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Introduction 
ସ ୍Welcome ା ଗତ! ମ ଇକ୍ର ସଫ୍ଟ ଅଫିସ ୍2016 ଆପ୍ସର ଚ କ୍ର ଟ ିମଖୁ୍ୟ ବିଷୟ - ୱ ର୍ଡ, ଏକ୍େଲ୍, ପ ୱ ରପଏଣ୍ଟ ଏବଂ 

ଆଉଟଲୁକ ୍ବିଷୟକ୍ର ଜ ଣବି  ଆପଣଙ୍କ ପ ଇ ଁସହଜ କରିବ  ପ ଇ ଁଏହି କ୍େପ ୍କ୍େପ ୍ବୁକ୍ ର୍ଜି ଇନ୍ କର ଯ ଇଛି | ପ୍ରକ୍ତୟକ 

ଭ ଗକ୍ର, ଆପଣ ଆରମ୍ଭରୁ ଆରମ୍ଭ କରିପ ରିକ୍ବ ଏବଂ ଆପଣ ବିକ୍େଷ ପଦ୍ଧତିଗରୁ୍ିକ କରିବ  େଖି୍ବି କ୍ବକ୍େ ଆପଣଙ୍କର ଦକ୍ଷତ  

ଗଠନ କରିପ ରିକ୍ବ | କିମ୍ବ , ଯଦି ଆପଣ ପସନ୍ଦ କରନି୍ତ, କ ଯଡୟଗରୁ୍ିକ କରିବ  ପ ଇ ଁଆପଣ କ୍ଯଉଠଁ କ୍ର ପ୍ରସୁ୍ତତ ମ ଗଡଦେଡନ 

ଆବେୟକ କରନି୍ତ ଆପଣ କ୍ସହି ସ୍ଥ ନକୁ କ୍ର୍ଇପଁ ରିକ୍ବ | କପିରି-ପଦକ୍କ୍ଷପଗରୁ୍ିକ ରସିପ ୍ଏବଂ ସଂକ୍କ୍ଷପକ୍ର ବିତରଣ କର ଯ ଏ - 

କ୍କବେ ତଥ୍ୟଗରୁ୍ିକ | ଆପଣ ସଚୂନ କ୍ଯ ଗୟ, ରଙ୍ଗୀନ ଗ୍ର ଫିେ ମଧ୍ୟ ପ ଇକ୍ବ ଯ ହ  ନକି୍ଦଡେ ବେୀ ବିଷୟବସୁ୍ତକୁ ସମଥ୍ଡନ କକ୍ର | 

Who this book is for 
ମ ଇକ୍ର ସଫ୍ଟ ଅଫିସ ୍ 2016 କ୍େପ-୍କ୍େପ ୍ ମ ଇକ୍ର ସଫ୍ଟ ଅଫିସ ୍ ଆପ୍ସର ଘର ଏବଂ ବୟବସ ୟ 

ଉପକ୍ଭ କ୍ତ ଙ୍କ ଦ୍ learning ା ର  ଏକ େକି୍ଷଣ ଏବଂ କ୍ରଫକ୍ରନ୍ସ ଉତ୍ସ ଭ ବକ୍ର ବୟବହ ର ପ ଇ ଁ

ର୍ିଜ ଇନ୍ କ୍ହ ଇଛି, କ୍ଯଉମଁ କ୍ନ ଫ ଇଲ ସେିୃ ଏବଂ ସଂପ ଦନ କରିବ କୁ ୱ ର୍ଡ, ଏକ୍େଲ୍, ଏବଂ 

ପ ୱ ରପଏଣ୍ଟ ବୟବହ ର କରିବ କୁ ଚ ହ ଁୁଛନି୍ତ, ଏବଂ ଇକ୍ମଲ୍, କ୍ଯ ଗ କ୍ଯ ଗ, ଏବଂ Outlook କ ୁ

ସଂଗଠିତ କରିବ କୁ Outlook ବୟବହ ର କରିବ କୁ ଚ ହ ଁୁଛନି୍ତ | ନିଯକିୁ୍ତ ପସୁ୍ତକର ବିଷୟବସୁ୍ତ 

କ୍ସହିମ ନଙ୍କ ପ ଇ ଁ ଉପକ୍ଯ ଗୀ କ୍ହ ଇଛି ଯ ହ କ ି ପବୂଡରୁ ଆପ୍ସର ପବୂଡ ସଂସ୍କରଣ ବୟବହ ର 

କରିସ ରିଛି ଏବଂ ପ୍ରଥ୍ମ ଥ୍ର ପ ଇ ଁଆପ ୍ଆବିଷ୍କ ର କରୁଥ୍ବି  କ୍ଲ କଙ୍କ ପ ଇ ଁଉପକ୍ଯ ଗୀ କ୍ହବ | 

ଯଦିଓ ଏହି ପସୁ୍ତକର ଅଧ୍ୟ ୟଗଡୁିକ ପ୍ରକ୍ତୟକ ଚ କ୍ର ଟ ି ଆପ ୍ ପ ଇ ଁ ପ୍ରମଖୁ୍ ସି୍କଲ୍ କ୍ସଟ୍ଗଡୁିକ ୁ

ପଙୁ୍ଖ ନୁପଙୁ୍ଖ ଭ ବକ୍ର ଆବୃତ କକ୍ର, ମ ଇକ୍ର ସଫ୍ଟ ଅଫିସ ୍ 2016 କ୍େପ-୍କ୍େପ ୍ ଏକ ପରିଚୟ 

ଭ ବକ୍ର ସକ୍ବଡ ତ୍ତମ ଭ ବକ୍ର ବୟବହୃତ ହୁଏ | ଉନ୍ନତ ବିଷୟଗରୁ୍ିକର ଗଭୀର କଭକ୍ରଜ୍ ଅନ୍ତଭଡୂ କ୍ତ 

କରି ପ୍ରକ୍ତୟକ ଆପର ସମ୍ପରୂ୍ଣ୍ଡ ଆକ୍ଲ ଚନ  ପ ଇ,ଁ ପ୍ରକ୍ତୟକ ଆପ ୍ ପ ଇ ଁ କ୍େପ ୍ କ୍େପ ୍ ବୁକ ୍ କ ୁ

ଅନୁସରଣ କରନ୍ତୁ: ମ ଇକ୍ର ସଫ୍ଟ ୱ ର୍ଡ 2016 କ୍େପ ୍କ୍େପ,୍ ମ ଇକ୍ର ସଫ୍ଟ ପ ୱ ରପଏଣ୍ଟ 2016 

କ୍େପ ୍ କ୍େପ ୍ ଏବଂ ମ ଇକ୍ର ସଫ୍ଟ ଆଉଟଲୁକ ୍ 2016 କ୍େପ ୍ କ୍େପ,୍ ସମସ୍ତ କ୍ଜ ନ୍ ଲ ମବଟଡ 

(ମ ଇକ୍ର ସଫ୍ଟ କ୍ପ୍ରସ,୍ 2015), ଏବଂ ମ ଇକ୍ର ସଫ୍ଟ ଏକ୍େଲ୍ 2016 କ୍େପ ୍କ୍େପ ୍ଦ୍ୱ ର  କଟିସ ୍ଫି୍ର 

(ମ ଇକ୍ର ସଫ୍ଟ କ୍ପ୍ରସ,୍ 2015) | ଏହି ପସୁ୍ତକର କ୍େଷକ୍ର ପ୍ରକ୍ତୟକ ପସୁ୍ତକର ବିଷୟବସୁ୍ତର ଏକ 

ତ ଲିକ  ପ୍ରଦ ନ କର ଯ ଇଛି |. 
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IMPORTANT  The Office 2016 apps are not available from the book’s website. You should 

install the apps before working through the procedures and practice tasks in this book. 

SEE ALSO For information about opening and saving files, see Chapter 2, “Create and 

manage files.” 

 
 

The Step by Step approach 
ବହିର କଭକ୍ରଜକୁ ଅଂେକ୍ର ବିଭକ୍ତ କର ଯ ଇଛି, ଯ ହ ର ପ୍ରକ୍ତୟକଟି ଚ କ୍ର ଟ ିଆପ ମଧ୍ୟରୁ କ୍ଗ ଟିଏକୁ ସଂପରୂ୍ଣ୍ଡ ପରିଚୟ ପ୍ରଦ ନ 

କରିଥ୍ ଏ | ପ୍ରକ୍ତୟକ ଅଂେକ ୁକଛିି ଆପର ପ୍ରମଖୁ୍ କ ill େେ କ୍ସଟ୍ କ୍କ୍ଷତ୍ରକୁ ପ୍ରତିନିଧତି୍ୱ କରୁଥ୍ବି  ଅଧ୍ୟ ୟକ୍ର ବିଭକ୍ତ କର ଯ ଇଛି, 

ଏବଂ ପ୍ରକ୍ତୟକ ଅଧ୍ୟ ୟ ବିଷୟଗରୁ୍ିକକ୍ର ବିଭକ୍ତ କ୍ହ ଇଛି ଯ ହ  କ୍ଗ ଷ୍ଠୀ ସମ୍ବନ୍ଧୀୟ କ skills େେଗରୁ୍ିକ | ପ୍ରକ୍ତୟକ ବିଷୟ 

କ୍ଜକ୍ନରିକ ୍ପଦ୍ଧତି ଦ୍ followed ା ର  ଏେକ୍ପ ଜିକ୍ଟ ରୀ ସଚୂନ  ଅନ୍ତଭଡୁ କ୍ତ କକ୍ର | ଅଧ୍ୟ ୟର କ୍େଷକ୍ର, ଆପଣ ଅଭୟ ସ 

କ ଯଡୟଗଡୁିକର ଏକ େଙୃ୍ଖେ  ପ ଇକ୍ବ ଯ ହ କୁ ଆପଣ ଅଧ୍ୟ ୟକ୍ର େଖି୍ ଯ ଇଥ୍ବି  କ skills େେ ବୟବହ ର କରି ନିକ୍ଜ ସମ୍ପରୂ୍ଣ୍ଡ 

କରିପ ରିକ୍ବ | ଆପଣ ଅଭୟ ସ ଫ ଇଲଗରୁ୍ିକ ବୟବହ ର କରିପ ରିକ୍ବ ଯ ହ  ଅଭୟ ସ କ ଯଡୟ ମ ଧ୍ୟମକ୍ର କ ଯଡୟ କରିବ କ ୁଏହି 

ପସୁ୍ତକର କ୍ୱବସ ଇଟରୁ ଉପଲବ୍ଧ, କିମ୍ବ  ଆପଣ ନିଜ ଫ ଇଲ୍ ବୟବହ ର କରିପ ରିକ୍ବ | 

Download the practice files 
ଏହି ପସୁ୍ତକକ୍ର ଆପଣ ଅଭୟ ସ କ ଯଡୟ ସମ ପ୍ତ କରିବ  ପବୂଡରୁ, ଆପଣଙୁ୍କ http://aka.ms/Office2016sbs/downloads ରୁ ବହିର ଅଭୟ ସ 

ଫ ଇଲଗଡୁିକୁ ଆପଣଙ୍କ କମ୍ପୟୁଟରକୁ ର୍ ଉନକ୍ଲ ର୍୍ କରିବ କୁ ପର୍ିବ | କ୍ୱବପଷୃ୍ ଠ କ୍ର ଥ୍ବି  ନିକ୍ଦଡେ ବେୀ ଅନୁସରଣ କରନ୍ତୁ | 

 

ଯଦି ଆପଣ ପକ୍ର ଅଭୟ ସ କ ଯଡୟଗଡୁିକୁ ପନୁର ବୃତି୍ତ କରିବ କୁ ଚ ହ ଁ ନି୍ତ, କ୍ତକ୍ବ ଆପଣ ମେୂ ଅଭୟ ସ 

ଫ ଇଲଗଡୁିକୁ ପନୁବଡ ର ର୍ ଉନକ୍ଲ ର୍୍ କରିପ ରିକ୍ବ |. 

 

The following table lists the practice files for this book. 
 

Chapter Folder File 

Part 1: Microsoft Office 2016   

1: Explore Office 2016 Ch01 None 

2: Create and manage files Ch02 DisplayProperties.xlsx 

DisplayViews.pptx 

NavigateFiles.docx 



Introduction 

Chapter Folder File 

xiii 

 

 

 

Part 2: Microsoft Word 2016   

3: Modify the structure and appearance Ch03 ApplyStyles.docx 

of text  ChangeTheme.docx 

  CreateLists.docx 

  FormatCharacters.docx 

  FormatParagraphs.docx 

  StructureContent.docx 

4: Collaborate on documents Ch04 ControlChanges.docx 

  MergeDocs1.docx 

  MergeDocs2.docx 

  ReviewComments.docx 

  TrackChanges.docx 

5: Merge data with documents Ch05 CreateEnvelopes.docx 
and labels  CustomerList.xlsx 

  InsertFields.docx 

  PolicyholdersList.xlsx 

  RefineData.docx 

  StartMerge.docx 

Part 3: Microsoft Excel 2016 
  

6: Perform calculations on data Ch06 AuditFormulas.xlsx 

  BuildFormulas.xlsx 

  CreateArrayFormulas.xlsx 

  CreateConditionalFormulas.xlsx 

  CreateExcelTables.xlsx 

  CreateNames.xlsx 

  SetIterativeOptions.xlsx 

7: Manage worksheet data Ch07 LimitData.xlsx 

  SummarizeValues.xlsx 

  ValidateData.xlsx 

8: Reorder and summarize data Ch08 LookupData.xlsx 

  OrganizeData.xlsx 

  SortCustomData.xlsx 

  SortData.xlsx 
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xiv 

 

 

 
 
 

Chapter Folder File 

9: Analyze alternative data sets Ch09 BuildSolverModel.xlsx 

  CreateScenarios.xlsx 

  DefineDataTables.xlsx 

  ManageMultipleScenarios.xlsx 

  PerformGoalSeekAnalysis.xlsx 

  PerformQuickAnalysis.xlsx 

  UseDescriptiveStatistics.xlsx 

Part 4: Microsoft PowerPoint 2016 
  

10: Create and manage slides Ch10 AddRemoveSlides.pptx 

  ApplyThemes.pptx 

  ChangeBackgrounds.pptx 

  CreateSections.pptx 

  ImportOutline.docx 

  RearrangeSlides.pptx 

  ReuseSlides.pptx 

11: Insert and manage simple graphics Ch11 Chickens.jpg 

  DrawShapes.pptx 

  EditPictures.pptx 

  Fish.jpg 

  Flamingos.jpg 

  Flowers01.jpg 

  InsertPictures.pptx 

  InsertScreens.pptx 

  Penguins01.jpg 

  Penguins02.jpg 

  Tiger01.jpg 

  Tiger02.jpg 

  YellowBird.jpg 

12: Add sound and movement to slides Ch12 AddAudio.pptx 

  AddVideo.pptx 

  AnimateSlides.pptx 

  Butterfly.wmv 

  CustomizeAnimation.pptx 

  SoundTrack.wma 

  Wildlife.wmv 



Introduction 

Chapter Folder File 

xv 

 

 

 

Part 5: Microsoft Outlook 2016   

13: Send and receive email messages Ch13 AttachFiles.docx 

14: Organize your Inbox Ch14 None 

15: Manage scheduling Ch15 None 

 

 

Ebook edition 
If you’re reading the ebook edition of this book, you can do the following: 

■ Search the full text 

■ Print 

■ Copy and paste 

You can purchase and download the ebook edition from the Microsoft Press Store at 

http://aka.ms/Office2016sbs/details. 

 

Get support and give feedback 
This topic provides information about getting help with this book and contacting us 

to provide feedback or report errors. 

 
Errata and support 

We’ve made every effort to ensure the accuracy of this book and its companion 

content. If you discover an error, please submit it to us at http://aka.ms 

/Office2016sbs/errata. 

If you need to contact the Microsoft Press Support team, please send an email message 

to mspinput@microsoft.com. 

For help with Microsoft software and hardware, go to http://support.microsoft.com. 

http://aka.ms/Office2016sbs/details
http://aka.ms/
mailto:mspinput@microsoft.com
http://support.microsoft.com/


Introduction 

xvi 

 

 

 
 

We want to hear from you 

At Microsoft Press, your satisfaction is our top priority, and your feedback our most 

valuable asset. Please tell us what you think of this book at http://aka.ms/tellpress. 

The survey is short, and we read every one of your comments and ideas. Thanks in 

advance for your input! 

 
Stay in touch 

Let’s keep the conversation going! We’re on Twitter at http://twitter.com/MicrosoftPress. 

http://aka.ms/tellpress
http://twitter.com/MicrosoftPress
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Modify the 
structure and 
appearance 
of text 

ର୍କୁୟକ୍ମଣ୍ଟ୍ ଗରିୁ୍କ ପ ଠୟ ଧ ରଣ କରିଥ୍ ଏ ଯ ହ କି ସଚୂନ  ପ୍ରଦ ନ 

କରିଥ୍ ଏ | 

ପ ଠକମ ନଙ୍କ ପ ଇ,ଁ କିନ୍ତୁ ର୍କୁୟକ୍ମଣ୍ଟ୍ ର ଦୃେୟ ମଧ୍ୟ ଏକ ବ ତ୍ତଡ  

ପ୍ରଦ ନ କକ୍ର | ବିଭିନ୍ନ ଉପ ୟକ୍ର ପ ଠକୁ ଫମଡ ଟ୍ କରି ଆପଣ 

ଗଠନ ଏବଂ ଅଥ୍ଡ ପ୍ରଦ ନ କରିପ ରିକ୍ବ | ୱ ର୍ଡ 2016 ବିଭିନ୍ନ 

ସରେ-ବୟବହ ର-ଉପକରଣଗରିୁ୍କ ପ୍ରଦ ନ କକ୍ର ଯ ହ କୁ ଆପଣ 

ଅତୟ ଧନିୁକ ଫମଡ ଟିଂ ପ୍ରକ୍ୟ ଗ ଏବଂ ଏକ ନ ଭିକ୍ଗସନ୍ ଗଠନ 

ସେିୃ କରିବ କୁ ବୟବହ ର କରିପ ରିକ୍ବ | 

 
ଏକ ସଂକି୍ଷପ୍ତ ର୍କୁୟକ୍ମଣ୍ଟକ୍ର କିମ୍ବ  ଏକ ଜଟିେ ନ ଭିକ୍ଗସନ୍ ଗଠନ 

ଆବେୟକ କକ୍ର ନ ହି,ଁ ଆପଣ ସହଜକ୍ର େବ୍ଦ ଏବଂ ପ ର ଗ୍ର ଫ୍ ଫମଡ ଟ୍ 

କରିପ ରିକ୍ବ ଯ ହ  ଦ୍ key ା ର  କି ପଏଣ୍ଟଗରୁ୍କି ଛିର୍  କ୍ହ ଇ ଆପଣଙ୍କ 

ର୍କୁୟକ୍ମଣ୍ଟର ଗଠନ ସ୍ପେ କ୍ହବ | ପବୂଡ ନିଦ୍ଧଡ ରିତ ୱ ର୍ଡ ଆଟଡ ପ ଠୟ 

ପ୍ରଭ ବ ପ୍ରକ୍ୟ ଗ କରି ଆପଣ ନ ଟକୀୟ ଚମତ୍କ ର ହ ସଲ କରିପ ରିକ୍ବ 

| ର୍କୁୟକ୍ମଣ୍ଟ୍ ଏବଂ ଅନୟ ନୟ ମ ଇକ୍ର ସଫ୍ଟ ଅଫିସ ୍ ଫ ଇଲଗରୁ୍ିକର 

ଦୃେୟକୁ ସି୍ଥର ରଖ୍ବି  ପ ଇ,ଁ ଆପଣ େ ଇଲ୍ ନ ମକ ଫମଡ ଟିଂର ପବୂଡ 

ନିଦ୍ଧଡ ରିତ କ୍ସଟ୍ ପ୍ରକ୍ୟ ଗ କରି ର୍କୁୟକ୍ମଣ୍ଟ୍ ଉପ ଦ ନଗରୁ୍କି ଫମଡ ଟ୍ 

କରିପ ରିକ୍ବ | ଏହ  ସହିତ, ଆପଣ ଏକ ଥ୍ମି ୍ପ୍ରକ୍ୟ ଗ କରି କ୍ଗ ଟିଏ 

କ୍ିିକ ୍ ସହିତ ଏକ ର୍କୁୟକ୍ମଣ୍ଟକ୍ର ଫଣ୍ଟ, ରଙ୍ଗ ଏବଂ ପ୍ରଭ ବ ପରିବତ୍ତଡନ 

କରିପ ରିକ୍ବ | 

ବର୍ଣ୍ଡ ଏବଂ ପ ର ଗ୍ର ଫ୍ ଫମଡ ଟିଂ ପ୍ରକ୍ୟ ଗ କରିବ , ବିଷୟବସୁ୍ତକ ୁ

ମ ନୁଆଲୀ କରିବ , ତ ଲିକ  ତିଆରି ଏବଂ ରୂପ ନ୍ତର କରିବ , 

ପ ଠୟକ୍ର େ yles େୀ ପ୍ରକ୍ୟ ଗ କରିବ  ଏବଂ ଏକ ର୍କୁୟକ୍ମଣ୍ଟର 

ଥ୍ମି ୍ପରିବତ୍ତଡନ ସହିତ ଜର୍ିତ ପ୍ରରିୟ  ମ ଧ୍ୟମକ୍ର ଏହି ଅଧ୍ୟ ୟ 

ଆପଣଙୁ୍କ ମ ଗଡଦେଡନ କକ୍ର |

  3  
In this chapter 
■ Apply paragraph formatting 

■ Structure content manually 

■ Apply character formatting 

■ Create and modify lists 

■ Apply built-in styles to text 

■ Change the document theme 

 

 

Practice files 

ଏହି ଅଧ୍ୟ ୟ ପ ଇ,ଁ Office2016SBS \ 

Ch03 କ୍ଫ ଲ୍ଡରରୁ ଅଭୟ ସ ଫ ଇଲଗଡୁିକୁ 

ବୟବହ ର କରନ୍ତୁ | ଅଭୟ ସ ଫ ଇଲ୍ 

ର୍ ଉନକ୍ଲ ର୍୍ ନିକ୍ଦଡେ ବେୀ ପ ଇ,ଁ ପରିଚୟ 

କ୍ଦଖ୍ନ୍ତୁ |. 
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Chapter 3: Modify the structure and appearance of text 
 

 

SEE ALSO For information about working with hidden structural characters, see 

“Structure content manually” later in this chapter. 

SEE ALSO For information about styles, see “Apply built-in styles to text” later in this 

chapter. 

 
 

Apply paragraph formatting 
କ୍ଟେଟ୍ ଏଣ୍ଟର୍ କରି ଏଣ୍ଟର୍ କୀ ଦବ ଇ ଏକ ପ ର ଗ୍ର ଫ୍ ସେିୃ ହୁଏ | ଏକ ଅନୁକ୍େଦକ୍ର କ୍ଗ ଟିଏ େବ୍ଦ, କ୍ଗ ଟିଏ ବ କୟ, 

କିମ୍ବ  ଏକ ଧକି ବ କୟ ରହିପ କ୍ର | ପ୍ରକ୍ତୟକ ପ ର ଗ୍ର ଫ୍ ଏକ ପ ର ଗ୍ର ଫ୍ ମ କଡ ସହିତ କ୍େଷ ହୁଏ, ଯ ହ  ଏକ ପଛୁଆ P 

(like) ପରି କ୍ଦଖ୍ ଯ ଏ | ପ ର ଗ୍ର ଫ୍ ମ କଡ ଏବଂ ଅନୟ ନୟ ଗଠନମେୂକ ଅକ୍ଷରଗରିୁ୍କ (କ୍ଯପରିକି କ୍ସ୍ପସ,୍ ଲ ଇନ୍ କ୍େକ୍, 

ଏବଂ ଟୟ ବ୍) ସ ଧ ରଣତ hidden ଲୁକ୍କ ୟିତ, କିନ୍ତୁ ଆପଣ କ୍ସଗରିୁ୍କୁ ପ୍ରଦେଡନ କରିପ ରିକ୍ବ | କ୍ବକ୍େକ୍ବକ୍େ ଏହି 

ଲୁକ୍କ ୟିତ ଅକ୍ଷରଗରିୁ୍କ ପ୍ରଦେଡନ କରିବ  ଏକ କ ଯଡୟ ସମ୍ପ ଦନ କରିବ  କିମ୍ବ  ଏକ ଗଠନମେୂକ ସମସୟ  ବୁ understand 

ାବି  ସହଜ କରିଥ୍ ଏ | 

ଏହ  ପବୂଡରୁ ଏବଂ ପକ୍ର କ୍ସ୍ପସ ୍ସହିତ ଏହ ର ଇକ୍େକ୍ଣ୍ଟସନ୍, ଆଲ ଇକ୍ନ୍ େଣ୍ଟ, ଏବଂ ଲ ଇନ୍ ବୟବଧ ନ ପରିବତ୍ତଡନ କରି ଆପଣ ଏକ 

ପ ର ଗ୍ର ଫର ଲୁକ୍ ପରିବତ୍ତଡନ କରିପ ରିକ୍ବ | ଆପଣ ଏହ ର ଚ ରିପ ଖ୍କ୍ର ସୀମ  ରଖ୍ପି ରିକ୍ବ ଏବଂ ଏହ ର ପଷୃ୍ଠଭୂମି ଛ ଇ 

କରିପ ରିକ୍ବ | ସ ମହିୂକ ଭ ବକ୍ର, ଆପଣ ଏକ ପ ର ଗ୍ର ଫ୍ ର ରୂପ ବଦେ ଇବ  ପ ଇ ଁବୟବହ ର କରୁଥ୍ବି  କ୍ସଟିଂସମହୂକ ୁ

ପ ର ଗ୍ର ଫ୍ ଫମଡ ଟିଂ କୁହ ଯ ଏ | 

 

ରିବନ୍ ର କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର ଟୁଲ୍ ବୟବହ ର କରି ଏବଂ କ୍ହ ମ ୍ଟୟ ବ୍ କିମ୍ବ  େ ସକରୁ ଏହ ର ବ ମ ଏବଂ 

ର୍ ହ ଣ ଇକ୍େଣ୍ଟଗରୁ୍ିକ ବୟବହ ର କରି ଆପଣ ଏକ ଅନୁକ୍େଦର ବ ମ ଏବଂ ର୍ ହ ଣ ଧ ର ଆଲ ଇକ୍ନ୍ େଣ୍ଟ ଏବଂ 

ଭୂଲମ୍ବ ବୟବଧ ନକୁ ପରିବତ୍ତଡନ କରିପ ରିକ୍ବ | ର୍କୁୟକ୍ମଣ୍ଟ୍ ବିଷୟବସୁ୍ତ ପ ଇ ଁ ଅଧକି ସ୍ଥ ନ ପ୍ରଦ ନ କରିବ କୁ 

େ ସକ ସ ଧ ରଣତ hidden ଲୁକ୍କ ୟିତ | 

 

The left indent can be changed from the Home tab or the ruler 

 

ଯଦି ଆପଣ ଏକ ପ ର ଗ୍ର ଫ୍ ସଂକ୍େ ଧନ କରନି୍ତ ଏବଂ ପରିବତ୍ତଡନଗରୁ୍ିକକ୍ର ଖ୍ସିୁ ନୁହନିଁ୍ତ, କ୍ତକ୍ବ ଆପଣ ମେୂ ଅନୁକ୍େଦ ଏବଂ ବର୍ଣ୍ଡ 

କ୍ସଟିଂସମହୂକୁ ପନୁ base କ୍ସଟ୍ କରିବ କ ୁଫମଡ ଟିଂକୁ ସଫ  କରି ପନୁ restore ସ୍ଥ ପନ କରିପ ରିକ୍ବ | 
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କ୍ଯକ୍ତକ୍ବକ୍େ ଆପଣ ମକ୍ନ ନୀତ ପ ର ଗ୍ର ଫଗରୁ୍ିକର ଆଲ ଇକ୍ନ୍ େଣ୍ଟ, ଇକ୍େକ୍ଣ୍ଟସନ୍, ଏବଂ କ୍ସ୍ପସିଙ୍ଗକ୍ର ଅକ୍ନକ 

ସଂକ୍େ ଧନ କରିବ କ ୁଚ ହ ଁ ନି୍ତ, ବଟନ୍ କ୍ିିକ୍ କରିବ  ଏବଂ ମ କଡର୍ ଡ୍ର ଗ ୍କରିବ  ଅକ୍ପକ୍ଷ  ପ ର ଗ୍ର ଫ୍ ର୍ ୟଲଗ ୍

ବେକ୍ର ପରିବତ୍ତଡନ କରିବ  କ୍ବକ୍େକ୍ବକ୍େ ତ୍ୱର ନ୍ିତି କ୍ହ ଇଥ୍ ଏ | 

  3  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Paragraph dialog box 

 

Configure alignment 
 
ଆଲ ଇକ୍ନ୍େଣ୍ଟ କ୍ସଟିଂସମହୂ ପଷୃ୍ଠ  ମ ଜିନ ମଧ୍ୟକ୍ର ପ ର ଗ୍ର ଫ୍ ପ ଠୟର ଭୂସମ ନ୍ତର ସି୍ଥତିକ ୁନିୟନ୍ତ୍ରଣ କକ୍ର | ଚ କ୍ର ଟି ଆଲ ଇକ୍ନ୍େଣ୍ଟ ଅପ୍ସନ୍ ଅଛି: 

■ Align Left : ଏହ  କ୍ହଉଛି ର୍ିଫଲ୍ଟ ପ ର ଗ୍ର ଫ୍ ଆଲ ଇକ୍ନ୍େଣ୍ଟ | ଏହ  ପ ର ଗ୍ର ଫର ପ୍ରକ୍ତୟକ ଧ ର୍ିର ବ ମ 

ମେୁକୁ ବ ମ ପଷୃ୍ଠ  ମ ଜିନ କିମ୍ବ  ବ ମ ଇକ୍େଣ୍ଟକ୍ର କ୍ସଟ୍ କକ୍ର | ଏହ  ଏକ ସିଧ  ବ ମ ଧ ର ଏବଂ ଏକ 

ଚିର  ର୍ ହ ଣ ଧ ରକ୍ର ପରିଣତ ହୁଏ | 

■ Align Right : ଏହ  ପ ର ଗ୍ର ଫର ପ୍ରକ୍ତୟକ ଧ ର୍ିର ର୍ ହ ଣ ମେୁକୁ ର୍ ହ ଣ ପଷୃ୍ ଠ  ମ ଜିନ କିମ୍ବ  

ର୍ ହ ଣ ଇକ୍େଣ୍ଟକ୍ର କ୍ସଟ୍ କକ୍ର | ଏହ  ଏକ ସିଧ  ର୍ ହ ଣ ଧ ର ଏବଂ ଏକ ବ ମପଟ ଧ ରକ୍ର 

ପରିଣତ ହୁଏ | 

■ Center: ଏହ  ପ ର ଗ୍ର ଫର ପ୍ରକ୍ତୟକ ଧ ର୍ି ବ ମ ଏବଂ ର୍ ହ ଣ ପଷୃ୍ ଠ  ମ ଜିନ କିମ୍ବ  ଇକ୍େଣ୍ଟସ ୍

ମଧ୍ୟକ୍ର କ୍କନ୍ଦ୍ର କକ୍ର | ଏହ  ଫେ ଫେ ବ ମ ଏବଂ ର୍ ହ ଣ ଧ ରକ୍ର ପରିଣତ ହୁଏ |  

Justify : ଏହି ଆଲ ଇକ୍ନ୍ େଣ୍ଟ େବ୍ଦଗଡୁିକ ମଧ୍ୟକ୍ର ବୟବଧ ନକୁ ସଜ ର୍ିଥ୍ ଏ ଯ ହ  ଦ୍ the ା ର  ପ ର ଗ୍ର ଫର ପ୍ରକ୍ତୟକ ଧ ର୍ିର ବ ମ ମେୁ ବ ମ 

ପଷୃ୍ ଠ  ମ ଜିନ କିମ୍ବ  ଇକ୍େଣ୍ଟକ୍ର ଏବଂ ପ ର ଗ୍ର ଫର ପ୍ରକ୍ତୟକ ଧ ର୍ିର ର୍ ହ ଣ ମେୁ (କ୍େଷ ଧ ର୍ି ବୟତୀତ) ର୍ ହ ଣ ମ ଜିନ କିମ୍ବ  ଇକ୍େଣ୍ଟକ୍ର ଥ୍ ଏ 

| । ଏହ  ସିଧ  ବ ମ ଏବଂ ର୍ ହ ଣ ଧ ରକ୍ର ପରିଣତ ହୁଏ |
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ରିବନକ୍ର ଥ୍ବି  ଆଲ ଇକ୍ନ୍ େଣ୍ଟ ବଟନ୍ ଉପକ୍ର ଥ୍ବି  ଆଇକନ୍ଗଡୁିକ ପ୍ରକ୍ତୟକ ଆଲ ଇକ୍ନ୍ େଣ୍ଟ ଅପ୍ସନ୍ ର ପ୍ରଭ ବକୁ ଦେଡ ଏ | 
 

To open the Paragraph dialog box 

1. Do either of the following: 

Home କ୍ହ ମ ୍ଟୟ ବ୍ କିମ୍ବ  କ୍ଲଆଉଟ୍ ଟୟ ବ୍ ଉପକ୍ର, ପ ର ଗ୍ର ଫ୍ ଗରୁ୍ପ ୍କ୍ର, ପ ର ଗ୍ର ଫ୍ ର୍ ୟଲଗ ୍ବେ ଲଞ୍ଚର୍ କ୍ିିକ୍ କରନ୍ତୁ | 

Home କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର, ପ ର ଗ୍ର ଫ୍ ଗରୁ୍ପ ୍କ୍ର, କ୍ରଖ୍  ଏବଂ ପ ର ଗ୍ର ଫ୍ କ୍ସ୍ପସ ୍ବଟନ୍ କ୍ିିକ୍ କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର 

ଲ ଇନ୍ କ୍ସ୍ପସ ୍ଅପ୍ସନ୍ କ୍ିିକ୍ କରନ୍ତୁ | 

To set paragraph alignment 

1. 1. କସଡର୍ କୁ ପ ର ଗ୍ର ଫର କ୍ଯକ anywhere ଣସି ସ୍ଥ ନକ୍ର ରଖ୍ନ୍ତୁ, କିମ୍ବ  ଆପଣ ଆର୍ଜେ 

କରିବ କୁ ଚ ହ ଁୁଥ୍ବି  ସମସ୍ତ ପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ |. 

2. Do either of the following: 

● କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର, ପ ର ଗ୍ର ଫ୍ ଗରୁ୍ପ ୍କ୍ର, ଆଲ ଇନ୍ ବ ମ, କ୍କନ୍ଦ୍ର, ର୍ ହ ଣକୁ 

ଆଲ ଇନ୍ କରନ୍ତୁ, କିମ୍ବ  ଜେିସ ୍ବଟନ୍ କ୍ିିକ୍ କରନ୍ତୁ | 

. ପ ର ଗ୍ର ଫ୍ ର୍ ୟଲଗ ୍ବେ କ୍ଖ୍ ଲ | ଇକ୍େଣ୍ଟସ ୍ଏବଂ କ୍ସ୍ପସ ୍ଟୟ ବ୍ ଉପକ୍ର, ସ ଧ ରଣ କ୍କ୍ଷତ୍ରକ୍ର,  

ଆଲ ଇକ୍ନ୍ େଣ୍ଟ ତ ଲିକ କ୍ର ବ ମ, କ୍କନ୍ଦ୍ରିତ, ର୍ ହ ଣ କିମ୍ବ  ଯଥ୍ ଥ୍ଡ କ୍ିିକ ୍କରନ୍ତୁ | 

 

Configure vertical spacing 

Paragraphs have two types of vertical spacing: 

■ Paragraph spacing: ପ୍ରକ୍ତୟକ ପ ର ଗ୍ର ଫ୍ ପବୂଡରୁ ଏବଂ ପକ୍ର କ୍ସ୍ପସ ୍କ୍ସଟ୍ କରି 

ପ ର ଗ୍ର ଫ୍ ମଧ୍ୟକ୍ର କ୍ସ୍ପସ ୍| ଏହି ସ୍ଥ ନ ସ ଧ ରଣତ points ପଏଣ୍ଟକ୍ର ମ ପ କର ଯ ଏ | 

■ Line spacing: ପ ର ଗ୍ର ଫର କ୍ରଖ୍ ଗଡୁିକ ମଧ୍ୟକ୍ର ଥ୍ବି  ସ୍ଥ ନ, ପ ଠୟର ଉଚ୍ଚତ  (ଏକକ, ର୍ବଲ୍, କିମ୍ବ  

ଏକ ନିଦିେ ସଂଖ୍ୟକ ଧ ର୍ି) କିମ୍ବ  ସବଡନିମ୍ ନ କିମ୍ବ  ସଠିକ୍ ବିନୁ୍ଦ ମ ପ ନିଦିେ କରି କ୍ରଖ୍ ଗଡୁିକର ଉଚ୍ଚତ  

କ୍ସଟ୍ କରି ବୟ ଖ୍ୟ  କର ଯ ଇଛି | 

 

ୱ ର୍ଡ 2016 କ୍ର ସେିୃ କ୍ହ ଇଥ୍ବି  ର୍କୁୟକ୍ମଣ୍ଟଗରୁ୍ିକ ପ ଇ ଁର୍ିଫଲ୍ଟ ଲ ଇନ୍ ବୟବଧ ନ କ୍ହଉଛି 1.08 ଧ ର୍ ି| କ୍ରଖ୍  ବୟବଧ ନ ପରିବତ୍ତଡନ କରିବ  

ଅନୁକ୍େଦକ୍ର ପ ଠୟର ରୂପ ଏବଂ ପଠନ କ୍ଯ ଗୟତ କୁ ପରିବତ୍ତଡନ କରିଥ୍ ଏ ଏବଂ ଅବେୟ ଏହ  ପଷୃ୍ଠ କ୍ର ଥ୍ବି  ସ୍ଥ ନ ପରିମ ଣକୁ ମଧ୍ୟ ପରିବତ୍ତଡନ କରିଥ୍ ଏ 

|. 
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The effect of changing line spacing 

 

ବୟକି୍ତଗତ ପ ର ଗ୍ର ଫ୍ ଏବଂ ପ ର ଗ୍ର ଫ୍ େ yles େୀ ପ ଇ ଁଆପଣ ପ ର ଗ୍ର ଫ୍ ଏବଂ ଲ ଇନ୍ ବୟବଧ ନ କ୍ସଟ୍ କରିପ ରିକ୍ବ | ର୍ିଜ ଇନ୍ ଟୟ ବକ୍ର 

ପ ର ଗ୍ର ଫ୍ କ୍ସ୍ପସ ୍କ୍ମନୁରୁ ଏକ ବିକଳ୍ପ ଚୟନ କରି ଆପଣ ଏକ ର୍କୁୟକ୍ମଣ୍ଟକ୍ର ଅଧକି ଂେ ବିଷୟବସୁ୍ତର ବୟବଧ ନକୁ େୀଘ୍ର ଆର୍ଜେ କରିପ ରିକ୍ବ 

| (ଯଦିଓ କ୍ମନୁକୁ ପ ର ଗ୍ର ଫ୍ କ୍ସ୍ପସିଙ୍୍ଗ ନ ମିତ କର ଯ ଇଛି, କ୍ମନୁ ବିକଳ୍ପଗଡୁିକ ଉଭୟ ପ ର ଗ୍ର ଫ୍ ବୟବଧ ନ ଏବଂ କ୍ରଖ୍  ବୟବଧ ନକୁ ନିୟନ୍ତ୍ରଣ 

କରିଥ୍ ଏ |) ଏହି ବିକଳ୍ପଗଡୁିକ, ଯ ହ  ନିଦିେ ମ ପ ପରିବକ୍ତ୍ତଡ ପ୍ରଭ ବ ଦ୍ୱ ର  ନ ମିତ, ସ ଧ ରଣ ପ ର ଗ୍ର ଫ୍ େ style େୀର ବୟବଧ ନ ଏବଂ 

ଅନୟ ନୟ େ yles େୀକ୍ର ପରିବତ୍ତଡନ କରି କ ଯଡୟ କକ୍ର | କ୍ସମ ନଙ୍କର ବୟବଧ ନ ପ ଇ ଁସ ଧ ରଣ େ style େୀ ଉପକ୍ର ନିଭଡର କକ୍ର | 

(େ େ ର୍ଡ କ୍ଟମ୍ପକ୍ଲଟଗରୁ୍ିକକ୍ର, ଅନୟ ନୟ େ yles େୀଗରୁ୍ିକ ସ ଧ ରଣ େ style େୀ ଉପକ୍ର ଆଧ ରିତ |) ପ ର ଗ୍ର ଫ୍ କ୍ସ୍ପସିଙ୍୍ଗ ବିକଳ୍ପଗଡୁିକ 

କ୍କବେ ସ ମ୍ପ୍ରତିକ ର୍କୁୟକ୍ମଣ୍ଟକ୍ର ସ ଧ ରଣ େ style େୀକୁ ପରିବତ୍ତଡନ କରିଥ୍ ଏ, ଏବଂ ଅନୟ ଦଲିଲଗଡୁିକୁ ପ୍ରଭ ବିତ କକ୍ର ନ ହି ଁ|. 

The following table describes the effect of each Paragraph Spacing option on the 

paragraph and line spacing settings. 

Paragraph 

spacing option 

Before 

paragraph 

After 

paragraph 

Line 

spacing 
 

 

Default Spacing options are controlled by the style set 
 

No Paragraph Space 0 points 0 points 1 line 

Compact 0 points 4 points 1 line 

Tight 0 points 6 points 1.15 lines 

Open 0 points 10 points 1.15 lines 

Relaxed 0 points 6 points 1.5 lines 

Double 0 points 8 points 2 lines 
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To quickly adjust the vertical spacing before, after, and within all paragraphs in a 

document 

1. ର୍ିଜ ଇନ୍ ଟୟ ବ୍ ଉପକ୍ର, ର୍କୁୟକ୍ମଣ୍ଟ୍ ଫମଡ ଟିଂ ଗରୁ୍ପ ୍କ୍ର, ପ ର ଗ୍ର ଫ୍ କ୍ସ୍ପସ ୍କ୍ମନୁ ପ୍ରଦେଡନ କରିବ କୁ ପ ର ଗ୍ର ଫ୍ କ୍ସ୍ପସ ୍ବଟନ୍ କ୍ିିକ୍ କରନ୍ତୁ | 

Each paragraph spacing option controls space around and within the paragraph 

 

1. Click the option you want to apply to all of the paragraphs in the document. 

To adjust the spacing between paragraphs 

1.  ଆପଣ ଆର୍ଜେ କରିବ କୁ ଚ ହ ଁୁଥ୍ବି  ସମସ୍ତ ପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ | 

2. କ୍ଲଆଉଟ୍ ଟୟ ବ୍ ଉପକ୍ର, ପ ର ଗ୍ର ଫ୍ ଗରୁ୍ପ ୍କ୍ର, କ୍ସ୍ପସ ୍ପବୂଡରୁ ଏବଂ ଆର୍ଜେ କରନ୍ତୁ | 

କ୍ସଟିଂ ପକ୍ର ବୟବଧ ନ. 
 

The settings in the Spacing boxes are measured in points 
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TIP କ୍ରଖ୍   ଏ ବଂ  ପ ର ଗ୍ର  ଫ୍  କ୍ସ୍ପସ ୍ କ୍ମନୁ ରୁ  ମକ୍ନ  ନ ୀତ  ପ ର ଗ୍ର  ଫ୍  ପ ୂବ ଡରୁ  ଏ ବଂ  ପକ୍ର  

ଆପଣ  କ୍ସ୍ପ ସ ୍ ଆର୍ଜେ  କ ରି ପ ରି କ୍ବ  |  କ୍େଷ  ଦୁ ଇଟ ି  ବିକଳ୍ପ  ମଧ୍ୟରୁ  କ୍ଗ  ଟ ିଏ  କ୍ି ିକ ୍  କ ରି ବ  

ଦ୍ୱ ର  ମକ୍ନ ନ ୀତ  ପ ର ଗ୍ର  ଫ୍  ମଧ୍ୟକ୍ର  ଏକ  ପ ୂବ ଡ ନ ିଦ୍ଧ ଡ ରି ତ  ପରି ମ ଣ  କ୍ଯ ଗ  ହୁ ଏ  କିମ୍ବ  

ଅପସ  ରଣ  ହୁ ଏ  |  

 

 

 

To adjust spacing between the lines of paragraphs 

• କସଡର୍ କୁ ପ ର ଗ୍ର ଫର କ୍ଯକ anywhere ଣସି ସ୍ଥ ନକ୍ର ରଖ୍ନ୍ତୁ, କିମ୍ବ  ଆପଣ ଆର୍ଜେ କରିବ କୁ ଚ ହ ଁୁଥ୍ବି  ସମସ୍ତ ପ ର ଗ୍ର ଫ୍ 

ଚୟନ କରନ୍ତୁ | 

• କ୍ହ ମ  ୍ଟୟ ବ୍  ଉପକ୍ର, ପ ର ଗ୍ର ଫ୍  ଗରୁ୍ପ  ୍କ୍ର ମକ୍ନ ନୀତ ପ ର ଗ୍ର ଫଗରୁ୍ିକକ୍ର େୀଘ୍ର ଆର୍ଜେକ୍ମଣ୍ଟ୍ କରିବ କୁ, ଲ ଇନ୍  
ଏବଂ ପ ର ଗ୍ର ଫ୍  କ୍ସ୍ପସିଙ୍୍ଗ  କ୍ିିକ୍ କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର କ୍ମନୁକ୍ର ଥ୍ବି  3 ଟି ଲ ଇନ୍  ବୟବଧ ନ କ any ଣସି  କ୍ିିକ୍ କରନ୍ତୁ 
| 

 3  
 
 

You can choose from preset internal line spacing options or adjust paragraph spacing 

 

Or 

1. କସଡର୍ କ ୁ ପ ର ଗ୍ର ଫର କ୍ଯକ anywhere ଣସି ସ୍ଥ ନକ୍ର ରଖ୍ନ୍ତୁ, କିମ୍ବ  ଆପଣ ଆର୍ଜେ 

କରିବ କୁ ଚ ହ ଁୁଥ୍ବି  ସମସ୍ତ ପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ | 

 

2. ପ ର ଗ୍ର ଫ୍ ର୍ ୟଲଗ ୍ବେ କ୍ଖ୍ ଲ | ଇକ୍େଣ୍ଟସ ୍ଏବଂ କ୍ସ୍ପସ ୍ଟୟ ବ୍ ଉପକ୍ର, କ୍ସ୍ପସ ୍ଏରିଆକ୍ର, ଆପଣ ପ ର ଗ୍ର ଫ୍ ବୟବଧ ନକ୍ର ଚ ହ ଁୁଥ୍ବି  

ଆର୍ଜେକ୍ମଣ୍ଟ୍ କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର ଓକ୍କ କ୍ିିକ୍ କରନ୍ତୁ |
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SEE ALSO For information about setting margins, see “Preview and adjust page layout” 

in Chapter 12, “Finalize and distribute documents,” of Microsoft Word 2016 Step by Step 

by Joan Lambert (Microsoft Press, 2015). For information about sections, see “Control what 

appears on each page” in the same chapter. 

 
 

Configure indents 
ୱ ର୍ଡକ୍ର, ଆପଣ ପ ର ଗ୍ର ଫ୍ ର କ୍ମ କ୍ଟଇ ଏବଂ ପ ଠୟର ଦ length ଘଡୟକ ୁପ ଠୟ ଦ୍ୱ ର  ଦଖ୍ଲ କ୍ହ ଇଥ୍ବି  କ୍କ୍ଷତ୍ରକ ୁବୟ ଖ୍ୟ  କରି 

ବୟ ଖ୍ୟ  କରିକ୍ବ ନ ହି;ଁ ଏହ  ପରିବକ୍ତ୍ତଡ, ଆପଣ ପ ଠୟର ଚ ରିପ ଖ୍କ୍ର ଧେ  ସ୍ଥ ନର ବ ମ, ର୍ ହ ଣ, ଉପର ଏବଂ ତେ ମ ଜିନକୁ 

ବୟ ଖ୍ୟ  କରନି୍ତ |. 
 

 
କ୍ପଜ୍ ମ ଜିନ୍ ଠ ରୁ କ୍ଟେଟ୍ ପଯଡୟନ୍ତ ଏକ ପ ର ଗ୍ର ଫ୍ ଇକ୍େଣ୍ଟ୍ | ଆପଣ କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର ବଟନ୍ କ୍ିିକ ୍କରି ବ ମ ଇକ୍େଣ୍ଟକ ୁ

ପରିବତ୍ତଡନ କରିପ ରିକ୍ବ, କିମ୍ବ  ଆପଣ ଇକ୍େଣ୍ଟଗଡୁିକ ୁସିଧ ସେଖ୍ େ ସକ ଉପକ୍ର କ୍ସଟ୍ କରିପ ରିକ୍ବ | ତିକ୍ନ ଟ ିଇକ୍େଣ୍ଟ ମ କଡର 

ସବୁକ୍ବକ୍େ େ ସକ ଉପକ୍ର ଉପସି୍ଥତ ଥ୍ ଏ:: 

■ Left Indent:  ଏହ  ଅନୁକ୍େଦର ପ୍ରକ୍ତୟକ ଧ ର୍ିର ବ ହୟ ବ ମ ଧ ରକୁ ବୟ ଖ୍ୟ  କକ୍ର | . 

■ Right Indent:  ଏହ  ଅନୁକ୍େଦର ପ୍ରକ୍ତୟକ ଧ ର୍ିର ବ ହୟ ର୍ ହ ଣ ଧ ରକୁ ବୟ ଖ୍ୟ  

କକ୍ର | 

■ First Line Indent: ଏହ  ଅନୁକ୍େଦର ପ୍ରଥ୍ମ ଧ ର୍ିର ପ୍ର ରମ୍ଭ ବିନୁ୍ଦକୁ ବୟ ଖ୍ୟ  କକ୍ର | 

 

କ କ୍କ କ ଆଜ ଆଜ ଆଜକ ଆଜଜ ଆଜ ଆ 

The indent markers on the ruler 
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TIP The First Line Indent marker is linked to the Left Indent marker. Moving the Left 

Indent marker also moves the First Line Indent marker, to maintain the first line indent 

distance. You can move the First Line Indent marker independently of the Left Indent marker to 

change the first line indent distance. 

TIP In this book, we show measurements in inches. If you want to change the measure- 

ment units Word uses, open the Word Options dialog box. On the Advanced page, in the 

Display area, click the units you want in the Show Measurements In Units Of list. Then click OK. 

 

 

ବ ମ ଇକ୍େଣ୍ଟ ଏବଂ ପ୍ରଥ୍ମ ଲ ଇନ୍ ଇକ୍େଣ୍ଟ ମ କଡର୍ ପ ଇ ଁରି୍ଫଲ୍ଟ କ୍ସଟିଂ କ୍ହଉଛି 0.0 ”, ଯ ହ  ବ ମ ପଷୃ୍ ଠ  ମ ଜିନ ସହିତ ସମ ନ୍ତର େ | 

ର୍ ହ ଣ ଇକ୍େଣ୍ଟ ମ କଡର ପ ଇ ଁରି୍ଫଲ୍ଟ କ୍ସଟିଂ କ୍ହଉଛି ବ ମ ମ ଜିନରୁ ର୍ ହ ଣ ମ ଜିନ ପଯଡୟନ୍ତ ଦୂରତ  | ଉଦ ହରଣ ସ୍ୱରୂପ, ଯଦି ପଷୃ୍ ଠ ର 

ଆକ ର 8.5 ”ଚଉର୍  ଏବଂ ବ ମ ଏବଂ ର୍ ହ ଣ ମ ଜିନ୍ 1.0 କୁ କ୍ସଟ୍ କ୍ହ ଇଛି, ରି୍ଫଲ୍ଟ ର୍ ହ ଣ ଇକ୍େଣ୍ଟ ମ କଡର କ୍ସଟିଂ କ୍ହଉଛି 6.5” | 

 

ଏକ ଫ େୀ 3 ଇକ୍େଣ୍ଟ କିମ୍ବ  ପ୍ରଥ୍ମ ଲ ଇନ୍ ଇକ୍େଣ୍ଟ ସେିୃ କରିବ କୁ ଆପଣ ବ ମ ଇକ୍େଣ୍ଟ ଏବଂ ପ୍ରଥ୍ମ ଲ ଇନ୍ ଇକ୍େଣ୍ଟ ମ କଡର 

ବୟବସ୍ଥ  କରିପ ରିକ୍ବ | ହୟ ଙି୍ଗଂ ଇକ୍େଣ୍ଟଗରୁ୍ିକ ସ ଧ ରଣତ bul ବୁକ୍ଲକ୍ଟର୍୍ ଏବଂ ନମ୍ବରଯକୁ୍ତ ତ ଲିକ  ପ ଇ ଁବୟବହୃତ ହୁଏ, 

କ୍ଯଉଥଁ୍କି୍ର ବୁକ୍ଲଟ୍ କିମ୍ବ  ନମ୍ବର ମଖୁ୍ୟ ପ ଠୟଠ ରୁ କମ ୍ଇକ୍େଣ୍ଟ୍ କ୍ହ ଇଥ୍ ଏ (ମଖୁ୍ୟତ ,, ଏହ  ପରୁୁଣ ) | ପ୍ରଥ୍ମ ଧ ର୍ି 

ଇକ୍େଣ୍ଟଗରୁ୍ିକ ବ ରମ୍ବ ର ପ୍ରକ୍ତୟକ ପରବତ୍ତଡୀ ଅନୁକ୍େଦର ପ୍ର ରମ୍ଭକୁ ର୍କୁୟକ୍ମଣ୍ଟକ୍ର ବୟବହୃତ ହୁଏ ଯ ହ  ପ ଠୟର ଅକ୍ନକ ଅନୁକୂେ 

ପ ର ଗ୍ର ଫକୁ କ୍ନଇ ଗଠିତ | ଉଭୟ ପ୍ରକ ରର ଇକ୍େଣ୍ଟଗରୁ୍କି ନୟିମକ୍ର ପ୍ରଥ୍ମ ଲ ଇନ୍ ଇକ୍େଣ୍ଟ ମ କଡର ବୟବହ ର କରି କ୍ସଟ୍ 

କ୍ହ ଇଛି || 

. 

 

 

To display the ruler 

1. On the View tab, in the Show group, select the Ruler check box. 
 

 

To indent or outdent the left edge of a paragraph 

1.କସଡର୍ କୁ ପ ର ଗ୍ର ଫର କ୍ଯକ anywhere ଣସି ସ୍ଥ ନକ୍ର ରଖ୍ନ୍ତୁ, କିମ୍ବ  ଆପଣ ଆର୍ଜେ କରିବ କୁ ଚ ହ ଁୁଥ୍ବି  ସମସ୍ତ ପ ର ଗ୍ର ଫ୍ 

ଚୟନ କରନ୍ତୁ | 

1. Do any of the following: 

Home କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର, ପ ର ଗ୍ର ଫ୍ ଗରୁ୍ପ ୍କ୍ର, ଇକ୍େଣ୍ଟ୍ ବ or ା ନ୍ତୁ କିମ୍ବ  ଇକ୍େଣ୍ଟ୍ ହ୍ର ସ ବଟନ୍ କ୍ିକି୍ କରନ୍ତୁ |
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TIP କ୍ଯପଯଡୟନ୍ତ ପ ର ଗ୍ର ଫ୍  ଆଲ ଇକ୍ନ୍ େଣ୍ଟ୍ ଯଥ୍ ଥ୍ଡ ନୁକ୍ହ ,ଁ ପ ର ଗ୍ର ଫ୍  ର ର୍ ହ ଣ ଧ ରଟି ଚିର 

କ୍ହ ଇଯିବ , କିନ୍ତୁ କ line ଣସି  ଧ ର୍ି ସଠିକ୍ ଇକ୍େଣ୍ଟ କିମ୍ବ  ପୁରୁଣ  ବ ହ କ୍ର ବିସ୍ତ ର କ୍ହବ ନ ହି  ଁ| 

 
 
 

 
 

● ପ ର ଗ୍ର ଫ୍ ର୍ ୟଲଗ ୍ବେ କ୍ଖ୍ ଲ | ଇକ୍େଣ୍ଟସ ୍ଏବଂ କ୍ସ୍ପସ ୍ଟୟ ବ୍ ଉପକ୍ର, ଇକ୍େକ୍ଣ୍ଟସନ୍ କ୍କ୍ଷତ୍ରକ୍ର, ଇକ୍େଣ୍ଟକୁ ବ ମ 

ବ େକ୍ର କ୍ସଟ୍ କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର ଓକ୍କ କିି୍କ୍ କରନ୍ତୁ |. 

● Ruler େ ସକ ଉପକ୍ର, ବ ମ ଇକ୍େଣ୍ଟ ମ କଡରକୁ େ ସକ ମ ପକୁ ଟ ଣନ୍ତୁ କ୍ଯଉଠଁ କ୍ର 

ଆପଣ ପ ର ଗ୍ର ଫର େରୀରର ବ ମ ପ ର୍ଶ୍ଡକୁ ରଖ୍ବି କୁ ଚ ହ ଁୁଛନି୍ତ |. 

To create a hanging indent or first line indent 

1.  କସଡର୍ କ ୁପ ର ଗ୍ର ଫର କ୍ଯକ anywhere ଣସି ସ୍ଥ ନକ୍ର ରଖ୍ନ୍ତୁ, କିମ୍ବ  ଆପଣ ଆର୍ଜେ କରିବ କୁ 

ଚ ହ ଁୁଥ୍ବି  ସମସ୍ତ ପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ  

2. ପ ର ଗ୍ର ଫ୍ ର୍ ୟଲଗ ୍ବେ କ୍ଖ୍ ଲ | ଇକ୍େଣ୍ଟସ ୍ଏବଂ କ୍ସ୍ପସ ୍ଟୟ ବ୍ ଉପକ୍ର, ଇକ୍େଣ୍ଟସ ୍ଅଞ୍ଚେକ୍ର, ପ୍ରଥ୍ମ ଲ ଇନ୍ କିି୍କ୍ କରନ୍ତୁ 

କିମ୍ବ  କ୍ସ୍ପେ ଲ୍ ବେକ୍ର ହୟ ଙ୍୍ଗ କରନ୍ତୁ | 

3. ବେକ୍ର, ଇକ୍େଣ୍ଟର ପରିମ ଣ କ୍ସଟ୍ କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର ଓକ୍କ କ୍ିିକ୍ କରନ୍ତୁ |Or 

1. ଅନୁକ୍େଦ େରୀରର ବ ମ ଇକ୍େଣ୍ଟ କ୍ସଟ୍ କରନ୍ତୁ | 

2. େ ସକ ଉପକ୍ର, ପ୍ରଥ୍ମ ଲ ଇନ୍ ଇକ୍େଣ୍ଟ ମ କଡରକୁ େ ସକ ମ ପକୁ ଟ ଣନ୍ତୁ କ୍ଯଉଠଁ କ୍ର ଆପଣ ଅନୁକ୍େଦର ପ୍ରଥ୍ମ ଧ ର୍ି 

ଆରମ୍ଭ କରିବ କୁ ଚ ହ ଁୁଛନି୍ତ | 

To indent or outdent the right edge of a paragraph 

1.  କସଡର୍ କ ୁପ ର ଗ୍ର ଫର କ୍ଯକ anywhere ଣସି ସ୍ଥ ନକ୍ର ରଖ୍ନ୍ତୁ, କିମ୍ବ  ଆପଣ ଆର୍ଜେ କରିବ କୁ ଚ ହ ଁୁଥ୍ବି  ସମସ୍ତ 

ପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ | 

. ନିମ୍ ନଲିଖ୍ତି ମଧ୍ୟରୁ କ Do ଣସିଟ ିକରନ୍ତୁ: 

● Ruler େ ସକ ଉପକ୍ର, ର ଇଟ୍ ଇକ୍େଣ୍ଟ ମ କଡରକୁ େ ସକ ମ ପକୁ ଟ ଣନ୍ତୁ କ୍ଯଉଠଁ କ୍ର ଆପଣ ଅନୁକ୍େଦର 

ସବଡ ଧକି ର୍ ହ ଣ ଧ ର କ୍ସଟ୍ କରିବ କୁ ଚ ହ ଁୁଛନି୍ତ |  

● ପ ର ଗ୍ର ଫ୍ ର୍ ୟଲଗ ୍ବେ କ୍ଖ୍ ଲ | ଇକ୍େକ୍ଣ୍ଟସନ୍ ଏବଂ କ୍ସ୍ପସ ୍ଟୟ ବ୍ ଉପକ୍ର, ଇକ୍େକ୍ଣ୍ଟସନ୍ କ୍କ୍ଷତ୍ରକ୍ର, 

ର୍ ହ ଣ ବ େକ୍ର ର୍ ହ ଣ ଇକ୍େଣ୍ଟ କ୍ସଟ୍ କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର ଓକ୍କ କିି୍କ୍ କରନ୍ତୁ |. 
 

TIP You cannot increase or decrease the indent beyond the margins by 

using the Increase Indent and Decrease Indent buttons. If you do need to 

extend an indent beyond the margins, you can do so by setting negative indenta- 

tion measurements in the Paragraph dialog box. 
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Structure content manually 
କ୍ବକ୍େକ୍ବକ୍େ ଏହ  ଏକ ଅନୁକ୍େଦ ମଧ୍ୟକ୍ର ପ ଠୟକୁ ମ ନୁଆଲ୍ ସ୍ଥ ନିତ କରିବ  ଆବେୟକ | ଦୁଇଟ ି ଭିନ୍ନ 

ଲୁକ୍କ ୟିତ ଅକ୍ଷର ବୟବହ ର କରି ଆପଣ ଏହ  କରିପ ରିକ୍ବ: କ୍ରଖ୍  କ୍େକ୍ ଏବଂ ଟୟ ବ୍ | ଏହି ଅକ୍ଷରଗଡୁିକ 

ଦୃେୟମ ନ ହୁଏ କ୍ଯକ୍ତକ୍ବକ୍େ ପ ର ଗ୍ର ଫ୍ ମ କଡ ଏବଂ ଫମଡ ଟିଂ ସକ୍ଙ୍କତ କ୍ଦଖ୍ ଇବ କୁ ବିକଳ୍ପ ଅନ୍ 

କ୍ହ ଇଯ ଏ |. 

Configure paragraph borders and shading 
To make a paragraph really stand out, you might want to put a border around 

it or shade its background. (For real drama, you can do both.) You can select a 

predefined border from the Borders menu, or design a custom border in the 

Borders And Shading dialog box. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
You can customize many aspects of the border 

 

After you select the style, color, width, and location of the border, you can 

click the Options button to specify its distance from the text. 
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TIP ଏକ ଲ ଇନ୍ କ୍େକ ୍ସନି୍ନକ୍ବେ କରିବ  ଏକ ନୂତନ ଅନୁକ୍େଦ ଆରମ୍ଭ କକ୍ର ନ ହି,ଁ କ୍ତଣ ୁ

କ୍ଯକ୍ତକ୍ବକ୍େ ଆପଣ ପ ର -ଗ୍ର ଫ୍ ଫମଡ ଟିଂକୁ କ୍ଟେଟ୍ ର ଏକ ଧ ର୍ିକ୍ର ପ୍ରକ୍ୟ ଗ କରନି୍ତ ଯ ହ  ଏକ 

ଲ ଇନ୍ କ୍େକ୍ ସହିତ ସମ ପ୍ତ ହୁଏ, ଫମଡ ଟିଂ କ୍କବେ କ୍ସହି ଧ ଡିକ୍ର ନୁକ୍ହ,ଁ ସମଗ୍ର ଅନୁକ୍େଦକ୍ର 

ପ୍ରକ୍ୟ ଗ ହୁଏ |  

 
SEE ALSO ପ ୃଷ୍ ଠ  ଏବଂ ବିଭ ଗ କ୍େକ୍ ବିଷୟକ୍ର ସ ୂଚନ  ପ ଇ ,ଁ  ମ ଇକ୍ର ସଫ୍ଟ  ୱ ର୍ ଡ 2016 ର 

ଅଧ୍ୟ ୟ 12, “ର୍କୁୟକ୍ମଣ୍ଟଗ ୁର୍ିକ  ଫ ଇନ ଲ ଏବଂ ବଣ୍ଟନ” କ୍ର “ପ୍ରକ୍ତୟକ ପ ୃଷ୍ ଠ କ୍ର ଯ ହ  

କ୍ଦଖ୍ ଯ ଏ ତ ହ  ନିୟନ୍ତ୍ରଣ କରନ୍ତୁ” କ୍ଦଖ୍ନ୍ତୁ |( Microsoft Press, 2015).  

ଜ ୋନ୍  ଲୋମବର୍ଟଙ୍କ ଦ୍  Step ାୋରୋ ପର୍ଯଟୟୋୟ (ମୋଇଜରୋସଫ୍ଟ  ଜେସ ୍, 2015) | 

 

 

 

The hidden characters have distinctive appearances: 

■ A line break character looks like a bent left arrow: ⮠ 

■ A tab character looks like a right-pointing arrow: ⭢ 

 

ପ ର ଗ୍ର ଫ୍ କ୍େଷ ନକରି ଏକ ନଦିିେ ସ୍ଥ ନକ୍ର ଏକ ପ ର ଗ୍ର ଫ୍ ର ଏକ ଧ ର୍ି ଗଡୁ ଇ ରଖ୍ବି  ପ ଇ ଁଆପଣ ଏକ ଲ ଇନ୍ କ୍େକ ୍

ବୟବହ ର କରିପ ରିକ୍ବ | ଆପଣ ହୁଏତ ଏହି କ que େେକ ୁଏକ ଧ ର୍କି୍ର କ୍କବେ ନଦିିେ ପ ଠୟ ପ୍ରଦେଡନ କରିବ କୁ, କିମ୍ବ  ଏକ େବ୍ଦ 

ପବୂଡରୁ ଏକ କ୍ରଖ୍  ଭ ଙି୍ଗବ  ପ ଇ ଁବୟବହ ର କରିପ ରନି୍ତ ଯ ହ  ଅନୟଥ୍  ହ ଇକ୍ଫକ୍ନ୍ ଟର୍୍ କ୍ହବ | 
 

 

ଏକ ଟୟ ବ୍ ବର୍ଣ୍ଡ ଦୁଇଟି ର୍କୁୟକ୍ମଣ୍ଟ୍ ଉପ ଦ ନ ମଧ୍ୟକ୍ର ଥ୍ବି  ସ୍ଥ ନକୁ ବୟ ଖ୍ୟ  କକ୍ର | ଉଦ ହରଣ ସ୍ୱରୂପ, ଆପଣ ଟୟ ବ୍ ବୟବହ ର 

କରି ତ ଲିକ  ଆଇଟମ,୍ କିମ୍ବ  ପ ଠୟ ସ୍ତମ୍ଭରୁ ସଂଖ୍ୟ ଗଡୁିକ ୁପଥୃ୍କ କରିପ ରିକ୍ବ | ତ ପକ୍ର ଆପଣ ଟୟ ବ୍ େପ ୍କ୍ସଟ୍ କରିପ ରିକ୍ବ 

ଯ ହ  ଟୟ ବର୍୍ କ୍ଟେଟ୍ ର ଅବସ୍ଥ ନ ଏବଂ ଆଲ ଇକ୍ନ୍ େଣ୍ଟକୁ ବୟ ଖ୍ୟ  କକ୍ର | 
 

You can align text in different ways by using tabs 

 

ଏକ ଟୟ ବ୍ ବର୍ଣ୍ଡ ଦୁଇଟି ର୍କୁୟକ୍ମଣ୍ଟ୍ ଉପ ଦ ନ ମଧ୍ୟକ୍ର ଥ୍ବି  ସ୍ଥ ନକୁ ବୟ ଖ୍ୟ  କକ୍ର | ଉଦ ହରଣ ସ୍ୱରୂପ, ଆପଣ ଟୟ ବ୍ ବୟବହ ର 

କରି ତ ଲିକ  ଆଇଟମ,୍ କିମ୍ବ  ପ ଠୟ ସ୍ତମ୍ଭରୁ ସଂଖ୍ୟ ଗଡୁିକ ୁପଥୃ୍କ କରିପ ରିକ୍ବ | ତ ପକ୍ର ଆପଣ ଟୟ ବ୍ େପ ୍କ୍ସଟ୍ କରିପ ରିକ୍ବ 

ଯ ହ  ଟୟ ବର୍୍ କ୍ଟେଟ୍ ର ଅବସ୍ଥ ନ ଏବଂ ଆଲ ଇକ୍ନ୍ େଣ୍ଟକୁ ବୟ ଖ୍ୟ  କକ୍ର |



Structure content manually 

81 

 

 

 
 
 

 

The tab settings 
 

You have the following tab options: 

3 
 

■ Left Tab : ଟୟ ବ୍ େପ ୍ସହିତ କ୍ଟେଟ୍ ର ବ ମ ମେୁକୁ ଆଲ ଇନ୍ କରନ୍ତୁ | 

■ Center Tab : ଟୟ ବ୍ େପ ୍ସହିତ ପ ଠୟର କ୍କନ୍ଦ୍ରକୁ ଆଲ ଇନ୍ କରନ୍ତୁ | 

■ Right Tab : ଟୟ ବ୍ େପ ୍ସହିତ କ୍ଟେଟ୍ ର ର୍ ହ ଣ ମେୁକୁ ଆଲ ଇନ୍ କରନ୍ତୁ | 

■ Decimal Tab : କ୍ଟେ େପ ୍ସହିତ କ୍ଟେଟ୍ କ୍ର ଦେମିକ ବିନୁ୍ଦ (ସ ଧ ରଣତ a ଏକ 

ସ ଂଖ୍ୟିକ ମଲୂୟ) ଆଲ ଇନ୍ କରନ୍ତୁ |  

■ Bar Tab : ଟୟ ବ୍ େପ ୍ସି୍ଥତିକ୍ର ଏକ ଭୂଲମ୍ବ କ୍ରଖ୍  ଅଙ୍କନ କକ୍ର | 
 

ଯଦି ଆପଣ େ ସକ ଉପକ୍ର ଟୟ ବ୍ େପ ୍ସି୍ଥର କରିବ  ଅତୟନ୍ତ କେକର, କ୍ତକ୍ବ ଆପଣ ଟୟ ବ୍ ର୍ ୟଲଗ ୍ବେରୁ ଟୟ ବ୍ େପ ୍କ୍ସଟ୍, 

ସଫ , ଆଲ ଇନ୍ ଏବଂ ଫମଡ ଟ୍ କରିପ ରିକ୍ବ | 
■  

You can specify the alignment and tab leader for each tab 
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ଯଦି ଆପଣ ଟୟ ବ୍ ଲିର୍ର୍ ବୟବହ ର କରିବ କୁ ଚ ହ ଁ ନି୍ତ କ୍ତକ୍ବ ଆପଣ ଏହି ର୍ ୟଲଗ ୍ବେରୁ କ ମ କରିପ ରିକ୍ବ - ଦୃେୟମ ନ ମ କଡ 

କ୍ଯପରିକି ର୍ଟ୍ କିମ୍ବ  ର୍ୟ ସ ୍ଟୟ ବ୍ ପବୂଡରୁ କ୍ଟେଟ୍ ସହିତ କ୍ଟେଟ୍ ସହିତ ସଂକ୍ଯ ଗ କରୁଥ୍ବି  ର୍ୟ ସ ୍| ଉଦ ହରଣ ସ୍ୱରୂପ, ପ ଠୟରୁ 

ପଷୃ୍ଠ  ନମ୍ବରକ ୁଆଖ୍ ିବହନ କରିବ କୁ ବିଷୟବସୁ୍ତର ଏକ ସ ରଣୀକ୍ର ଟୟ ବ୍ କ୍ନତ ମ କ୍ନ ଉପକ୍ଯ ଗୀ | 

 
କ୍ଯକ୍ତକ୍ବକ୍େ ଆପଣ ଟୟ ବ୍ ଅକ୍ଷର ସନି୍ନକ୍ବେ କରନି୍ତ, ଟୟ ବ୍ ଅକ୍ଷରର ର୍ ହ ଣକ୍ର ଥ୍ବି  କ୍ଟେଟ୍ ଏହ ର ପ୍ରକ ର ଅନୁଯ ୟୀ େପ ୍

କ୍ହ ଇଯ ଏ | ଉଦ ହରଣ ସ୍ୱରୂପ, ଯଦି ଆପଣ ଏକ କ୍ସଣ୍ଟର୍ ଟୟ ବ୍ େପ ୍କ୍ସଟ୍ କରନି୍ତ, ଟୟ ବ୍ କୀ ଦବ ଇବ  ଦ୍ୱ ର  କ୍ଟେଟ୍ ଘଞିୁ୍ଚବ ଯ ହ  

ଦ୍ its ା ର  ଏହ ର କ୍କନ୍ଦ୍ର ଟୟ ବ୍ େପ ୍ସହିତ ସମ ନ୍ତର େ କ୍ହବ | 

 

ପ ର ଗ୍ର ଫ୍ ମ କଡ ଏବଂ ଅନୟ ନୟ ଗଠନମେୂକ ବର୍ଣ୍ଡଗରୁ୍କି ପ୍ରଦେଡନ କିମ୍ବ  ଲୁଚ ଇବ  ପ ଇ ଁ| 

●  ନିମ୍ ନଲିଖ୍ତି ମଧ୍ୟରୁ କ୍ଗ ଟିଏ କରନ୍ତୁ: 

● Home କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର, ପ ର ଗ୍ର ଫ୍ ଗରୁ୍ପ ୍କ୍ର, କ୍ଦଖ୍ ନ୍ତୁ / ଲୁଚ ନ୍ତୁ ¶ ବଟନ୍ କିି୍କ୍ କରନ୍ତୁ |  

● Press Ctrl+Shift+* (asterisk). 

To insert a line break 

1. କ୍ଯଉଠଁ କ୍ର ଆପଣ କ୍ରଖ୍  ଭ ଙି୍ଗବ କୁ ଚ ହ ଁୁଛନି୍ତ କସଡର୍ ରଖ୍ନ୍ତୁ | 

2. ନିମ୍ନଲିଖ୍ତି ମଧ୍ୟରୁ କ Do ଣସିଟି କରନ୍ତୁ: 

Page କ୍ଲଆଉଟ୍ ଟୟ ବ୍ ଉପକ୍ର, କ୍ପଜ୍ କ୍ସଟଅପ ୍ଗରୁ୍ପ ୍କ୍ର, କ୍େକ୍ କିି୍କ୍ କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର କିି୍କ୍ କରନ୍ତୁ | 

ପ ଠୟ ର ପିଙ୍୍ଗ | 

3.press Shift + Enter ଦବ ନ୍ତୁ | 

To insert a tab character 

1. କ୍ଯଉଠଁ କ୍ର ଆପଣ ଟୟ ବ୍ ବର୍ଣ୍ଡ କ୍ଯ ରି୍ବ କୁ ଚ ହ ଁୁଛନି୍ତ, କସଡର୍ ରଖ୍ନ୍ତୁ | 

2.ଟୟ ବ୍ କୀ ଦବ ନ୍ତୁ | 

To open the Tabs dialog box 

1. ଏକ କିମ୍ବ  ଅଧକି ପ ର ଗ୍ର ଫ୍ ର କ୍ଯକ portion ଣସି ଅଂେ ଚୟନ କରନ୍ତୁ ଯ ହ  ପ ଇ ଁଆପଣ ଟୟ ବ୍ େପ ୍ପରିଚ େନ  କରିବ କୁ ଚ ହ ଁୁଛନି୍ତ | 

2. ପ ର ଗ୍ର ଫ୍ ର୍ ୟଲଗ ୍ବେ କ୍ଖ୍ ଲ | 

3. ଇକ୍େଣ୍ଟସ ୍ଏବଂ କ୍ସ୍ପସ ୍ଟୟ ବ୍ ର ନିମ୍ ନ-ବ ମ କ୍କ ଣକ୍ର, ଟୟ ବ୍ ସ ବଟନ୍ କ୍ିିକ୍ କରନ୍ତୁ |
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TIP When you manually align a tab and set a tab stop, Word removes any 

default tab stops to the left of the one you set. 

 

 

To align a tab and set a tab stop 

1.  ଏକ କିମ୍ବ  ଅଧକି ପ ର ଗ୍ର ଫ୍ ର କ୍ଯକ portion ଣସି ଅଂେ ଚୟନ କରନ୍ତୁ ଯ ହ  ପ ଇ ଁଆପଣ ଟୟ ବ୍ 

େପ ୍କ୍ସଟ୍ କରିବ କୁ ଚ ହ ଁୁଛନି୍ତ | 

ଟୟ ବ୍ େପ ୍ମ ଧ୍ୟମକ୍ର ଚର କରିବ କୁ େ ସକଙ୍କ ବ ମ ମେୁକ୍ର ଥ୍ବି  ଟୟ ବ୍ ବଟନ୍ କ୍ିକି୍ କରନ୍ତୁ | 

2. ଆଲ ଇକ୍ନ୍ େଣ୍ଟ, ଏହି ରମକ୍ର: 3 | 

3. ● ବ ମ 

4. ● କ୍କନ୍ଦ୍ର 

5. ● ଠିକ ୍

6. ● ଦେମିକ 

7. ● ବ ର୍ 

8. When the Tab button shows the alignment you want, click the ruler at the point 

where you want to set the tab. 
 

Or 

1. ଟୟ ବ୍ ସ ର୍ ୟଲଗ ୍ବେ କ୍ଖ୍ ଲନ୍ତୁ | 

2. ଟୟ ବ୍ େପ ୍କ୍ପ ଜିସନ୍ ବେକ୍ର, ନୂଆ ଟୟ ବ୍ େପ ୍ପ ଇ ଁକ୍ପ ଜିସନ୍ ପ୍ରକ୍ବେ କରନ୍ତୁ | 

3. ଆଲ ଇକ୍ନ୍େଣ୍ଟ୍ ଏବଂ ଲିର୍ର୍ କ୍କ୍ଷତ୍ରକ୍ର, ଏହି ଟୟ ବ୍ େପ ୍ପ ଇ ଁଆପଣ ଚ ହ ଁୁଥ୍ବି  ବିକଳ୍ପଗରିୁ୍କ କ୍ସଟ୍ କରନ୍ତୁ | 

4. ଟୟ ବ୍ କ୍ସଟ୍ କରିବ କୁ କ୍ସଟ୍ କିି୍କ୍ କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର ଓକ୍କ କିି୍କ୍ କରନ୍ତୁ | 

 

ଏକ ବିଦୟମ ନ କେମ ୍ଟୟ ବ୍ େପ ୍ର ସି୍ଥତି ପରିବତ୍ତଡନ କରିବ କୁ | 

1. Do either of the following: 

 

● The େ ସକ ଉପକ୍ର ଟୟ ବ ମ କଡର ଟ ଣନ୍ତୁ | 

● Tab ଟୟ ବ୍ ସ ର୍ ୟଲଗ ୍ବେ କ୍ଖ୍ ଲ | ଟୟ ବ୍ େପ ୍କ୍ପ ଜିସନ୍ ତ ଲିକ କ୍ର, ଆପଣ ପରିବତ୍ତଡନ କରିବ କୁ ଚ ହ ଁୁଥ୍ବି  

ଟୟ ବ୍ େପ ୍ଚୟନ କରନ୍ତୁ | ବିଦୟମ ନ ଟୟ ବ୍ େପ ୍ସଫ  କରିବ କୁ ସଫ  ବଟନ୍ କ୍ିିକ୍ କରନ୍ତୁ | ଟୟ ବ୍ େପ ୍

କ୍ପ ଜିସନ୍ ବେକ୍ର ରିକ୍ଲସିକ୍ମଣ୍ଟ ଟୟ ବ୍ େପ ୍କ୍ପ ଜିସନ୍ ପ୍ରକ୍ବେ କରନ୍ତୁ, କ୍ସଟ୍ କ୍ିିକ୍ କରନ୍ତୁ ଏବଂ ତ ପକ୍ର ଓକ୍କ 

କ୍ିିକ୍ କରନ୍ତୁ |
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To remove a custom tab stop 

1. Do either of the following: 

 

● The େ ସକ ଉପକ୍ର ଟୟ ବ ମ କଡର ଟ ଣନ୍ତୁ | 

● Tab ଟୟ ବ୍ ସ ର୍ ୟଲଗ ୍ବେ କ୍ଖ୍ ଲ | ଟୟ ବ୍ େପ ୍କ୍ପ ଜିସନ୍ ତ ଲିକ କ୍ର, ଆପଣ ପରିବତ୍ତଡନ କରିବ କୁ ଚ ହ ଁୁଥ୍ବି  

ଟୟ ବ୍ େପ ୍ଚୟନ କରନ୍ତୁ | ବିଦୟମ ନ ଟୟ ବ୍ େପ ୍ସଫ  କରିବ କୁ ସଫ  ବଟନ୍ କ୍ିିକ୍ କରନ୍ତୁ | ଟୟ ବ୍ େପ ୍

କ୍ପ ଜିସନ୍ ବେକ୍ର ରିକ୍ଲସିକ୍ମଣ୍ଟ ଟୟ ବ୍ େପ ୍କ୍ପ ଜିସନ୍ ପ୍ରକ୍ବେ କରନ୍ତୁ, କ୍ସଟ୍ କ୍ିିକ୍ କରନ୍ତୁ ଏବଂ ତ ପକ୍ର ଓକ୍କ 

କ୍ିିକ୍ କରନ୍ତୁ | 

Apply character formatting 
ତୁମର ର୍କୁୟକ୍ମଣ୍ଟର ଦୃେୟ କ୍କବେ ର୍କୁୟକ୍ମଣ୍ଟର ବ ତ୍ତଡ  ନୁକ୍ହ ଁବରଂ ର୍କୁୟକ୍ମଣ୍ଟର ସେିୃକତ୍ତଡ  ବିଷୟକ୍ର ସଚୂନ  ମଧ୍ୟ ପହଞ୍ଚ ଇବ କ୍ର 

ସ ହ ଯୟ କକ୍ର | ଏକ ସସୁଜି୍ଜତ ସଂଗଠିତ ର୍କୁୟକ୍ମଣ୍ଟ ଯ ହ  ରମ ଗତ ଭ ବକ୍ର ଫମଡ ଟ୍ କ୍ହ ଇଥ୍ବି  ବିଷୟବସୁ୍ତ ଏବଂ ଉପଯକୁ୍ତ 

ଗ୍ର ଫିକ୍ ଉପ ଦ ନଗଡୁକିୁ ଧ ରଣ କରିଥ୍ ଏ, ଏବଂ ଏଥ୍କି୍ର ବନ ନ କିମ୍ବ  ବୟ କରଣଗତ ତ୍ରୁଟ ିଧ ରଣ କକ୍ର ନ ହି,ଁ କ୍ଯକ any ଣସି 

ଉତ୍ପ ଦ କିମ୍ବ  କ୍ସବ  ପ୍ରଦ ନ କରିବ ର କ୍ଷମତ  ଉପକ୍ର ଅଧକି ଆତ୍ମବିର୍ଶ୍ ସ ଆହ୍ .ା ନ କକ୍ର | 

 

ପବୂଡରୁ ଏହି ଅଧ୍ୟ ୟକ୍ର, ଆପଣ ପ ର ଗ୍ର ଫକ୍ର ଫମଡ ଟିଂ ପ୍ରକ୍ୟ ଗ କରିବ ର ପଦ୍ଧତି ବିଷୟକ୍ର ଜ ଣକି୍ଲ | ଏହି ବିଷୟଟ ିଏକ 

ର୍କୁୟକ୍ମଣ୍ଟର ପ ଠୟ ଫମଡ ଟିଂ କରିବ ର ପଦ୍ଧତିକୁ ଅନ୍ତଭଡୁ କ୍ତ କକ୍ର | ଆପଣ ପ ଠୟକ୍ର ପ୍ରକ୍ୟ ଗ କରୁଥ୍ବି  ଫମଡ ଟିଂକୁ ଅକ୍ଷର ଫମଡ ଟିଂ 

ଭ ବକ୍ର କୁହ ଯ ଏ | ୱ ର୍ଡ ର୍କୁୟକ୍ମଣ୍ଟକ୍ର, ଆପଣ ତିନି ପ୍ରକ ରର ବର୍ଣ୍ଡ ଫମଡ ଟିଂ ପ୍ରକ୍ୟ ଗ କରିପ ରିକ୍ବ: 

 

▪ Font ଫଣ୍ଟ, ଫଣ୍ଟ୍ ସ ଇଜ୍, କ୍ବ ଲ୍ଡ, ଇଟ ଲିକ୍, ଅେରଲ ଇନ୍, େର ଇକ୍ର , ସବସିି୍କଲଟ, ସପୁରସି୍କିଲ ଟ, ଫଣ୍ଟ ରଙ୍ଗ ଏବଂ 

ହ ଇଲ ଇଟ୍ ରଙ୍ଗ ସହିତ ବୟକି୍ତଗତ ବର୍ଣ୍ଡ ଫମଡ ଟ୍ | 

▪ କେ ତ୍ମକ ପ ଠୟ ପ୍ରଭ ବ ଯ ହ  ବର୍ଣ୍ଡ ବ ହୟକ୍ରଖ୍  ଅନ୍ତଭଡୂ କ୍ତ କକ୍ର ଏବଂ ରଙ୍ଗ ଭରିଥ୍ ଏ | 

o ର୍କୁୟକ୍ମଣ୍ଟ୍ କ୍ଟମ୍ପକ୍ଲଟ୍ ସହିତ ଜର୍ିତ ପି୍ରଫମଡ କ୍ଟର୍୍ େ yles େୀ, ଯ ହ  ମଧ୍ୟରୁ ଅକ୍ନକ କ୍କବେ ପ ଠୟର 

ରୂପକୁ ପ୍ରଭ ବିତ କକ୍ର ନ ହି ଁବରଂ ଗଠନମେୂକ ସଚୂନ  ମଧ୍ୟ ପ୍ରଦ ନ କକ୍ର (କ୍ଯପରିକି ଟ ଇଟଲ୍ ଏବଂ 

କ୍ହର୍ିଙ୍୍ଗ) | 

କ୍ଯକ୍ତକ୍ବକ୍େ ଆପଣ ଏକ ର୍କୟୁକ୍ମଣ୍ଟକ୍ର କ୍ଟେଟ୍ ଏଣ୍ଟର୍ କରନି୍ତ, ଏହ  ଏକ ନିଦିେ ଫଣ୍ଟକ୍ର ପ୍ରଦେତି ହୁଏ | ର୍ିଫଲ୍ଟ ଭ ବକ୍ର, ଏକ 

ନୂତନ ଖ୍ ଲି ର୍କୁୟକ୍ମଣ୍ଟକ୍ର ପ ଠୟ ପ ଇ ଁବୟବହୃତ ଫଣ୍ଟ କ୍ହଉଛି 11-ପଏଣ୍ଟ କ ଲିେି, କିନ୍ତୁ ଆପଣ କ୍ଯକ any ଣସି ସମୟକ୍ର କ୍ଯକ 

element ଣସି ଉପ ଦ ନର ଫଣ୍ଟ ପରିବତ୍ତଡନ କରିପ ରିକ୍ବ | ସଂସ୍ଥ ପିତ ଆପଗଡୁିକ ଉପକ୍ର ନଭିଡର କରି ଉପଲବ୍ଧ ଫଣ୍ଟଗଡୁକି 

କ୍ଗ ଟିଏ କମ୍ପୟୁଟରରୁ ଅନୟ କମ୍ପୟୁଟରକ୍ର ଭିନ୍ନ କ୍ହ ଇଥ୍ ଏ | ସ ଧ ରଣ ଫଣ୍ଟଗଡୁିକକ୍ର ଆରିଆଲ୍, ଭର୍ଡ ନ , ଏବଂ ଟ ଇମ୍ସ ନୁୟ 

କ୍ର ମ ନ୍ ଅନ୍ତଭଡୁ କ୍ତ |. 

You can vary the look of a font by changing the following attributes: 

■ Size:  ପ୍ର ୟ ପ୍ରକ୍ତୟକ ଫଣ୍ଟକ୍ର ଏକ ଆକ ରର ପରିସର ଅଛି ଯ ହ କୁ ଆପଣ ଚୟନ କରିପ ରିକ୍ବ | 

(କ୍ବକ୍େକ୍ବକ୍େ ଆପଣ ତ ଲିକ ଭୁକ୍ତ କ୍ହ ଇଥ୍ବି  କ୍ଲ କଙ୍କଠ ରୁ ଅତିରିକ୍ତ ଆକ ର କ୍ସଟ୍ କରିପ ରିକ୍ବ | 

କ୍ଯପରି p) ଏକ ବିନୁ୍ଦ କ୍ହଉଛି ଏକ ଇଞ୍ଚର 1/72 (ପ୍ର ୟ 0.04 କ୍ସଣି୍ଟମିଟର) |
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■ Style:ପ୍ର  ୟ  ପ୍ର କ୍ ତ ୟ କ  ଫ ଣ୍ଟ କ୍ ର  ଫ ଣ୍ଟ  େ  s ty les  େ ୀ ର  ପ ରି ସ ର  ଅ ଛି  |  ସ ବୁ ଠ  ରୁ  ସ  ଧ ର ଣ  

କ୍ ହ ଉ ଛ ି  ନ ି ୟ ମି ତ  (କ ି ମ୍ବ   ସ  ଦ ) ,  ଇ ଟ  ଲି କ ୍ ,  କ୍ ବ ଲ୍ ଡ ଏ ବ ଂ  କ୍ ବ  ଲ୍ ଡ ଇ ଟ  ଲି କ ୍  |  

■ Effects: ପ୍ରଭ ବଗରୁ୍ିକ ପ୍ରକ୍ୟ ଗ କରି ଫଣ୍ଟଗରୁ୍ିକ ବୃଦି୍ଧ କର ଯ ଇପ ରିବ, କ୍ଯପରିକି ଅେରଲ ଇନ୍, 

କ୍ଛ ଟ କୟ ପିଟ ଲ୍ ଅକ୍ଷର (କ୍ଛ ଟ କୟ ପ)୍, କିମ୍ବ  ଛ ୟ  |. 

Character spacing: 3 କୁ ଦବ ଇ ଆପଣ ଅକ୍ଷର ମଧ୍ୟକ୍ର ବୟବଧ ନ ପରିବତ୍ତଡନ 

କରିପ ରିକ୍ବ |କ୍ସମ ନଙୁ୍କ ଅଲଗ  କିମ୍ବ  ଏକତ୍ର ଚିପିବ  | 

ଯଦିଓ କିଛି ଗଣୁ ପରସ୍ପରକୁ ବ ତିଲ୍ କରିପ କ୍ର, କ୍ସଗଡୁିକ ସ ଧ ରଣତ um ଏକତ୍ରିତ | ଉଦ ହରଣ ସ ୍.ରୁପ, ଆପଣ ଏକ କ୍ବ ଲ୍ଡ ଫଣ୍ଟ୍ 

େ style େୀକୁ ବିଭିନ୍ନ ଆକ ରକ୍ର ଏବଂ ସବୁଜ ରଙ୍ଗର ବିଭିନ୍ନ ଛ ଇକ୍ର ବୟବହ ର କରି େବ୍ଦଗଡୁିକୁ ଏକ ସମ୍ବ ଦ ଚିଠିକ୍ର ଛିର୍  କର ଇ 

ପ ରନି୍ତ | 

You apply character formatting from one of three locations: 

■ Mini Toolbar 

ମିନି ଟୁଲ୍ ବ ର୍ କ୍ର ଅକ୍ନକ ସ ଧ ରଣ ଫମଡ ଟିଂ ବଟନ୍ ଉପଲବ୍ଧ ଯ ହ କି ଆପଣ କ୍ଟେଟ୍ ଚୟନ କରିବ  ସମୟକ୍ର କ୍ଦଖ୍ ଯ ଏ |  

The Mini Toolbar appears temporarily when you select text, becomes transparent when you move 

the pointer away from the selected text, and then disappears entirely 

■ Font group on the Home tab:  ଏହି କ୍ଗ ଷ୍ଠୀ ଫଣ୍ଟ ବଦେ ଇବ  ପ ଇ ଁବଟନ୍ ଅନ୍ତଭଡୂ କ୍ତ 

କକ୍ର ଏବଂ ଆପଣ ବୟବହ ର କରିବ ର ସମ୍ଭ ବନ  ଥ୍ବି  ଅଧକି ଂେ ଫଣ୍ଟ୍ ଆଟ୍ରିବୁୟଟ୍ | 

The most common font formatting commands are available on the Home tab 

 

■ Font dialog box: ଫଣ୍ଟ ର୍ ୟଲଗ ୍ବେରୁ କମ-୍ସ ଧ ରଣ ପ୍ରକ୍ୟ ଗ ଗଣୁ କ୍ଯପରିକି କ୍ଛ ଟ କୟ ପ ୍

ଏବଂ ସ୍ୱତନ୍ତ୍ର ଅେରଲ ଇନ୍ ଉପଲବ୍ଧ |
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Font attributes that aren’t available on the Home tab can be set here 

 

ଅକ୍ଷରର ରୂପ ବଦେ ଇବ  ପ ଇ ଁଅକ୍ଷର ଫମଡ ଟିଂ ପ୍ରକ୍ୟ ଗ କରିବ  ସହିତ, ଆପଣ ଅଧକି ଜିଙ୍୍ଗ କ୍ଯ ର୍ିବ  ପ ଇ ଁଏକ ଚୟନକ୍ର ପବୂଡ 

ନିଦ୍ଧଡ ରିତ ପ ଠୟ ପ୍ରଭ ବଗରୁ୍ିକ (କ୍ବକ୍େକ୍ବକ୍େ ୱ ର୍ଡ ଆଟଡ କୁହ ଯ ଏ) ପ୍ରକ୍ୟ ଗ କରିପ ରିକ୍ବ | ଉପଲବ୍ଧ ପ୍ରଭ ବଗରୁ୍ିକ ସ ମ୍ପ୍ରତକି ଥ୍ମି ୍

ରଙ୍ଗ ସହିତ କ୍ମେ ଖ୍ ଉଛି | 
You can apply any predefined effect in the gallery or define a custom effect 
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TIP ମକ୍ନ ନୀତ ପ ଠୟକ୍ର େୀଘ୍ର ଏକ ଭିନ୍ନ ଅେରଲ ଇନ୍ େ style େୀ ପ୍ରକ୍ୟ ଗ କରିବ କୁ, କ୍ହ ମ  ୍ଟୟ ବ୍ 

ଅନ୍ତଗଡତ ଅେରଲ ଇନ୍ ବଟନ୍ ପ ଖ୍କ୍ର ଥ୍ବି  ତୀର କ୍ିିକ୍ କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର ତ ଲିକ କ୍ର, ଆପଣ 

ଅେରଲ ଇନ୍ େ style େୀକ୍ର କ୍ିିକ୍ କରନ୍ତୁ | 

ଆଜବଦନ କରିବୋକୁ ଚୋହ  ୁଛନ୍ତି | 

 

 

 
ଏହି ପ୍ରଭ ବଗରୁ୍ିକ କିଛି ମ ତ୍ର କ୍ର ନ ଟକୀୟ, କ୍ତଣ ୁଆପଣ କ୍ବ ଧହୁଏ କ୍ସମ ନଙ୍କର ବୟବହ ରକୁ ର୍କୁୟକ୍ମଣ୍ଟ୍ ଟ ଇଟଲ୍ ଏବଂ ସମ ନ 

ଉପ ଦ ନଗଡୁିକକ୍ର ସୀମିତ ରଖ୍ବି କୁ ଚ ହ ଁ ନି୍ତ ଯ ହ କୁ ଆପଣ ବିକ୍େଷ ଧ୍ୟ ନ କ୍ଦବ କୁ ଚ ହ ଁୁଛନି୍ତ | 

 

To change the font of selected text 

1. ମିନି ଟୁଲ୍ ବ ର୍ କ୍ର କିମ୍ବ  କ୍ହ ମ ୍ଟୟ ବ୍ କ୍ର ଥ୍ବି  ଫଣ୍ଟ୍ ଗରୁ୍ପ ୍କ୍ର, ଫଣ୍ଟ ତ ଲିକ କ୍ର, ଆପଣ ଆକ୍ବଦନ କରିବ କୁ ଚ ହ ଁୁଥ୍ବି  

ଫଣ୍ଟକୁ 3 କ୍ିିକ୍ କରନ୍ତୁ | 

To change the font size of selected text 

1. Do any of the following on the Mini Toolbar or in the Font group on the 

Home tab: 

ଫଣ୍ଟ୍ ସ ଇଜ୍ ତ ଲିକ କ୍ର, ଆପଣ ପ୍ରକ୍ୟ ଗ କରିବ କୁ ଚ ହ ଁୁଥ୍ବି  ଫଣ୍ଟ୍ ସ ଇଜ୍ କ୍ିିକ୍ କରନ୍ତୁ | 

Font ଫଣ୍ଟ୍ ସ ଇଜ୍ ବେକ୍ର, ଆପଣ ପ୍ରକ୍ୟ ଗ କରିବ କୁ ଚ ହ ଁୁଥ୍ବି  ଫଣ୍ଟ୍ ସ ଇଜ୍ ପ୍ରକ୍ବେ କରନ୍ତୁ (ଏପରିକି ଏକ ଆକ ର ଯ ହ  ତ ଲିକ କ୍ର 

କ୍ଦଖ୍ ଯ ଏ ନ ହି)ଁ | ତ ’ପକ୍ର ଏଣ୍ଟର୍ କୀ ଦବ ନ୍ତୁ | 

Set କ୍ସଟ୍ ଇନରିକ୍ମଣ୍ଟକ୍ର ଫଣ୍ଟ୍ ସ ଇଜ୍ ବ To ା ଇବ କୁ, ଫଣ୍ଟ୍ ସ ଇଜ୍ ବୃଦି୍ଧ କ୍ିିକ୍ କରନ୍ତୁ | 

ବଟନ୍, କିମ୍ବ  Ctrl +> ଦବ ନ୍ତୁ | 

Set କ୍ସଟ୍ ଇନରିକ୍ମଣ୍ଟକ୍ର ଫଣ୍ଟ୍ ସ ଇଜ୍ ହ୍ର ସ କରିବ କୁ, ଫଣ୍ଟ୍ ସ ଇଜ୍ ହ୍ର ସ କ୍ିିକ୍ କରନ୍ତୁ | 

ବଟନ୍, କିମ୍ବ  Ctrl + <ଦବ ନ୍ତୁ | 

To format selected text as bold, italic, or underlined 

Do any of the following: 

Mini ମିନି ଟୁଲ୍ ବ ର୍ କ୍ର, କ୍ବ ଲ୍ଡ, ଇଟ ଲିକ୍, କିମ୍ବ  ଅେରଲ ଇନ୍ ବଟନ୍ କିି୍କ୍ କରନ୍ତୁ | 

Home କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର, ଫଣ୍ଟ୍ ଗରୁ୍ପ ୍କ୍ର, କ୍ବ ଲ୍ଡ, ଇଟ ଲିକ୍ କିମ୍ବ  ଅେରଲ ଇନ୍ କିି୍କ୍ କରନ୍ତୁ | 

ବଟନ୍ 

ପ ଠୟକୁ କ୍ବ ଲ୍ଡ ଭ ବକ୍ର ଫମଡ ଟ୍ କରିବ କୁ Ctrl + B ଦବ ନ୍ତୁ | 

କ୍ଟେଟ୍ କୁ ଇଟ ଲିକ୍ ଭ ବକ୍ର ଫମଡ ଟ୍ କରିବ କୁ Ctrl + I ଦବ ନ୍ତୁ | 

1. ପ ଠୟକ ୁଅେରଲ ଇନ୍ କରିବ କ ୁCtrl + U ଦବ ନ୍ତୁ | 
 

 

To cross out selected text by drawing a line through it 
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କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର, ଫଣ୍ଟ୍ ଗରୁ୍ପ ୍କ୍ର, େର ଇକକ୍ର  ବଟନ୍ କ୍ିିକ୍ କରନ୍ତୁ |( On the Home tab, in the Font group, click the 

Strikethrough button)
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TIP To apply the Font Color button’s current color, you can simply click the 

button (not its arrow). If you want to apply a color that is not shown in the Theme 

Colors or Standard Colors palette, click More Colors. In the Colors dialog box, click the 

color you want in the honeycomb on the Standard page, or click the color gradient or 

enter values for a color on the Custom page. 

 

 

To display superscript or subscript characters 

 

1. ଆପଣ ରିକ୍ପ ଜିସନ୍ କରିବ କ ୁଚ ହ ଁୁଥ୍ବି  ବର୍ଣ୍ଡଗରୁ୍ିକ ଚୟନ କରନ୍ତୁ | 

2. କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର, ଫଣ୍ଟ୍ ଗରୁ୍ପ ୍କ୍ର, ନିମ୍ନଲିଖ୍ତି ମଧ୍ୟରୁ କ do ଣସିଟ ିକରନ୍ତୁ: 

3.ଅକ୍ଷରଗଡୁିକୁ ଲ ଇନର ତେ ଭ ଗକୁ ସ୍ଥ ନ ନ୍ତର କରିବ କୁ ସବସି୍କିଲ ଟ ବଟନ୍ କ୍ିିକ ୍କରନ୍ତୁ | 

4.ଅକ୍ଷରଗଡୁିକୁ ଲ ଇନର େୀଷଡକ ୁସ୍ଥ ନ ନ୍ତର କରିବ କୁ ସପୁରସି୍କିଲ ଟ ବଟନ୍ କ୍ିିକ ୍କରନ୍ତୁ | 

To apply artistic effects to selected text 

● 1. କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର, ଫଣ୍ଟ୍ ଗରୁ୍ପ ୍କ୍ର, କ୍ଟେଟ୍ ଇକ୍ଫକ୍ଟସ ୍ଏବଂ ଟ ଇକ୍ପ ଗ୍ର ଫି 

ବଟନ୍ କ୍ିିକ୍ କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର ନିମ୍ ନଲିଖ୍ତି ମଧ୍ୟରୁ କ do ଣସିଟି କରନ୍ତୁ: 

● Text କ୍ଟେଟ୍ ଇକ୍ଫକ୍ଟସ ୍ଏବଂ ଟ ଇକ୍ପ ଗ୍ର ଫି ଗୟ କ୍ଲରୀକ୍ର, ଆପଣ ପ୍ରକ୍ୟ ଗ କରିବ କୁ 

ଚ ହ ଁୁଥ୍ବି  ପି୍ରଫମଡର୍୍ ଇକ୍ଫକ୍ଟ ମିଶ୍ରଣକୁ କ୍ିିକ୍ କରନ୍ତୁ |. 

● କ୍ଟେଟ୍ ଇକ୍ଫକ୍ଟସ ୍ଏବଂ ଟ ଇକ୍ପ ଗ୍ର ଫି କ୍ମନୁକ୍ର, ଆଉଟ୍ ଲ ଇନ୍, ଛ ୟ , ପ୍ରତିଫେନ, କ୍୍ ି, 

ନମ୍ବର େ ଇଲ୍, ଲିଗ ଟର୍, କିମ୍ବ  େ ଇଲିେିକ ୍କ୍ସଟ୍ କ୍ିକି୍ କରନ୍ତୁ | ତ ପକ୍ର କ୍ସହ ିପ୍ରଭ ବଗରୁ୍ିକ 

ପ୍ରକ୍ୟ ଗ ଏବଂ ରୂପ ନ୍ତର କରିବ କୁ ସବକ୍ମନସ ୍ଉପକ୍ର ଚୟନ କରନ୍ତୁ |. 

To change the font color of selected text 
1. କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର, ଫଣ୍ଟ୍ ଗରୁ୍ପ ୍କ୍ର, ପ୍ରଦେଡନ କରିବ କ ୁଫଣ୍ଟ୍ ରଙ୍ଗ ତୀର କିି୍କ୍ କରନ୍ତୁ | 

ଫଣ୍ଟ ରଙ୍ଗ କ୍ମନୁ | 

2. ଥ୍ମି ୍କଲସଡ କିମ୍ବ  େ େ ର୍ଡ କଲସଡ ପୟ କ୍ଲଟ୍ କ୍ର, କ୍ସହି ରଙ୍ଗକୁ ମକ୍ନ ନୀତ ପ ଠୟକ୍ର ପ୍ରକ୍ୟ ଗ କରିବ  ପ ଇ ଁଏକ ରଙ୍ଗ ସି୍ୱଚ୍ ଚୟନ କରନ୍ତୁ | 
 

To change the case of selected text 

1. Do either of the following: 

1.Home କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର, ଫଣ୍ଟ୍ ଗରୁ୍ପ ୍କ୍ର, କ୍କସ ୍ପରିବତ୍ତଡନ ବଟନ୍ କ୍ିିକ ୍କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର କ୍ସକ୍ଣ୍ଟନ୍ ସ କ୍କସ,୍ କ୍ଲ ୟର 

କ୍କସ,୍ UPPERCASE, ପ୍ରକ୍ତୟକ ୱ ର୍ଡକ ୁକୟ ପିଟ ଲ ଇଜ୍ କରନ୍ତୁ କିମ୍ବ  କ୍ଟ ଗଲ୍ କ୍କସ ୍କ୍ିିକ୍ କରନ୍ତୁ |( On the Home tab, in the Font 

group, click the Change Case button, and then click Sentence case, lowercase, UPPERCASE, Capitalize Each Word, or tOGGLE cASE.) 

 

2.Standard େ େ ର୍ଡ କ୍କସ ୍ଅପ୍ସନ୍ (ବ କୟ କ୍କସ,୍ UPPERCASE, କ୍ଲ ୟର କ୍କସ,୍ ଏବଂ ପ୍ରକ୍ତୟକ େବ୍ଦକ ୁକୟ ପିଟ ଲ ଇଜ୍) 

ମ ଧ୍ୟମକ୍ର ଚର କରିବ କୁ ବ ରମ୍ବ ର Shift + F3 ଦବ ନ୍ତୁ |( Press Shift+F3 repeatedly to cycle through the standard case options 

(Sentence case, UPPERCASE, lowercase, and Capitalize Each Word).)
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To highlight text 3  
1. Select the text you want to change, and then do either of the following: 

● On the Mini Toolbar or in the Font group on the Home tab, click the Text 

Highlight Color button to apply the default highlight color. 

● On the Mini Toolbar or in the Font group on the Home tab, click the Text 

Highlight Color arrow, and then click a color swatch to apply the selected 

highlight color and change the default highlight color. 

Or 

1. Without first selecting text, do either of the following: 

● Click the Text Highlight Color button to select the default highlight color. 

● Click the Text Highlight Color arrow, and then click a color swatch to select 

that highlight color. 

2. When the pointer changes to a highlighter, drag it across one or more sections 

of text to apply the highlight. 

3. Click the Text Highlight Color button or press the Esc key to deactivate the 

highlighter. 

To copy formatting to other text 

1. Click anywhere in the text that has the formatting you want to copy. 

2. On the Home tab, in the Clipboard group, do either of the following: 

● If you want to apply the formatting to only one target, click the Format 

Painter button once. 

● If you want to apply the formatting to multiple targets, double-click the 

Format Painter button. 

3. When the pointer changes to a paintbrush, click or drag across the text you 

want to apply the copied formatting to. 

IMPORTANT The case options vary based on the selected text. If the 

selection ends in a period, Word does not include the Capitalize Each Word 

option in the rotation. If the selection does not end in a period, Word does not 

include Sentence case in the rotation. 
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IMPORTANT If you have selected an entire paragraph, clicking Clear All 

Formatting will clear character and paragraph formatting from the para- 

graph and reset it to the default paragraph style. 

 

 

4. If you activated the Format Painter for multiple targets, repeat step 3 until you 

finish applying the formatting. Then click the Format Painter button once, or 

press the Esc key, to deactivate the tool. 

To repeat the previous formatting command 

1. Select the text to which you want to apply the repeated formatting. 

2. Do either of the following to repeat the previous formatting command: 

● On the Quick Access Toolbar, click the Repeat button. 

● Press Ctrl+Y. 

To open the Font dialog box 

1. Do either of the following: 

● On the Home tab, in the Font group, click the Font dialog box launcher. 

● Press Ctrl+Shift+F. 

To remove character formatting 

1. Select the text you want to clear the formatting from. 

2. Do any of the following: 

● Press Ctrl+Spacebar to remove only manually applied formatting (and not 

styles). 

● On the Home tab, in the Font group, click the Clear All Formatting button to 

remove all styles and formatting other than highlighting from selected text. 
 

● On the Home tab, in the Font group, click the Text Highlight Color arrow 

and then, on the menu, click No Color to remove highlighting. 

To change the character spacing 

1. Select the text you want to change. 

2. Open the Font dialog box, and then click the Advanced tab to display character 

spacing and typographic features. 
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3. In the Spacing list, click Expanded or Condensed. 

4. In the adjacent By box, set the number of points you want to expand or condense 

the character spacing. 

5. In the Font dialog box, click OK. 

  3  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Create and modify lists 
ତ ଲିକ ଗଡୁକି କ୍ହଉଛି ପ ର ଗ୍ର ଫ୍ ଯ ହ  ଏକ ଅକ୍ଷରରୁ ଆରମ୍ଭ ହୁଏ (ସ ଧ ରଣତ a ଏକ ସଂଖ୍ୟ  କିମ୍ବ  ବୁକ୍ଲଟ୍) ଏବଂ ଏକ ing 

ାୁଲୁଥ୍ବି  ଇକ୍େଣ୍ଟ ସହିତ ଫମଡ ଟ୍ କ୍ହ ଇଥ୍ ଏ ଯ ହ  ଦ୍ each ା ର  ଅକ୍ଷରଗଡୁକି ପ୍ରକ୍ତୟକ ତ ଲିକ  ଆଇଟମ ୍ର ବ ମ ମେୁକ୍ର ଛିର୍  

କ୍ହ ଇଥ୍ ’ନି୍ତ | ସ Fort ଭ ଗୟବେତ ,, ୱ ର୍ଡ ଆପଣଙ୍କ ପ ଇ ଁତ ଲିକ ର ଫମଡ ଟିଂର ଯତ୍ନ ନିଏ | ଆପଣ ସେିୃ କରିବ କୁ ଚ ହ ଁୁଥ୍ବି  

ତ ଲିକ ର ପ୍ରକ ରକୁ ଆପଣ କ୍କବେ ସଚିୂତ କରନି୍ତ | କ୍ଯକ୍ତକ୍ବକ୍େ ଆଇଟମଗରୁ୍ିକର ରମ ଗରୁୁତ୍ୱପରୂ୍ଣ୍ଡ ନୁକ୍ହ ଁ- ଉଦ ହରଣ ସ୍ୱରୂପ, 

କ୍ଲ କ କିମ୍ବ  କ୍ଯ ଗ ଣ ତ ଲିକ  ପ ଇ ଁ- ବୁକ୍ଲକ୍ଟର୍୍ ତ ଲିକ  ସକ୍ବଡ ତ୍ତମ ପସନ୍ଦ | ଏବଂ କ୍ଯକ୍ତକ୍ବକ୍େ ରମଟ ିଗରୁୁତ୍ୱପରୂ୍ଣ୍ଡ - 

ଉଦ ହରଣ ସ୍ୱରୂପ, ଏକ ପଦ୍ଧତିର ପଦକ୍କ୍ଷପ ପ ଇ ଁ- ଆପଣ କ୍ବ ଧହୁଏ ଏକ ନମ୍ବରଯକୁ୍ତ ତ ଲିକ  ସେିୃ କରିବ କୁ ଚ ହିକଁ୍ବ |

Character formatting and case considerations 

ଏକ ର୍କୁୟକ୍ମଣ୍ଟକ୍ର ଆପଣ ଚରିତ୍ର ଫମଡ ଟିଂ ବୟବହ ର କରୁଥ୍ବି  ଉପ ୟ ଆପଣଙ୍କ ପ ଠକମ ନଙ୍କ 

ଉପକ୍ର ଏହ ର ଭିଜୁଆଲ୍ ପ୍ରଭ ବକୁ ପ୍ରଭ ବିତ କରିପ ରିବ | ନୟ ୟପରୂ୍ଣ୍ଡ ଭ ବକ୍ର ବୟବହୃତ, ଚରିତ୍ର 

ଫମଡ ଟିଂ ଏକ ସ ଧ  ର୍କୁୟକ୍ମଣ୍ଟକୁ ଆକଷଡଣୀୟ ଏବଂ ବୃତି୍ତଗତ କ୍ଦଖ୍ ଇପ କ୍ର, କିନ୍ତୁ ଅତୟଧକି 

ବୟବହ ର ଏହ କୁ ଆକ୍ମ ଦଦ ୟକ କ୍ଦଖ୍ ଯ ଏ ଏବଂ ସକ୍ନ୍ଦେରୁ ବିେିନ୍ନ କରିପ କ୍ର | ଉଦ ହରଣ 

ସ୍ୱରୂପ, ସମ ନ ର୍କୁୟକ୍ମଣ୍ଟକ୍ର ଅତୟଧକି ଫଣ୍ଟ ବୟବହ ର କରିବ  କ୍ହଉଛି ଅଭିଜ୍ଞତ ର ଚିହ୍ନ, କ୍ତଣ ୁ

ଦୁଇ କିମ୍ବ  ତିକ୍ନ ଟିରୁ ଅଧକି ବୟବହ ର କରନ୍ତୁ ନ ହି ଁ| 

ମକ୍ନରଖ୍ନ୍ତୁ କ୍ଯ କ୍ଲ ୟର କ୍କସ ୍ଅକ୍ଷରଗଡୁିକ ହ୍ର ସ କ୍ହବ କୁ ଲ କ୍ଗ, କ୍ତଣ ୁସମସ୍ତ ଅକ୍ଷର 

(କୟ ପିଟ ଲ୍) ଅକ୍ଷର ବୟବହ ର େକି୍ର ନ ମ  ଏବଂ କ୍ହର୍ିଙ୍୍ଗ କିମ୍ବ  କିଛି ପ୍ରକ ରର ଗରୁୁତ୍ୱ ପ ଇ ଁ

ଉପକ୍ଯ ଗୀ କ୍ହ ଇପ କ୍ର | ତଥ୍ ପି, ବଡ ଅକ୍ଷରଗଡୁିକର ବଡ ବ୍କିଗଡୁିକ ଆଖ୍କୁି କି୍ ନ୍ତ କକ୍ର | 

ଟିପ୍ପଣୀ ଅକ୍ଷର ଏବଂ କ୍ଲ ୟର କ୍କସ ୍େବ୍ଦ କ୍କଉଠୁଁ ଆକ୍ସ? କମ୍ପୟୁଟରର ଆଗମନ ପଯଡୟନ୍ତ, ଲିର୍କ୍ର 

ନିମିତ ବୟକି୍ତଗତ ଅକ୍ଷରଗଡୁିକ ଏକତ୍ରିତ କ୍ହ ଇ େବ୍ଦଗଡୁିକୁ ଏକ ମଦୁ୍ରିତ ପଷୃ୍ଠ କ୍ର କ୍ଦଖ୍ ଯିବ | 

ଅକ୍ଷରଗରୁ୍ିକ ବର୍ଣ୍ଡ ନୁରମିକ ଭ ବକ୍ର ଗେିତ କ୍ହ ଇଥ୍ଲି , ଉପର ଅକ୍ଷରକ୍ର ବଡ ଅକ୍ଷର ଏବଂ କ୍ଛ ଟ 

ଅକ୍ଷରକ୍ର କ୍ଛ ଟ ଅକ୍ଷର |. 
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TIP If you want to start a paragraph with an asterisk or number but don’t want to format 

the paragraph as a bulleted or numbered list, click the AutoCorrect Options button that 

appears after Word changes the formatting, and then in the list, click the appropriate Undo 

option. You can also click the Undo button on the Quick Access Toolbar or press Ctrl+Z. 

 

 

ଆପଣ ଏକ ତ ଲିକ  ଭ ବକ୍ର ଏକ ବିଦୟମ ନ ପ ର ଗ୍ର ଫ୍ କ୍ସଟ୍ ଫମଡ ଟ୍ କରିପ ରିକ୍ବ କିମ୍ବ  ର୍କୁୟକ୍ମଣ୍ଟକ୍ର ସଚୂନ  ପ୍ରକ୍ବେ 

କଲ କ୍ବକ୍େ ତ ଲିକ  ସେିୃ କରିପ ରିକ୍ବ | ଆପଣ ଏକ ତ ଲିକ  ସେିୃ କରିବ  ପକ୍ର, ଆପଣ ତ ଲିକ କୁ ନିମ୍ ନଲିଖ୍ତି ଭ ବକ୍ର 

ରୂପ ନ୍ତର, ଫମଡ ଟ୍ ଏବଂ କେମ ଇଜ୍ କରିପ ରିକ୍ବ: 

■ ଆପଣ ଏକ ତ ଲିକ କ୍ର ଆଇଟମଗରୁ୍ିକ ଘଞୁ୍ଚ ଇ ପ ରିକ୍ବ, ନୂତନ ଆଇଟମ ୍ସନ୍ନିକ୍ବେ କରିପ ରିକ୍ବ, କିମ୍ବ  ଅବ ଞ୍ଛିତ ଆଇଟମ ୍

ବିକ୍ଲ ପ କରିପ ରିକ୍ବ | ଯଦି ତ ଲିକ  ନମ୍ବର କ୍ହ ଇଛି, ୱ ର୍ଡ ସ୍ୱୟଂଚ େିତ ଭ ବକ୍ର ସଂଖ୍ୟ ଗଡୁିକୁ ଅପକ୍ର୍ଟ୍ କକ୍ର | 

■ ଆପଣ ତ ଲିକ ର ଇକ୍େକ୍ଣ୍ଟସନ୍ ସଂକ୍େ ଧନ କରିପ ରିକ୍ବ | ଆପଣ ତ ଲିକ ର ସ ମଗ୍ରିକ ଇକ୍େକ୍ଣ୍ଟସନ୍ ଏବଂ ପ୍ରଥ୍ମ ଲ ଇନର 

ସମ୍ପକଡକୁ ଅନୟ କ୍ରଖ୍  ସହିତ ପରିବତ୍ତଡନ କରିପ ରିକ୍ବ | 

A ଏକ ବୁକ୍ଲକ୍ଟର୍୍ ତ ଲିକ  ପ ଇ,ଁ ଆପଣ ତ ଲିକ  ଆଇଟମଗରୁ୍ିକୁ ଆକ୍ର ହଣ କିମ୍ବ  ଅବତରଣ ରମକ୍ର ସଜ ଇ ପ ରିକ୍ବ, 

ବୁକ୍ଲଟ୍ ସକ୍ଙ୍କତ ପରିବତ୍ତଡନ କରିପ ରିକ୍ବ, କିମ୍ବ  କେମ ୍ବୁକ୍ଲଟ୍ (ଏପରିକି ଚିତ୍ର ବୁକ୍ଲଟ୍) କ ୁବୟ ଖ୍ୟ  କରିପ ରିକ୍ବ | 

A ଏକ ନମ୍ବରଯକୁ୍ତ ତ ଲିକ  ପ ଇ,ଁ ଆପଣ ସଂଖ୍ୟ  େ style େୀକୁ ପରିବତ୍ତଡନ କରିପ ରିକ୍ବ କିମ୍ବ  ଏକ କେମ ୍େ style େୀକୁ 

ବୟ ଖ୍ୟ  କରିପ ରିକ୍ବ, ଏବଂ ଆପଣ ଏକ ତ ଲିକ  ପ ଇ ଁପ୍ର ରମ୍ଭ ସଂଖ୍ୟ  ନିଦିେ କରିପ ରିକ୍ବ | 

To format a new bulleted or numbered list as you enter content 

● 1. ର୍କୁୟକ୍ମଣ୍ଟ୍ ସି୍ଥତିକ୍ର ଥ୍ବି  କସଡର୍ ସହିତ କ୍ଯଉଠଁ କ୍ର ଆପଣ ତ ଲିକ  ଆରମ୍ଭ କରିବ କୁ ଚ ହ ଁୁଛନି୍ତ, 

ନିମ୍ନଲିଖ୍ତି ମଧ୍ୟରୁ କ୍ଗ ଟିଏ କରନ୍ତୁ: 

● A ଏକ ନୂତନ ବୁକ୍ଲକ୍ଟର୍୍ ତ ଲିକ  ଆରମ୍ଭ କରିବ କୁ, ଏକ ପ ର ଗ୍ର ଫ୍ ଆରମ୍ଭକ୍ର * (ଏକ 

ଆକ୍େରିସ୍କ) ପ୍ରକ୍ବେ କରନ୍ତୁ, ଏବଂ ତ ଲିକ  ଆଇଟମ ୍ପ ଠୟ ପ୍ରକ୍ବେ କରିବ  ପବୂଡରୁ କ୍ସ୍ପସ ୍ବ ର୍ 

କିମ୍ବ  ଟୟ ବ୍ କୀ ଦବ ନ୍ତୁ | 

● A ଏକ ନୂତନ ନମ୍ବରଯକୁ୍ତ ତ ଲିକ  ଆରମ୍ଭ କରିବ କୁ, ଏକ ଅନୁକ୍େଦ ଆରମ୍ଭକ୍ର 1 (ଏକ ସଂଖ୍ୟ  

ପକ୍ର ଅନୁସରଣ କରନ୍ତୁ) ପ୍ରକ୍ବେ କରନ୍ତୁ, ଏବଂ ତ ଲିକ  ଆଇଟମ ୍ପ ଠୟ ପ୍ରକ୍ବେ କରିବ  ପବୂଡରୁ 

କ୍ସ୍ପସ ୍ବ ର୍ କିମ୍ବ  ଟୟ ବ୍ କୀ ଦବ ନ୍ତୁ |. 

କ୍ଯକ୍ତକ୍ବକ୍େ ଆପଣ ଏହି ଫୟ େନକ୍ର ଏକ ତ ଲିକ  ଆରମ୍ଭ କରନି୍ତ, ୱ ର୍ଡ ସ୍ୱୟଂଚ େିତ ଭ ବକ୍ର ଏହ କୁ ବୁକ୍ଲକ୍ଟର୍୍ କିମ୍ବ  

ନମ୍ବରଯକୁ୍ତ ତ ଲିକ  ଭ ବକ୍ର ଫମଡ ଟ୍ କକ୍ର | କ୍ଯକ୍ତକ୍ବକ୍େ ଆପଣ ଏକ ନୂତନ ଆଇଟମ ୍ଆରମ୍ଭ କରିବ କ ୁଏଣ୍ଟର୍ ଦବ ନି୍ତ, ୱ ର୍ଡ 

ନୂତନ ଅନୁକ୍େଦକୁ ଫମଡ ଟିଂ ଜ ରି ରକ୍ଖ୍ | ଆଇଟମ ୍ଟ ଇପ ୍କରିବ  ଏବଂ ଏଣ୍ଟର୍ ଦବ ଇବ  ଦ୍ sub ା ର  ସକ୍ବ୍ ସଣ୍ଟ୍ ବୁକ୍ଲକ୍ଟର୍୍ କିମ୍ବ  

ନମ୍ବରଯକୁ୍ତ ଆଇଟମ ୍କ୍ଯ ଗ ହୁଏ | ତ ଲିକ  କ୍େଷ କରିବ କୁ, ଦୁଇଥ୍ର ଏଣ୍ଟର୍ ଦ ବନ୍ତୁ; କିମ୍ବ  କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର ପ ର ଗ୍ର ଫ୍ 

ଗରୁ୍ପ ୍କ୍ର ବୁକ୍ଲଟ୍ ସ ତୀର କିମ୍ବ  ନମ୍ବରିଂ ତୀର କ୍ିକି୍ କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର ଗୟ କ୍ଲରୀକ୍ର, କ୍ିକି୍ କରନ୍ତୁ ନ ହି ଁ| 
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TIP For a multilevel list, you can change the numbering pattern or bullets by clicking 

the Multilevel List button in the Paragraph group on the Home tab and then clicking the 

pattern you want, or you can define a custom pattern by clicking Define New Multilevel List. 

 

 

To convert paragraphs to bulleted or numbered list items 

1. ପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ ଯ ହ କୁ ଆପଣ ଆଇଟମ ୍ଆଇଟମଗରୁ୍ିକକ୍ର ରୂପ ନ୍ତର କରିବ କୁ ଚ ହ ଁୁଛନି୍ତ | 

2. କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର, ପ ର ଗ୍ର ଫ୍ ଗରୁ୍ପ ୍କ୍ର, ନିମ୍ନଲିଖ୍ତି ମଧ୍ୟରୁ କ do ଣସିଟି କରନ୍ତୁ: 

ଚୟନକୁ ବୁକ୍ଲକ୍ଟର୍୍ ତ ଲିକ କ୍ର ପରିଣତ କରିବ କୁ ବୁକ୍ଲଟ୍ ସ ବଟନ୍ କିି୍କ୍ କରନ୍ତୁ |  

3.ଚୟନକୁ ଏକ ନମ୍ବରଯକୁ୍ତ ତ ଲିକ କ୍ର ରୂପ ନ୍ତର କରିବ କୁ ସଂଖ୍ୟ କରଣ ବଟନ୍ କିି୍କ୍ କରନ୍ତୁ | 

To create a list that has multiple levels 

1. ବୁକ୍ଲକ୍ଟର୍୍ କିମ୍ବ  ନମ୍ବରଯକୁ୍ତ ତ ଲିକ  ତିଆରି କରିବ  ଆରମ୍ଭ କରନ୍ତୁ | 

2. କ୍ଯକ୍ତକ୍ବକ୍େ ଆପଣ ପରବତ୍ତଡୀ ତ ଲିକ  ଆଇଟମ ୍ଏକ ଭିନ୍ନ ସ୍ତରକ୍ର ରହିବ କୁ ଚ ହ ଁ ନି୍ତ, ନିମ୍ ନଲିଖ୍ତି ମଧ୍ୟରୁ କ୍ଗ ଟିଏ କରନ୍ତୁ: 

Next ପରବତ୍ତଡୀ ଆଇଟମ ୍ଏକ ସ୍ତର ନିମ୍ ନ (ଅଧକି ଇକ୍େଣ୍ଟ୍) ସେିୃ କରିବ କୁ, ଆପଣ ନିମ୍ ନ ସ୍ତରର ତ ଲିକ  ଆଇଟମ ୍ପ ଠୟ ପ୍ରକ୍ବେ କରିବ  ପବୂଡରୁ 

କ୍ସହ ିଅନୁକ୍େଦର ପ୍ର ରମ୍ଭକ୍ର ଟୟ ବ୍ କୀ ଦବ ନ୍ତୁ | 

Next ପରବତ୍ତଡୀ ଆଇଟମ ୍କ ୁଏକ ସ୍ତର ଉଚ୍ଚ (କମ ୍ଇକ୍େଣ୍ଟ୍) ସେିୃ କରିବ କୁ, ଉଚ୍ଚ ସ୍ତରୀୟ ତ ଲିକ  ଆଇଟମ ୍ପ ଠୟ ପ୍ରକ୍ବେ କରିବ  ପବୂଡରୁ, 

ଅନୁକ୍େଦ ଆରମ୍ଭକ୍ର Shift + ଟୟ ବ୍ ଦବ ନ୍ତୁ | 

ବୁକ୍ଲକ୍ଟର୍୍ ତ ଲିକ  କ୍କ୍ଷତ୍ରକ୍ର, ୱ ର୍ଡ ପ୍ରକ୍ତୟକ ଆଇଟମ ୍ସ୍ତର ପ ଇ ଁବୁକ୍ଲଟ୍ ବର୍ଣ୍ଡ ପରିବତ୍ତଡନ କକ୍ର | ଏକ ନମ୍ବରଯକୁ୍ତ ତ ଲିକ  କ୍କ୍ଷତ୍ରକ୍ର, ୱ ର୍ଡ 

ପବୂଡ ନିଦ୍ଧଡ ରିତ ସଂଖ୍ୟ କରଣ କ୍ଯ ଜନ  ଉପକ୍ର ଆଧ ର କରି ବୟବହୃତ ସଂଖ୍ୟ କରଣର ପ୍ରକ ର ପରିବତ୍ତଡନ କରିଥ୍ ଏ | 
 

To modify the indentation of a list 

1. Select the list items whose indentation you want to change, and do any of the 

following: 

1.Home କ୍ହ ମ ୍ଟୟ ବ୍ ଉପକ୍ର, ପ ର ଗ୍ର ଫ୍ ଗରୁ୍ପ ୍କ୍ର, ତ ଲିକ  ବସୁ୍ତଗଡିୁକୁ ର୍ ହ ଣକୁ ଘଞୁ୍ଚ ଇବ  ପ ଇ ଁଇକ୍େଣ୍ଟ ବ 

Incre ା ନ୍ତୁ ବଟନ୍ କିି୍କ୍ କରନ୍ତୁ |( On the Home tab, in the Paragraph group, click the Increase 

Indent button to move the list items to the right.) 

2.ପ ର ଗ୍ର ଫ୍ କ୍ଗ ଷ୍ଠୀକ୍ର, ତ ଲିକ  ଆଇଟମଗଡିୁକୁ ବ ମକୁ ଘଞୁ୍ଚ ଇବ  ପ ଇ ଁଇକ୍େଣ୍ଟ ହ୍ର ସ ବଟନ୍ କିି୍କ୍ କରନ୍ତୁ |( In the 

Paragraph group, click the Decrease Indent button to move the list items to the left.) 

3.ଭୂସମ ନ୍ତର େ ସକ ପ୍ରଦେଡନ କରନ୍ତୁ, ଏବଂ ଇକ୍େଣ୍ଟ ମ କଡରଗଡିୁକୁ ବ ମ କିମ୍ବ  ର୍ ହ ଣକୁ ଟ ଣନ୍ତୁ |( Display the 

horizontal ruler, and drag the indent markers to the left or right.)
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SEE ALSO For information about paragraph indentation, see “Apply paragraph 

formatting” earlier in this chapter. 

 
 
 

 
 

 

To sort bulleted list items into ascending or descending order 

1. Select the bulleted list items whose sort order you want to change. 

2. On the Home tab, in the Paragraph group, click the Sort button to open the 

Sort Text dialog box. 

3. In the Sort by area, click Ascending or Descending. Then click OK. 

To change the bullet symbol 

1. Select the bulleted list whose bullet symbol you want to change. 

2. On the Home tab, in the Paragraph group, click the Bullets arrow. 

3. In the Bullets gallery, click the new symbol you want to use to replace the bullet 

character that begins each item in the selected list. 

To define a custom bullet 

1. In the Bullets gallery, click Define New Bullet. 

2. In the Define New Bullet dialog box, click the Symbol, Picture, or Font button, 

and make a selection from the wide range of options. 

3. Click OK to apply the new bullet style to the list. 

To change the number style 

1. Select the numbered list whose number style you want to change. 

2. On the Home tab, in the Paragraph group, click the Numbering arrow to display 

the Numbering gallery. 

3. Make a new selection to change the style of the number that begins each item 

in the selected list. 

TIP You can adjust the space between the bullets and their text by dragging 

only the Hanging Indent marker. 
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To define a custom number style 

1. In the Numbering gallery, click Define New Number Format. 

2. In the Define New Number Format dialog box, do any of the following: 
● Change the selections in the Number Style, Number Format, or Alignment 

boxes. 3  
● Click the Font button, and make a selection from the wide range of options. 

3. Click OK to apply the new numbering style to the list. 

To start a list or part of a list at a predefined number 

1. Place the cursor within an existing list, in the list paragraph whose number you 

want to set. 

2. Display the Numbering gallery, and then click Set Numbering Value to open 

the Set Numbering Value dialog box. 

3. Do either of the following to permit custom numbering: 

● Click Start new list. 

● Click Continue from previous list, and then select the Advance value (skip 

numbers) check box. 

4. In the Set value to box, enter the number you want to assign to the list item. 

Then click OK. 
 

You can start or restart a numbered list at any number 
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Format text as you type 
ଆପଣ ଯ ହ  ଟ ଇପ ୍କରନି୍ତ ତ ହ  ଉପକ୍ର ଆଧ ର କରି ଆପଣ କିପରି ଏକ 

ଉପ ଦ ନକୁ ଫମଡ ଟ୍ କରିବ କୁ ଚ ହ ଁୁଛନି୍ତ ତ ହ  ବୁ to ାବି  ପ ଇ ଁଆପ ୍ର ସ ମଥ୍ଡୟର 

କ୍କବେ କ୍ଗ ଟିଏ ଉଦ ହରଣ | ଅକ୍ଟ -ସଠିକ୍ ର୍ ୟଲଗ ୍ବେକୁ ଅନୁସନ୍ଧ ନ କରି 

ଆପଣ ଏହ ିଏବଂ ଅନୟ ନୟ ଅକ୍ଟ  ଫମଡ ଟିଂ ବିକଳ୍ପଗଡୁିକ ବିଷୟକ୍ର ଅଧକି 

ଜ ଣପି ରିକ୍ବ, ଯ ହ କୁ ଆପଣ ୱ ର୍ଡ ଅପ୍ସନ୍ ର୍ ୟଲଗ ୍ବେର ପରୁ୍ଫିଂ କ୍ପଜରୁ 

କ୍ଖ୍ ଲିପ ରିକ୍ବ | 

ଅକ୍ଟ  ଫମଡ ଟ୍ କ୍ଯକ୍ହତୁ ତୁକ୍ମ ଟ ଇପ ୍କର, ବୁକ୍ଲଟ୍ ଏବଂ ନମ୍ବରଯକୁ୍ତ ତ ଲିକ  

ଅନ୍ତଭଡୂ କ୍ତ କରି ର୍ିଫଲ୍ଟ ଭ ବକ୍ର ୱ ର୍ଡ ପ୍ରକ୍ୟ ଗ ବିକଳ୍ପଗଡୁିକୁ ଦେଡ ଏ | 

 
 
 
 
 
 
 
 
 
 
 
 

 
You can select and clear options to control automatic formatting behavior 

 

ଏହି ର୍ ୟଲଗ ୍ବେକ୍ର କ୍ଗ ଟିଏ ମଜ ଦ ର ବିକଳ୍ପ କ୍ହଉଛି ବର୍ଡର ଲ ଇନ୍ସ | କ୍ଯକ୍ତକ୍ବକ୍େ ଏହି 

କ୍ଚକ୍ ବେ ସିକ୍ଲକ୍ଟ ହୁଏ, ରମ ଗତ ତିକ୍ନ ଟି ହ ଇକ୍ଫନ୍ (-) କିମ୍ବ  ରମ ଗତ ତିନିଟି ଅେର କ୍ସ୍କ ର 

(_) ଟ ଇପ ୍କରି ଏଣ୍ଟର୍ ଦବ ଇବ  ଦ୍ୱ ର  ପଷୃ୍ ଠ କ୍ର କ୍ଗ ଟିଏ ଧ ଡି ଆଙି୍କଥ୍ ଏ | ରମ ଗତ ତିକ୍ନ ଟି 

ସମ ନ ଚିହ୍ନ ଟ ଇପ ୍କରିବ  (=) ଏକ ର୍ବଲ୍ ଲ ଇନ୍ ଆଙି୍କଥ୍ ଏ ଏବଂ ରମ ଗତ ତିକ୍ନ ଟି ଟିଲ୍ଡସ ୍

(~) ଟ ଇପ ୍କରିବ  ଏକ ଜିଜ ଗ ୍କ୍ରଖ୍  ଆଙି୍କଥ୍ ଏ | 
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SEE ALSO For information about tables of contents, see “Create and modify tables of 

contents” in Chapter 13, “Reference content and content sources,” of Microsoft Word 2016 

Step by Step by Joan Lambert (Microsoft Press, 2015). 

 
 

Apply built-in styles to text 
ତୁମର ର୍କୁୟକ୍ମଣ୍ଟକୁ କ୍ସହି ଉପ ୟକ୍ର ଫମଡ ଟ୍ କରିବ କୁ ସକ୍ଷମ କ୍ହବ  ପ ଇ ଁଚରିତ୍ର ଏବଂ ପ ର ଗ୍ର ଫ୍ ଫମଡ ଟିଂ ବିଷୟକ୍ର ତୁମକୁ ଅଧକି 

ଜ ଣବି କୁ ପର୍ିବ ନ ହି ଁଯ ହ  କ୍ସମ ନଙୁ୍କ ପ read ାବି  ସହଜ ଏବଂ ଅଧକି ବୃତି୍ତଗତ କ୍ଦଖ୍ ଯିବ | ଦୁଇଟି ମ ଉସ ୍କିି୍କ୍ ସହିତ, ଆପଣ ସହଜକ୍ର 

େବ୍ଦ, ବ କୟ ଂେର ରୂପ ପରିବତ୍ତଡନ କରିପ ରିକ୍ବ, 

ଏବଂ େ yles େୀ ବୟବହ ର କରି ପ ର ଗ୍ର ଫ୍ | ଅଧକି ଗରୁୁତ୍ୱପରୂ୍ଣ୍ଡ କ୍ହଉଛି, ଆପଣ ଏକ ର୍କୁୟକ୍ମଣ୍ଟ୍ ବ ହୟକ୍ରଖ୍  3 ନିମଡ ଣ କରିପ ରିକ୍ବ | 

ଯ ହ  ନ ଭିକ୍ଗସନ୍ କ୍ପନ୍ କ୍ର ପ୍ରତିଫେିତ କ୍ହ ଇଛି ଏବଂ ବିଷୟବସୁ୍ତର ଏକ ସ ରଣୀ ସେିୃ କରିବ କ୍ର ବୟବହୃତ କ୍ହ ଇପ ରିବ | 

 

Apply styles 
େ yles େୀକ୍ର ଅକ୍ଷର ଫମଡ ଟିଂ (କ୍ଯପରିକି ଫଣ୍ଟ, ଆକ ର, ଏବଂ ରଙ୍ଗ), ପ ର ଗ୍ର ଫ୍ ଫମଡ ଟିଂ (କ୍ଯପରିକି କ୍ରଖ୍  

ବୟବଧ ନ ଏବଂ ବ ହୟକ୍ରଖ୍  ସ୍ତର) କିମ୍ବ  ଉଭୟର ମିଶ୍ରଣ ଅନ୍ତଭଡୁ କ୍ତ କ୍ହ ଇପ କ୍ର | େ st େୀ କ୍ଟମ୍ପକ୍ଲଟକ୍ର ଗେିତ 

କ୍ହ ଇଛି ଯ ହ  ଏକ ର୍କୁୟକ୍ମଣ୍ଟ ସହିତ ସଂଲଗ୍ନ କ୍ହ ଇଛି | ରି୍ଫଲ୍ଟ ଭ ବକ୍ର, ଖ୍ ଲି ନୂତନ ର୍କୁୟକ୍ମଣ୍ଟଗରିୁ୍କ ସ ଧ ରଣ 

କ୍ଟମ୍ପକ୍ଲଟ୍ ଉପକ୍ର ଆଧ ରିତ | ସ ଧ ରଣ କ୍ଟମ୍ପକ୍ଲଟ୍ େ st େୀଗରିୁ୍କର ଏକ ମ ନକ ଚୟନ ଅନ୍ତଭଡୂ କ୍ତ କକ୍ର ଯ ହ  

ଅଧକି ଂେ ର୍କୁୟକ୍ମଣ୍ଟର ମ basic େିକ ଆବେୟକତ  ସହିତ ଖ୍ ପ ଖ୍ ଏ | ଏହି େ yles େୀକ୍ର ନଅଟି କ୍ହରି୍ଙ୍୍ଗ ସ୍ତର, 

ବିଭିନ୍ନ ପ ଠୟ େ yles େୀ ଅନ୍ତଭଡୂ କ୍ତ କ୍ହ ଇଛି ଯ ହ  ଏକ ଧକି ସ୍ତରର ବୁକ୍ଲକ୍ଟର୍୍ ଏବଂ ନମ୍ବରଯକୁ୍ତ ତ ଲିକ , ସଚୂକ ଙ୍କ 

ଏବଂ ବିଷୟବସୁ୍ତ ବିଷୟବସୁ୍ତ ପ୍ରକ୍ବେ େ yles େୀ ଏବଂ ଅକ୍ନକ ବିକ୍େଷ େ styles େୀ କ୍ଯପରିକି ହ ଇପର୍ ଲିଙ୍୍କ, 

କ୍କ କ୍ଟସନ୍, କ୍ଲସିକ୍ହ ଲ୍ଡର୍, କୟ ପ୍ସନ୍ ଏବଂ ଅନୟ ନୟ ଉପ ଦ ନଗରିୁ୍କ ପ ଇ ଁ| 

ରି୍ଫଲ୍ଟ ଭ ବକ୍ର, କ୍ହ ମ ୍ଟୟ ବକ୍ର ଥ୍ବି  େ ଇଲ୍ ଗୟ କ୍ଲରୀକ୍ର ଅଧକି ଂେ ସ ଧ ରଣ ପବୂଡ ନିଦ୍ଧଡ ରିତ େ yles େୀ 

ଉପଲବ୍ଧ | ଆପଣ ଗୟ କ୍ଲରୀକ୍ର େ yles େୀ କ୍ଯ ର୍ପି ରିକ୍ବ କିମ୍ବ  କ୍ସହିଗରୁ୍ିକ ଅପସ ରଣ କରିପ ରିକ୍ବ ଯ ହ କୁ ଆପଣ 

ପ୍ର ୟତ use ବୟବହ ର କରନି୍ତ ନ ହି ଁ| 
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The Styles gallery in a new, blank document based on the Normal template 
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SEE ALSO For information about document theme elements, see “Change the document 

theme,” later in this chapter. 

TIP ଏକ ବିଦୟମ ନ ର୍କୁୟକ୍ମଣ୍ଟର ରୂପ ବଦେ ଇବ  ପ ଇ  ଁେ ଇଲ୍ କ୍ସଟ୍ ଏକ େୀଘ୍ର ଏବଂ ସହଜ ଉପ ୟ 

ପ୍ରଦ ନ କକ୍ର | 

ର୍କୁୟକ୍ମଣ୍ଟ୍ ଉପକ୍ର ଆଧ ରିତ କ୍ଟମ୍ପକ୍ଲଟ୍ ପରିବତ୍ତଡନ କରି ଆପଣ େ ଇଲ୍ ସଂଜ୍ଞ  ମଧ୍ୟ ପରିବତ୍ତଡନ 

କରିପ ରିକ୍ବ | େ yles େୀ ଏବଂ କ୍ଟମ୍ପକ୍ଲଟଗରୁ୍ିକ ବିଷୟକ୍ର ଅଧକି ସଚୂନ  ପ ଇ ,ଁ ମ ଇକ୍ର ସଫ୍ଟ  ୱ ର୍ଡ 2016 

ର କ୍ଜ ନ୍ ଲ ମବଟଡ (ମ ଇକ୍ର ସଫ୍ଟ  କ୍ପ୍ରସ ,୍ 2015) ର ଅଧ୍ୟ ୟ 15, “ୱ ର୍ଡକ୍ର ଅଧକି ଦକ୍ଷତ ର ସହିତ କ ଯଡୟ 

କରନ୍ତୁ” ଅଧ୍ୟୋୟ 15 ଜର “କଷ୍ଟମ  ୍ଷ୍ଟୋଇଲ୍ ଏବଂ ଜର୍ମ୍ପଜଲର୍୍ ସଷିୃ୍ଟ” ଜଦଖନ୍ତୁ | 

 

 

 

ଏକ କ୍ଟମ୍ପକ୍ଲଟକ୍ର ଗେିତ େ yles େୀ ସ ଧ ରଣତ Normal ସ ଧ ରଣ େ style େୀ ଉପକ୍ର ଆଧ ରିତ ଏବଂ 

ର୍କୁୟକ୍ମଣ୍ଟର ଥ୍ମି ୍ସହିତ ଜର୍ିତ କ୍କବେ ରି୍ଫଲ୍ଟ ବର୍ ିଏବଂ କ୍ହରି୍ଙ୍୍ଗ ଫଣ୍ଟ ବୟବହ ର କକ୍ର, କ୍ତଣ ୁକ୍ସମ କ୍ନ ସମକ୍ସ୍ତ 

ଏକତ୍ର ଯ ଆନି୍ତ | ଏହି କ ରଣରୁ, େ yles େୀ ବୟବହ ର କରି ର୍କୁୟକ୍ମଣ୍ଟ ବିଷୟବସୁ୍ତକୁ ଫମଡ ଟିଂ କରିବ  ଏକ ସସୁଙ୍ଗତ 

ପ୍ରଭ ବ ସେିୃ କକ୍ର | ଆପଣ ନ ମିତ େ yles େୀଗରିୁ୍କ ପ୍ରକ୍ୟ ଗ କରିବ  ପକ୍ର, ଆପଣ ଏକ ଭିନ୍ନ େ ଇଲ୍ କ୍ସଟ୍ କୁ 

ସଇୁଚ୍ କରି ଏକ ସମ୍ପରୂ୍ଣ୍ଡ ର୍କୁୟକ୍ମଣ୍ଟର ଲୁକ୍କୁ ସହଜକ୍ର ପରିବତ୍ତଡନ କରିପ ରିକ୍ବ ଯ ହ  ସମ ନ ନ ମ ସହିତ େ yles େୀ 

ଧ ରଣ କକ୍ର କିନ୍ତୁ ଭିନ୍ନ ଫମଡ ଟିଂ | 

Style sets are available from the Document Formatting gallery on the Design tab. 

 

Pointing to a style set in the gallery displays a live preview of the effects of applying that style set to the 

entire document 
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TIP If the Styles pane floats above the page, you can drag it by its title bar to the 

right or left edge of the app window to dock it. 

 

 

To open the Styles pane 

1. On the Home tab, click the Styles dialog box launcher. 

 

 

  3  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

The Styles pane can display style names or previews of the styles 

 

 

To change which styles are displayed in the Styles pane 

1. Open the Styles pane, and then click Options. 

(େ ଇଲ୍ କ୍ପନ୍ କ୍ଖ୍ ଲନ୍ତୁ, ଏବଂ ତ ପକ୍ର ବିକଳ୍ପଗରୁ୍ିକ କ୍ିିକ ୍କରନ୍ତୁ |)
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To make it easier to find specific styles, sort the list alphabetically 

 

2. In the Style Pane Options dialog box, do any of the following, and then click OK: 

● In the Select styles to show list, click one of the following(List ତ ଲିକ  କ୍ଦଖ୍ ଇବ କୁ ଚୟନ େ 

styles େୀକ୍ର, ନିମ୍ ନଲିଖ୍ତି ମଧ୍ୟରୁ କ୍ଗ ଟିଏ କିି୍କ୍ କରନ୍ତୁ) 

● ● ସପୁ ରିେ କର ଯ ଇଥ୍ବି  େ yles େୀଗରୁ୍ିକ ପ୍ରଦେଡନ କକ୍ର ଯ ହ  ବୟବହ ର ପ ଇ ଁସପୁ ରିେ 

ଅନୁଯ ୟୀ କ୍ଟମ୍ପକ୍ଲଟକ୍ର ଟୟ ଗ ୍କ୍ହ ଇଛି | 

● Use ବୟବହ ରକ୍ର େ st େୀ ପ୍ରଦେଡନ କକ୍ର ଯ ହ  ସ ମ୍ପ୍ରତିକ ର୍କୁୟକ୍ମଣ୍ଟକ୍ର ବିଷୟବସୁ୍ତ ଉପକ୍ର 

ପ୍ରକ୍ୟ ଗ ହୁଏ | 

● Current ସ ମ୍ପ୍ରତିକ ର୍କୁୟକ୍ମଣ୍ଟକ୍ର କ୍ଟମ୍ପକ୍ଲଟ୍ କ୍ର ଥ୍ବି  େ yles େୀଗରୁ୍ିକ ପ୍ରଦେତି କକ୍ର 

ଯ ହ  ସ ମ୍ପ୍ରତିକ ର୍କୁୟକ୍ମଣ୍ଟ୍ ସହିତ ସଂଲଗ୍ନ କ୍ହ ଇଛି | 

● ● ସମସ୍ତ େ yles େୀ ବିଲ୍ଟ-ଇନ୍ େ yles େୀ, ସଂଲଗ୍ନ କ୍ଟମ୍ପକ୍ଲଟକ୍ର ଥ୍ବି  େ yles େୀ ଏବଂ 

ଅନୟ କ୍ଟମ୍ପକ୍ଲଟରୁ ର୍କୁୟକ୍ମଣ୍ଟକୁ ଅଣ ଯ ଇଥ୍ବି  େ styles େୀ ପ୍ରଦେଡନ କକ୍ର | 

● List ତ ଲିକ  କିପରି ସଟଡ କ୍ହ ଇଛି ଚୟନ କରନ୍ତୁ ଚୟନକ୍ର, ବର୍ଣ୍ଡ ନୁରମିକ କ୍ିିକ୍ କରନ୍ତୁ, 

ସପୁ ରିେ ଅନୁଯ ୟୀ, ଫଣ୍ଟ, ଉପକ୍ର ଆଧ ରିତ, କିମ୍ବ  ପ୍ରକ ର ଅନୁଯ ୟୀ | 

● St େ styles େୀ କ୍କ୍ଷତ୍ର ଭ ବକ୍ର କ୍ଦଖ୍ ଇବ କୁ ସିକ୍ଲକ୍ଟ ଫମଡ ଟିଂକ୍ର, ପ୍ରକ୍ତୟକ କ୍ଚକ୍ ବେ 

ଚୟନ କରନ୍ତୁ ଯ ହ  ପ ଇ ଁଆପଣ ନ ମିତ େ yles େୀରୁ ଭିନ୍ନତ  ପ୍ରଦେଡନ କରିବ କୁ ଚ ହ ଁୁଛନି୍ତ | 

● କିପରି ବିଲ୍ଟ-ଇନ୍ େ ଇଲ୍ ନ ମଗରୁ୍ିକ କ୍କ୍ଷତ୍ର ପ୍ରଦେତି ହୁଏ ଚୟନ କରନ୍ତୁ, କ୍ଚକ୍ ବେ ଚୟନ 
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କରନ୍ତୁ | 
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TIP If the style you want to apply is a paragraph style, you can position the 

cursor anywhere in the paragraph. If the style you want to apply is a character 

style, you must select the text. 

 

 

To display or hide style previews in the Styles pane 

1. Open the Styles pane, and then select or clear the Show Preview check box. 

To add a style to the Styles gallery 

1. In the Styles pane, point to the style, click the arrow that appears, and then click 
3 

 
Add to Style Gallery. 

To remove a style from the Styles gallery 

1. Do either of the following: 

● In the Styles pane, point to the style, click the arrow that appears, and then 

click Remove from Style Gallery. 

● In the Styles gallery, right-click the style, and then click Remove from Style 

Gallery. 

To apply a built-in style 

1. Select the text or paragraph to which you want to apply the style. 
 

2. In the Styles gallery on the Home tab, or in the Styles pane, click the style you 

want to apply. 

To change the style set 

1. On the Design tab, in the Document Formatting group, click the More button 

if necessary to display all the style sets. 

2. Point to any style set to preview its effect on the document. 

3. Click the style set you want to apply. 

 
Manage outline levels 

Styles can be used for multiple purposes: to affect the appearance of the content, to 

build a document outline, and to tag content as a certain type so that you can easily 

locate it. 
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Heading styles define a document’s outline 

 

Each paragraph style has an associated Outline Level setting. Outline levels include 

Body Text and Level 1 through Level 9. (Most documents make use only of body text 

and the first three or four outline levels.) 

 

Most documents use only two to four of the outline levels 
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TIP Only headings that are styled with the document heading styles appear in 

the Navigation pane. 

TIP If there is no triangle next to a heading, that heading does not have 

subheadings. 

 

 

Paragraphs that have the Level 1 through Level 9 outline levels become part of the 

hierarchical structure of the document. They appear as headings in the Navigation 

pane and act as handles for the content that appears below them in the hierarchy. You 

can collapse and expand the content below each heading, and move entire sections 

of content by dragging the headings in the Navigation pane. 

  3  
To display the document outline in the Navigation pane 

1. In the Navigation pane, click Headings to display the document structure. 
 

 

To expand or collapse the outline in the Navigation pane 

1. In the Navigation pane, do either of the following: 

● If there is a white triangle to the left of a heading, click it to expand that 

heading to show its subheadings. 

● If there is a downward-angled black triangle to the left of a heading, click it 

to collapse the subheadings under that heading. 
 

 

To expand or collapse sections in the document 

1. In a document that contains styles, point to a heading to display a triangle to its 

left. Then do either of the following: 

● If the triangle is a downward-angled gray triangle, click the triangle to hide 

the content that follows the heading. 

● If the triangle is a white triangle, click the triangle to display the hidden 

document content. 
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Change the document theme 
Every document you create is based on a template, and the look of the template is 

controlled by a theme. The theme is a combination of coordinated colors, fonts, and 

effects that visually convey a certain tone. To change the look of a document, you can 

apply a different theme from the Themes gallery. 

 

The default installation of Word 2016 offers 30 themes to choose from 

 

Each theme has a built-in font set and color set, and an associated effect style. 

■ Each font set includes two fonts—the first is used for headings and the second 

for body text. In some font sets, the heading and body fonts are the same. 

■ Each color in a color set has a specific role in the formatting of styled elements. 

For example, the first color in each set is applied to the Title and Intense Refer- 

ence styles, and different shades of the third color are applied to the Subtitle, 

Heading 1, and Heading 2 styles. 
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TIP In addition to colors and fonts, you can control the more subtle design elements, 

such as paragraph spacing and visual effects that are associated with a theme. 

 

 

If you like the background elements of a theme but not the colors or fonts, you can 

mix and match theme elements. 

 

 

  3  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Word 2016 offers thousands of different combinations for creating a custom theme that meets your 

exact needs 

 

If you create a combination of theme elements that you would like to be able to use 

with other documents, you can save the combination as a new theme. By saving the 

theme in the default Document Themes folder, you make the theme available in the 

Themes gallery. However, you don’t have to store custom themes in the Document 

Themes folder; you can store them anywhere on your hard disk, on removable media, 

or in a network location. 
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TIP If multiple people create corporate documents for your company, you can ensure 

that everyone’s documents have a common look and feel by assembling a custom 

theme and making it available to everyone. Use theme elements that reflect your corporate 

colors, fonts, and visual style, and then save the theme to a central location or send the theme 

file by email and instruct your colleagues to save it to the default Document Themes folder. 

TIP If you have manually applied formatting to document content, the theme does not 

override the manual formatting. To ensure that all document elements are controlled by 

the theme, click Reset To The Default Style Set on the Document Formatting menu. 

 
 
 

 

By default, Word applies the Office theme to all new, blank documents. In Word 2016, 

the Office theme uses a primarily blue palette, the Calibri font for body text, and 

Calibri Light for headings. If you plan to frequently use a theme other than the Office 

theme, you can make that the default theme. 

 

 

To apply a built-in theme to a document 

1.  On the Design tab, in the Document Formatting group, click the Themes 

button, and then click the theme you want to apply. 
 

 

To change theme elements in a document 

1. On the Design tab, in the Document Formatting group, do any of the following: 

● Click the Colors button (the ScreenTip says Theme Colors), and then click the 

color set you want to apply. 

● Click the Fonts button (the ScreenTip says Theme Fonts), and then click the 

font set you want to apply. 

● Click the Effects button (the ScreenTip says Theme Effects), and then click 

the effect style you want to apply. 

TIP The default Document Themes folder is stored within your user profile. On a 

default freestanding installation, the folder is located at C:\Users\<user name> 

\AppData\Roaming\Microsoft\Templates\Document Themes. In a corporate environment 

with managed computer configurations, the user profile folder might be located elsewhere. 
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To save a custom theme 

1. Apply a base theme, and then modify the theme colors, fonts, and effects as 

you want them. 

2. On the Design tab, in the Document Formatting group, click the Themes 

button. 3  
3. At the bottom of the Themes menu, click Save Current Theme to display the 

contents of the Document Themes folder in the Save Current Theme dialog box. 

4. In the File name box, replace the suggested name, and then click Save. 

To apply a custom theme 

1. Display the Themes menu. If you have created a custom theme, the Themes 

menu now includes a Custom area that contains your theme. 

2. Click the theme to apply it to the document. 

To change the default theme 

1. In the document, apply the theme you want to use as the default theme. 

2. On the Design tab, in the Document Formatting group, click Set as Default. 

To apply a theme from a nonstandard location 

1. On the Design tab, in the Document Formatting group, click the Themes 

button. 

2. At the bottom of the Themes menu, click Browse for Themes. 

3. In the Choose Theme or Themed Document dialog box, browse to the theme 

you want to apply, and then click Open. 

To find the location of your Document Themes folder 

1. On the Design tab, in the Document Formatting group, click the Themes 

button. 

2. At the bottom of the Themes menu, click Save Current Theme. 

3. In the Save Current Theme dialog box, click the icon at the left end of the 

address bar to display the full path to the Document Themes folder. 
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To delete a custom theme 

1. ନିମ୍ନଲିଖ୍ତି ମଧ୍ୟରୁ କ୍ଗ ଟିଏ କରନ୍ତୁ:( Do either of the following:) 

 

1.File ଫ ଇଲ୍ ଏେକ୍ଲ ିରର୍ କ୍ଖ୍ ଲନ୍ତୁ, ର୍କୁୟକ୍ମଣ୍ଟ୍ ଥ୍ମି୍ସ କ୍ଫ ଲ୍ଡରକୁ େ ଉଜ୍ କରନ୍ତୁ ଏବଂ ଥ୍ମି ୍ଫ ଇଲ୍ ର୍ିଲିଟ୍ କରନ୍ତୁ |( Open 

File Explorer, browse to the Document Themes folder, and delete the theme file.) 

2.Word ୱ ର୍ଡକ୍ର, ଥ୍ମି୍ସ କ୍ମନୁ ପ୍ରଦେଡନ କରନ୍ତୁ, କେମ ୍ଥ୍ମି ୍ଉପକ୍ର ର୍ ହ ଣ କ୍ିିକ ୍କରନ୍ତୁ ଏବଂ ତ ପକ୍ର ର୍ଲିିଟ୍ କ୍ିକି୍ କରନ୍ତୁ |( In 

Word, display the Themes menu, right-click the custom theme, and then click Delete.) 

ଧ୍ୟ ନ ଦିଅନ୍ତୁ କ୍ଯ ଦ୍ୱିତୀୟ ପଦ୍ଧତି ଗୟ କ୍ଲରୀରୁ ଥ୍ମି ୍ପସନ୍ଦକୁ ଅପସ ରଣ କକ୍ର କିନ୍ତୁ ଥ୍ମି ୍କ୍ଫ ଲ୍ଡରରୁ ଥ୍ମି ୍ଫ ଇଲ୍ ଅପସ ରଣ କକ୍ର 

ନ ହି ଁ| 

Skills review 
In this chapter, you learned how to: 

■ Apply paragraph formatting 

■ Structure content manually 

■ Apply character formatting 

■ Create and modify lists 

■ Apply built-in styles to text 

■ Change the document theme 
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Practice tasks 
The practice files for these tasks are located in the Office2016SBS\Ch03 

folder. You can save the results of the tasks in the same folder. 

 
Apply paragraph formatting 

Open the FormatParagraphs document, display formatting marks, and then complete 

the following tasks: 

1. ର୍କୁୟକ୍ମଣ୍ଟକ୍ର ଅଧକି ଂେ କିମ୍ବ  ସମସ୍ତ ପ ର ଗ୍ର ଫ୍ ପ୍ରଦେଡନ କରିବ କୁ େ ସକମ ନଙୁ୍କ ପ୍ରଦେଡନ କରନ୍ତୁ 

ଏବଂ ଜୁମ ୍ସ୍ତରକ ୁସଜ ର୍ନ୍ତୁ | 

2. ପ୍ରଥ୍ମ ଦୁଇଟି ପ ର ଗ୍ର ଫ୍ (ସ୍ୱ ଗତ! ଏବଂ ପରବତ୍ତଡୀ ଅନୁକ୍େଦ) ଚୟନ କରନ୍ତୁ ଏବଂ କ୍ସମ ନଙୁ୍କ 

ମ ଜିନ ମଧ୍ୟକ୍ର କ୍କନ୍ଦ୍ର କରନ୍ତୁ | 

3. ଦ୍ୱିତୀୟ ପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ ଏବଂ ପ୍ରଥ୍ମ ଲ ଇନ୍ ଇକ୍େଣ୍ଟ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | 

4. ତୃତୀୟ ଅନୁକ୍େଦ ଚୟନ କରନ୍ତୁ ଏବଂ ତ ପକ୍ର ନିମ୍ନଲିଖ୍ତି ଫମଡ ଟିଂ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ: 

The ପ ର ଗ୍ର ଫ୍ ଫମଡ ଟ୍ କରନ୍ତୁ ଯ ହ  ଦ୍ the ା ର  ପ ର ଗ୍ର ଫର ଧ ରଗଡୁିକ ଉଭୟ ବ ମ ଏବଂ 

ର୍ ହ ଣ ମ ଜିନ ବିରୁଦ୍ଧକ୍ର ଫି୍ େ ୍କ୍ହବ | 

The ବ ମ ଏବଂ ର୍ ହ ଣ ପକ୍ଟ ପ ର ଗ୍ର ଫକ ୁଅଧ  ଇଞ୍ଚ ଦ୍ୱ ର  ଇକ୍େଣ୍ଟ କରନ୍ତୁ | 

5. ସ ବଧ ନ ପ ର ଗ୍ର ଫକ ୁ0.25 ଇଞ୍ଚ ଦ୍ୱ ର  ଇକ୍େଣ୍ଟ କରନ୍ତୁ | 

6. ଏକ ସ ଙ୍ଗକ୍ର ତକିଆ, କମ୍ବେ, ଟ କ୍ୱଲ୍, ଲିକ୍ମ ଜ ଇନ୍ କ୍ୱକ୍ନରୀ ଟୁର୍, ଏବଂ ଇନ୍-କ୍ହ ମ ୍ମସ ଜ ୍

ପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ | ପ ର ଗ୍ର ଫ୍ ପକ୍ର ସ୍ଥ ନ ଅପସ ରଣ କରିବ କୁ ପ ର ଗ୍ର ଫ୍ ବୟବଧ ନ 

ପରିବତ୍ତଡନ କରନ୍ତୁ | 

7. ର୍କୁୟକ୍ମଣ୍ଟର େୀଷଡକ୍ର, ଏକ ବ ହୟ ସୀମ  ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ ଦୟ କରି କିଛି ମିନିଟ୍ ପ ର ଗ୍ର ଫ୍ ନିଅନ୍ତୁ 

| 

8. ର୍କୁୟକ୍ମଣ୍ଟ୍ କ୍ସଭ୍ ଏବଂ ବନ୍ଦ କରନ୍ତୁ |
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Structure content manually 

Open the StructureContent document, display formatting marks, and then complete 

the following tasks: 

● ର୍କୁୟକ୍ମଣ୍ଟକ୍ର ଅଧକି ଂେ କିମ୍ବ  ସମସ୍ତ ପ ର ଗ୍ର ଫ୍ ପ୍ରଦେଡନ କରିବ କୁ େ ସକମ ନଙୁ୍କ ପ୍ରଦେଡନ କରନ୍ତୁ 

ଏବଂ ଜୁମ ୍ସ୍ତରକୁ ସଜ ର୍ନ୍ତୁ | 

● ଦ୍ୱିତୀୟ ଅନୁକ୍େଦକ୍ର (ଆକ୍ମ ଚ ହିବୁଁ ...), କୁଟିଜ୍ େବ୍ଦ ଅନୁସରଣ କରୁଥ୍ବି  କମ  ଏବଂ କ୍ସ୍ପସ ୍ପକ୍ର 

ତୁରନ୍ତ ଏକ କ୍ରଖ୍  କ୍େକ ୍ସନ୍ନିକ୍ବେ କରନ୍ତୁ | 

● ତକିଆ, କମ୍ବେ, ତଉଲିଆ, ଏବଂ ର୍ିସ ୍ଟ କ୍ୱଲ୍ ପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ | 2 ଇଞ୍ଚ ମ କଡକ୍ର ଏକ ବ ମ 

ଟୟ ବ୍ େପ ୍ସନ୍ନିକ୍ବେ କରନ୍ତୁ ଏବଂ କ୍ସହି ଅବସ୍ଥ ନ ପବୂଡରୁ କ୍ଯକ any ଣସି ଟୟ ବ୍ େପ ୍ସଫ  କରନ୍ତୁ | 

● ତକିଆ ପ ର ଗ୍ର ଫକ୍ର, ଟୟ ବ୍ ମ କଡର୍ ସହିତ େବ୍ଦ ପବୂଡରୁ କ୍ସ୍ପସ ୍ସ୍ଥ ନ ନ୍ତର କରନ୍ତୁ | ପରବତ୍ତଡୀ ତିକ୍ନ ଟ ି

ଅନୁକ୍େଦକ୍ର ଟୟ ବ୍ ସନ୍ନକି୍ବେ କରିବ କୁ ପ୍ରରିୟ  ପନୁର ବୃତି୍ତ କରନ୍ତୁ | କ୍କ ଲନ୍ ଅନୁସରଣ କରୁଥ୍ବି  

ପ୍ରକ୍ତୟକ ଅନୁକ୍େଦର ଅଂେ ବତ୍ତଡମ ନ 2-ଇଞ୍ଚ ମ କଡକ୍ର ଆଲ ଇନ୍ କ୍ହ ଇ ଆପଣଙ୍କ ଆବେୟକତ ଠ ରୁ 

ଅଧକି ସ୍ଥ ନ ଉତ୍ପ ଦନ କକ୍ର | 

● ଟୟ ବ୍ ଧ ରଣ କରିଥ୍ବି  ଚ କ୍ର ଟ ିପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର ନିମ୍ନଲିଖ୍ତି କ ଯଡୟ କରନ୍ତୁ: 

2 ବ ମ ଟୟ ବ୍ େପ ୍କୁ 2 ଇଞ୍ଚ ମ କଡରୁ 1.25 ଇଞ୍ଚ ମ କଡକୁ ପରିବତ୍ତଡନ କରନ୍ତୁ | 

 

େ ସକ ଉପକ୍ର, ହୟ ଙି୍ଗଂ ଇକ୍େଣ୍ଟ ମ କଡରକୁ 1.25 ଇଞ୍ଚ ମ କଡକ୍ର ଟୟ ବ େପକୁ ଟ ଣନ୍ତୁ (ବ ମ ଇକ୍େଣ୍ଟ ମ କଡର ଏହ  ସହିତ ଗତି  

କକ୍ର) ପ ର ଗ୍ର ଫର ଦ୍ୱିତୀୟ ଧ ର୍ି ପ୍ରଥ୍ମ ଧ ର୍ି ସହିତ ସମ ନ ସ୍ଥ ନକ୍ର ଆରମ୍ଭ କ୍ହବ | ତ ପକ୍ର ଚୟନ ମକୁ୍ତ କରିବ କୁ କ୍ହ ମ ୍କୀ 

ଦବ ନ୍ତୁ ଯ ହ  ଦ୍ you ା ର  ଆପଣ ଫେ ଫେଗରୁ୍ିକ ସମୀକ୍ଷ  କରିପ ରିକ୍ବ | 

 

1. At the bottom of the document, select the three paragraphs containing dollar 

amounts, and then do the following: 

Inch ଇଞ୍ଚ ମ କଡକ୍ର ଏକ ଦେମିକ ଟୟ ବ୍ େପ ୍କ୍ସଟ୍ କରନ୍ତୁ | 

Decimal ଦେମିକ ପଏଣ୍ଟକ୍ର ମଲୂୟକୁ ସମ ନ କରିବ  ପ ଇ ଁପ୍ରକ୍ତୟକ ର୍ଲ ର ଚିହ୍ନର ବ ମ ପ ର୍ଶ୍ଡକ୍ର ଥ୍ବି  ସ୍ଥ ନକୁ ଏକ 

ଟୟ ବ ସହିତ ବଦେ ନ୍ତୁ | 

 

2. ଆପଣଙ୍କ କ ଯଡୟର ଫେ ଫେକୁ ଭଲ ପ୍ରଦେଡନ କରିବ କୁ ଫମଡ ଟିଂ ମ କଡ ଲୁଚ ନ୍ତୁ | 

3. ର୍କୁୟକ୍ମଣ୍ଟ୍ କ୍ସଭ୍ କରନ୍ତୁ ଏବଂ ବନ୍ଦ କରନ୍ତୁ |
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Apply character formatting 

Open the FormatCharacters document, and then complete the following tasks: 

 

1ଦ୍ୱିତୀୟ ବୁକ୍ଲଟ୍ ପଏଣ୍ଟକ୍ର, ପ୍ର କୃତିକ େବ୍ଦକ ୁଅେରଲ ଇନ୍ କରନ୍ତୁ | ତ ପକ୍ର ଚତୁଥ୍ଡ ବୁକ୍ଲଟ୍ ପଏଣ୍ଟକ୍ର ସମସ୍ତ େବ୍ଦକୁ 

ଅେରଲ ଇନ୍ କରିବ କୁ ଫମଡ ଟିଂ କମ େକୁ ପନୁର ବୃତି୍ତ କର | 

 

2. ଚତୁଥ୍ଡ ବୁକ୍ଲଟ୍ ପଏଣ୍ଟକ୍ର, େବ୍ଦର କ୍ଯକ anywhere ଣସି ସ୍ଥ ନକ୍ର କ୍ିକି୍ କରନ୍ତୁ | େବ୍ଦକ ୁଏକ କ୍ମ ଟ  

ଅେରଲ ଇନ୍ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ ଯ ହ  ମଧ୍ୟ ଅେରଲ ଇନ୍ ବଟନ୍ ସହିତ କ୍ମ ଟ  ଅେରଲ ଇନ୍ ଫମଡ ଟ୍ ନୟସ୍ତ 

କକ୍ର | ତ ’ପକ୍ର କ୍ମ ଟ  ଅେରଲ ଇନ୍ େବ୍ଦ ବିଭ ଗକ୍ର ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | 

3.  

4. କମଡଚ ରୀ ଓରିଏକ୍ଣ୍ଟସନ୍ କ୍ହର୍ଙ୍ି୍ଗ ଚୟନ କରନ୍ତୁ ଏବଂ କ୍ହର୍ଙି୍ଗକ୍ର କ୍ବ ଲ୍ଡ ଫମଡ ଟିଂ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | 

 

4. ଫମଡ ଟିଂ କପି କରନ୍ତୁ, ଏବଂ ତ ପକ୍ର ଏହ କ ୁଗ ଇର୍ଲ ଇନ ସବ୍ଟ ଇଟଲକ୍ର ରଙ୍ଗ କରନ୍ତୁ, ସବ୍ଟ ଇଟ୍ କୁ ଏକ କ୍ହର୍ଙ୍ି୍ଗ କରିବ କୁ | 

1. 5. ନିକ୍ଦଡେ ବେୀ କ୍ହର୍ିଙ୍୍ଗ ଚୟନ କରନ୍ତୁ ଏବଂ ନିମ୍ନଲିଖ୍ତି ଫମଡ ଟିଂ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ: 

 
 
 
 
 
 

Change the font color of the words Employee Orientation to Green, Accent 6. 

Select the Community Service Committee heading, and apply the following formatting: 

● Employee ଆପଣ କମଡଚ ରୀ ଓରିଏକ୍ଣ୍ଟସକ୍େ ପ୍ରକ୍ୟ ଗ କରିଥ୍ବି  ସମ ନ ରଙ୍ଗକ୍ର 

ଅକ୍ଷରଗଡୁିକୁ ବ ହୟକ୍ରଖ୍  କରନ୍ତୁ | 

● A ଏକ ଅଫକ୍ସଟ୍ ର୍ ଇକ୍ଗ ନ ଲ୍ ତେ ବ ମ ବ ହୟ ଛ ୟ  ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | ଛ ୟ  

ରଙ୍ଗକୁ ସବୁଜ, Accent 6, ଗ  ark ା  50% କ୍ର ପରିବତ୍ତଡନ କରନ୍ତୁ | 

● The ଅକ୍ଷରଗଡୁିକୁ ସବୁଜ, Accent 6 ରଙ୍ଗକ୍ର ପରୁଣ କରନ୍ତୁ, ଏବଂ ତ ’ପକ୍ର 

ପ ଠୟ ବ ହୟକ୍ରଖ୍ କୁ ସବୁଜ, Accent 6, Darker 25% କ୍ର ପରିବତ୍ତଡନ କରନ୍ତୁ | 

You have now applied three text effects to the selected text by using three 

shades of the same green. 

● ଫଣ୍ଟକୁ ଇମ୍ପ କ୍ଟକ୍ର ପରିବତ୍ତଡନ କରନ୍ତୁ | 

● ଫଣ୍ଟ ଆକ ରକ ୁ20 ପଏଣ୍ଟକ୍ର କ୍ସଟ୍ କରନ୍ତୁ | 

● କ୍ଛ ଟ କୟ ପ ୍ଫଣ୍ଟ୍ ଇକ୍ଫକ୍ଟ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | 

● 10 ଅକ୍ଷର ବୟବଧ ନକ ୁ10 ପଏଣ୍ଟକ୍ର ବିସ୍ତ ର କରନ୍ତୁ | 
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8. ପ୍ରଥ୍ମ ବୁକ୍ଲଟ୍ ପଏଣ୍ଟକ୍ର, କ୍ସବ ର ଧ ରଣ  ବ କୟ ଂେ ଚୟନ କରନ୍ତୁ ଏବଂ a ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | 

ଉଜ୍ଜ୍ୱେ ସବୁଜ ହ ଇଲ ଇଟ୍ | 

9. ପଞ୍ଚମ ବୁକ୍ଲଟ୍ ପଏଣ୍ଟକ୍ର, ଏକ ସ ଙ୍ଗକ୍ର ମସି୍ତଷ୍କ ଆରମଣ, କ୍ଯ ଜନ , ଏବଂ କ୍ନତୃତ୍ୱ େବ୍ଦଗରୁ୍ିକ ବ ଛନ୍ତୁ ଏବଂ ସମସ୍ତ ଅକ୍ଷରର ମ ମଲ କୁ ବଡ 

ଆକ ରକ୍ର ପରିବତ୍ତଡନ କରନ୍ତୁ | 

10. ର୍କୁୟକ୍ମଣ୍ଟ୍ କ୍ସଭ୍ ଏବଂ ବନ୍ଦ କରନ୍ତୁ | 

Create and modify lists 

Open the CreateLists document, display formatting marks and rulers, and then 

complete the following tasks: 

1. ନିମ୍ନକ୍ର ପ୍ରଥ୍ମ ଚ କ୍ର ଟ ିପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ ନିୟମଗରୁ୍ିକ ଚ କ୍ର ଟ ିକ୍ଶ୍ରଣୀକ୍ର ବିଭକ୍ତ | ମକ୍ନ ନୀତ ଅନୁକ୍େଦଗଡୁିକ ୁ

ବୁକ୍ଲକ୍ଟର୍୍ ତ ଲିକ  ଭ ବକ୍ର ଫମଡ ଟ୍ କରନ୍ତୁ | ତ ’ପକ୍ର ଚ କ୍ର ଟି ତ ଲିକ  ଆଇଟମ ୍ପ ଇ ଁବୁକ୍ଲଟ୍ ବର୍ଣ୍ଡକ ୁଚ ରିଟି ହୀର କୁ କ୍ନଇ 

ପରିବତ୍ତଡନ କର | 

2. ସଂଜ୍ଞ  କ୍ହର୍ଙ୍ି୍ଗ ତକ୍େ ଦୁଇଟି ପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ | ମକ୍ନ ନୀତ ପ ର ଗ୍ର ଫଗଡୁିକ ୁଏକ ନମ୍ବରଯକୁ୍ତ ତ ଲିକ  ଭ ବକ୍ର ଫମଡ ଟ୍ 

କରନ୍ତୁ | 

3. ସ ଧ ରଣ ନିୟମ କ୍ହର୍ଙ୍ି୍ଗ ତକ୍େ ପ୍ରଥ୍ମ ଚ କ୍ର ଟ ିପ ର ଗ୍ର ଫ୍ ଚୟନ କରନ୍ତୁ | ଦ୍ୱିତୀୟ ନମ୍ବରଯକୁ୍ତ ତ ଲିକ  ଭ ବକ୍ର ପ ର ଗ୍ର ଫ୍ 

ଫମଡ ଟ୍ କରନ୍ତୁ | ନିଶି୍ଚତ କରନ୍ତୁ କ୍ଯ ନୂତନ ତ ଲିକ  1 ନମ୍ବରରୁ ଆରମ୍ଭ କ୍ହଉଛି | 

4. ପରବତ୍ତଡୀ ତିକ୍ନ ଟ ିଅନୁକ୍େଦକୁ ବୁକ୍ଲଟ୍ ତ ଲିକ  ଭ ବକ୍ର ଫମଡ ଟ୍ କରନ୍ତୁ | (ଧ୍ୟ ନ ଦିଅନ୍ତୁ କ୍ଯ ୱ ର୍ଡ ଆପଣ ପବୂଡରୁ ନିଦିେ 

କରିଥ୍ବି  ବୁକ୍ଲଟ୍ ପ୍ରତୀକକ ୁବୟବହ ର କରନି୍ତ | 

5. ଅବେେି ତିକ୍ନ ଟ ିଅନୁକ୍େଦକୁ ଏକ ନମ୍ବରଯକୁ୍ତ ତ ଲିକ  ଭ ବକ୍ର ଫମଡ ଟ୍ କରନ୍ତୁ | ନଶିି୍ଚତ କରନ୍ତୁ କ୍ଯ ପବୂଡ ନମ୍ବର କ୍ହ ଇଥ୍ବି  

ତ ଲିକ ରୁ ତ ଲିକ  ସଂଖ୍ୟ  ଜ ରି ରହିଛି | 

6. କ dogs ଣସି ବଡ କୁକୁର ସଂଖ୍ୟ ଯକୁ୍ତ ତ ଲିକ  ଆଇଟମ ୍କ୍ଖ୍ ଜ | କ୍ଦଖ୍ବି  େବ୍ଦରୁ ଆରମ୍ଭ କ୍ହଉଥ୍ବି  ପ ଠୟରୁ ଏକ ନୂତନ 

ଦ୍ୱିତୀୟ ସ୍ତରୀୟ ସଂଖ୍ୟ ଯକୁ୍ତ ତ ଲିକ  ଆଇଟମ ୍(କ) ସେିୃ କରନ୍ତୁ | ତ ’ପକ୍ର ଦ୍ୱିତୀୟ ଆଇଟମ ୍(ଖ୍) ସେିୃ କରନ୍ତୁ ଏବଂ କ୍ବ ର୍ଡ ଏହି 

ନିୟମକୁ ବୟତିରମ କରିବ ର ଅଧକି ର ସଂରକ୍ଷଣ କରନ୍ତୁ | 

7. ଏକ ତୃତୀୟ ତ ଲିକ  ଆଇଟମ ୍(ଗ) ସେିୃ କରନ୍ତୁ | ପ୍ରଥ୍ମ ତ ଲିକ  ଆଇଟମକ ୁନୂତନ ତ ଲିକ  ଆଇଟମକୁ କ୍ପ୍ର ତ୍ସ ହିତ କର, ଏବଂ 

ସମସ୍ତ ଗହୃପ େିତ ପେମୁ ନଙୁ୍କ କ୍ସମ ନଙ୍କ ମ ଲିକଙ୍କ ଆପ ଟଡକ୍ମଣ୍ଟକ୍ର ରହିବ  ଜରୁରୀ | ଧ୍ୟ ନ ଦିଅନ୍ତୁ କ୍ଯ ସ ଧ ରଣ ନିୟମ ତ ଲିକ  

ବତ୍ତଡମ ନ ରମ ନୁରମିକ ଭ ବକ୍ର ସଂଗଠିତ କ୍ହ ଇଛି | 

8. ତିକ୍ନ ଟି ବୁକ୍ଲକ୍ଟର୍୍ ତ ଲିକ  ଆଇଟମଗ୍ଡୁକିୁ ବର୍ଣ୍ଡ ନୁରମିକ ରମକ୍ର ସଟଡ କରନ୍ତୁ | 

9. ର୍କୁୟକ୍ମଣ୍ଟ୍ କ୍ସଭ୍ କରନ୍ତୁ ଏବଂ ବନ୍ଦ କରନ୍ତୁ |
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Apply built-in styles to text 

Open the ApplyStyles document in Print Layout view, and then complete the 

following tasks: 

1. ଏହ ର ବିଷୟବସୁ୍ତଗଡିୁକର ଏକ ସମୀକ୍ଷ  ପ ଇବ କୁ ର୍କୁୟକ୍ମଣ୍ଟ୍ ମ ଧ୍ୟମକ୍ର କ୍ସ୍କର ଲ୍ କରନ୍ତୁ | ଧ୍ୟ ନ ଦିଅନ୍ତୁ କ୍ଯ 

ର୍କୁୟକ୍ମଣ୍ଟ୍ ଏକ କ୍କନ୍ଦ୍ରୀଭୂତ ଟ ଇଟଲ୍ ଏବଂ ସବ୍ଟ ଇଟ୍ ସହତି ଆରମ୍ଭ ହୁଏ, ଏବଂ କ୍ସଠ କ୍ର ଅକ୍ନକ କ୍ହରି୍ଙ୍୍ଗ ଅଛି | 

2. ନ ଭିକ୍ଗସନ୍ କ୍ପନ୍ କ୍ଖ୍ ଲନ୍ତୁ | ଧ୍ୟ ନ ଦିଅନ୍ତୁ କ୍ଯ ନ ଭିକ୍ଗସନ୍ କ୍ପନ୍ ର କ୍ହରି୍ଙ୍୍ଗ କ୍ପଜ୍ ର୍କୁୟକ୍ମଣ୍ଟ୍ କ୍ର କ୍ହରି୍ଙ୍୍ଗ 

ପ୍ରତିଫେିତ କକ୍ର ନ ହି,ଁ କ ରଣ କ୍ହରି୍ଙ୍ଗଗରିୁ୍କ େ ଇଲ୍ ପରିବକ୍ତ୍ତଡ କ୍ଲ କ ଲ୍ ଫମଡ ଟିଂ ସହିତ ଫମଡ ଟ୍ କ୍ହ ଇଛି | 

3. େ ଇଲ୍ କ୍ପନ୍ କ୍ଖ୍ ଲନ୍ତୁ ଏବଂ ଏହ କୁ ଆପ ୍ୱକି୍େ ର ର୍ ହ ଣ ପ ର୍ଶ୍ଡକ୍ର ର୍କ୍ କରନ୍ତୁ | 

4. ନ ଭିକ୍ଗସନ୍ କ୍ପନ୍ ଏବଂ େ ଇଲ୍ କ୍ପନ୍ ମଧ୍ୟକ୍ର ପଷୃ୍ ଠ  ବିଷୟବସୁ୍ତକୁ ଫିଟ୍ କରିବ  ପ ଇ ଁପଷୃ୍ ଠ ର ଜୁମ ୍ସ୍ତର କ୍ସଟ୍ କରନ୍ତୁ 

| 

5. ର୍କୁୟକ୍ମଣ୍ଟ୍ ଟ ଇଟଲ୍ କ୍ର ଟ ଇଟଲ୍ େ style େୀ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ, ସମସ୍ତ ବ ଉେଁ ବିଷୟକ୍ର | 

6. ସଚୂନ  ସିଟ୍ ପ ର ଗ୍ର ଫକ୍ର ସବ୍ଟ ଇଟ୍ େ ଇଲ୍ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | 

7. ଏକ ନୂତନ ଘରକୁ ଯିବ , ପ୍ରଥ୍ମ କ୍ବ ଲ୍ଡ କ୍ହରି୍ଙ୍ଗକ୍ର କ୍ହର୍ିଙ୍୍ଗ 1 େ style େୀ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | ଧ୍ୟ ନ ଦିଅନ୍ତୁ କ୍ଯ 

କ୍ହରି୍ଙ୍୍ଗ କ୍ନଭିକ୍ଗସନ୍ କ୍ପନ୍ କ୍ର କ୍ଦଖ୍ ଯ ଏ | 

8. କ୍ହରି୍ଙ୍୍ଗ ଅନୁସରଣ କରୁଥ୍ବି  ବିଷୟବସୁ୍ତକୁ ଲୁଚ ନ୍ତୁ | ତ ’ପକ୍ର ଏହ କୁ ପନୁ play ପ୍ରଦେଡନ କରନ୍ତୁ | 

9. ସସୁ୍ଥ ରହିବ କୁ କ୍ହରି୍ଙ୍୍ଗ 1 େ style େୀ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | ତ ’ପକ୍ର ବଗିକ୍ର ରଖ୍ବି କ୍ର ସମ ନ େ style େୀ 

ପ୍ରକ୍ୟ ଗ କରିବ କୁ ଫମଡ ଟିଂକୁ ପନୁର ବୃତି୍ତ କରନ୍ତୁ | 

10. ପଷୃ୍ ଠ  କ୍ସ୍କର ଲ୍ କରନ୍ତୁ ଯ ହ  ଦ୍ both ା ର  ଉଭୟ ଅେରଲ ଇନ୍ କ୍ହରି୍ଙ୍୍ଗ ଦୃେୟମ ନ କ୍ହବ | ମ ଇଟ୍ ସ ଏବଂ କ୍ମଲି 

ବଗ ୍କ୍ହରି୍ଙ୍୍ଗ ଚୟନ କରନ୍ତୁ | ତ ’ପକ୍ର ଏକ ସ ଙ୍ଗକ୍ର ଉଭୟ ଚୟନକ୍ର କ୍ହରି୍ଙ୍୍ଗ 2 େ style େୀ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | 

11. ବର୍ଣ୍ଡମ େ  ରମକ୍ର ସମସ୍ତ େ yles େୀ ପ୍ରଦେଡନ କରିବ କୁ େ ଇଲ୍ କ୍ପନ୍ ବିନୟ ସ କରନ୍ତୁ | 

12. ନ ଭିକ୍ଗସନ୍ କ୍ପନ୍ କ୍ର, କ୍ହରି୍ଙ୍୍ଗ ଉପକ୍ର, ଆରମ୍ଭକୁ ଜମ୍ପ କିି୍କ୍ କରନ୍ତୁ | 

ର୍କୁୟକ୍ମଣ୍ଟ୍ ଟ ଇଟଲ୍ କୁ କ୍ଫରିବ  ପ ଇ ଁବଟନ୍ | 

13. ର୍କୁୟକ୍ମଣ୍ଟର ପ୍ରଥ୍ମ ଅନୁକ୍େଦକ୍ର, କମ୍ପ ନୀର ନ ମ ୱ ଇର୍୍ ୱ ଲ୍ଡ ଡ ଆମଦ ନୀକ ରୀ ଚୟନ କରନ୍ତୁ ଏବଂ ଇକ୍ଣ୍ଟନ୍ସ 

କ୍ରଫକ୍ରନ୍ସ େ style େୀ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | 

14. ଦି୍ୱତୀୟ ଅନୁକ୍େଦକ୍ର, ପ୍ରଥ୍ମ ବ କୟର କ୍େଷକ୍ର, କି୍ମ୍ପିଂ େବ୍ଦକୁ ବ ଛ, ଏବଂ ଏମ୍ପ ସିସ ୍େ style େୀ ପ୍ରକ୍ୟ ଗ କର | ତ ’

ପକ୍ର, ବ କୟର କ୍େଷକ୍ର, ଚ ଲୁଥ୍ବି  େବ୍ଦକ୍ର ସମ ନ େ style େୀ ପ୍ରକ୍ୟ ଗ କର |
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15. ନ ଭିକ୍ଗସନ୍ କ୍ପନ୍ ଏବଂ େ ଇଲ୍ କ୍ପନ୍ ବନ୍ଦ କରନ୍ତୁ | ତ ପକ୍ର ୱକି୍େ କ୍ର ର୍କୁୟକ୍ମଣ୍ଟ୍ ର ଉଭୟ ପଷୃ୍ଠ  ପ୍ରଦେଡନ କରିବ କ ୁଭୁୟ 

କ୍ସଟିଂକୁ ବିନୟ ସ କରନ୍ତୁ | 

16. ର୍କୁୟକ୍ମଣ୍ଟକ୍ର କ୍ସଟ୍ କ୍ହ ଇଥ୍ବି  ମ Basic େକି (ଏଲିଗ ଣ୍ଟ) େ style େୀକୁ ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | ପଷୃ୍ଠ  ଓସ ରକ ୁଦୃେୟ ପରିବତ୍ତଡନ 

କରନ୍ତୁ ଏବଂ େ ଇଲ୍ ବିଷୟବସୁ୍ତକ୍ର ପରିବତ୍ତଡନଗରୁ୍ିକ ଲକ୍ଷୟ କରନ୍ତୁ | 

17. ର୍କୁୟକ୍ମଣ୍ଟ୍ କ୍ସଭ୍ ଏବଂ ବନ୍ଦ କରନ୍ତୁ | 

 

Change the document theme 

Open the ChangeTheme document, and then complete the following tasks: 

 

1. ର୍କୁୟକ୍ମଣ୍ଟକ୍ର କ୍ଫକ୍ସଟ୍ ଥ୍ମି ୍ପ୍ରକ୍ୟ ଗ କରନ୍ତୁ | 

2. ଥ୍ମି ୍ରଙ୍ଗକ ୁକମେ  ରଙ୍ଗ ସି୍କମ ୍କ୍ର ପରିବତ୍ତଡନ କରନ୍ତୁ | 

3. ଥ୍ମି ୍ଫଣ୍ଟଗରୁ୍ିକ ଜଜିଆ ଥ୍ମି ୍କ୍ସଟ୍ କ୍ର ପରିବତ୍ତଡନ କରନ୍ତୁ | 

4. କ୍ମ  ଥ୍ମି ୍ନ ମକ ଏକ କେମ ୍ଥ୍ମି ୍ଭ ବକ୍ର ପରିବତି୍ତତ ଥ୍ମି ୍କୁ ର୍ିଫଲ୍ଟ କ୍ଫ ଲ୍ଡରକ୍ର କ୍ସଭ୍ କରନ୍ତୁ | ଥ୍ମି ୍କ୍ମନୁକ୍ର କେମ ୍ଥ୍ମି ୍

ଉପଲବ୍ଧ ଅଛି ଯ ଞ୍ଚ କରନ୍ତୁ | 

5. ର୍କୁୟକ୍ମଣ୍ଟ୍ କ୍ସଭ୍ ଏବଂ ବନ୍ଦ କରନ୍ତୁ |
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Index 
Symbols 
+ (addition) operator 218 

& (concatenation) operator 218 

#DIV/0! error code 230 

/ (division) operator 218 

##### error code 230 

^ (exponentiation) operator  218 

* (multiplication) operator 218 

#NAME? error code 230 

- (negation) operator 218 

% (percentage) operator 218 

#REF! error code 230 

– (subtraction) operator 218 

#VALUE! error code 230 

A 
absolute references 

changing from relative 214 

creating 217 

accepting tracked changes in documents 

131–132 

accessing documents 

restricting with passwords 144–149 

restricting with rights management 149 

accounts 

displaying Office settings 20 

managing 18–20 

Active view 528 

Address Block merge field 179–181 

address books, searching 437–438 

address boxes 430, 464 

address lists 

searching 438 

troubleshooting   435 

address resolution  430, 434 

AGGREGATE function 245, 247, 250–252 

aliases 430 

 
 
 
 
 

Align Left 71 

Align Right 71 

aligning 

decimal points 81 

lines of text 80 

tabs 83 

text, using tab stops 80 

All Items list, filtering 463 

All Markup view 122 

Analysis ToolPak 303–304 

animating 

objects 386, 392–394 

pictures 386–391 

pie charts 392 

text 386–391 

animation effects 

adding sound   402 

applying multiple  391, 395 

configuring   390 

copying between objects 395 

customizing 396–402 

Emphasis 388, 391 

Entrance 387, 391 

Exit 389–391 

fine-tuning   396–397 

live preview 394 

Motion Path   389 

removing   396 

reordering   400 

Animation Painter   396 

Animation Pane 395–398 

animations 386 

adding sound effects 402 

configuring options 390, 395 

fine-tuning   399 

indicators 398 

as individual events 398 

on click 398 
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animations (continued)  definition   207  

opening effect-specific dialog box 400 function_num  248, 252–253 

ordering 391  fv 207 

positioning objects on slides  391  k 253 

previewing  394, 396  lookup_value 277 

reordering 391  nper 207 

selecting 395, 398  options 251–253 

setting duration  401  pv 207 

timing 401  range_lookup 277 

triggering 398, 401  rate 207 

turning off live preview   394  ref 252–253 

types 386  table_array 277 

annotating documents  135–136  type 207 

app windows  VLOOKUP function   276 

changing backgrounds   20  array formulas 227–229 

changing color schemes 20  arrays 253 

maximizing 13  artistic effects 

personalizing 19  applying to pictures  361 

Quick Access Toolbar 6  applying to text   88 

ribbon   6–9  ascending order, sorting bulleted lists 94 

status bar 10–11  attachments  

title bar 5–6  arranging messages by  482  

appointment window   504  copies of online files   449  

appointments 504, 506  displaying   454–456  

conflicting   504–505  forwarding messages  465  

converting into events 510–511  modifying   445  

converting into meetings 512  opening in default app   457  

creating from messages 510–511  Outlook items   450  

creating recurrences 517  previewing   454–457  

default availability 513  removing   445, 449  

displaying on calendars 505  saving to storage drives  457–458  

editing 507  scanning for viruses  456  

indicating availability  516  sending from File Explorer   449  

InfoBar 505  sharing Office files   447–448  

modifying 516  attendees 519  

opening new appointment windows 506 adding to meetings 521  

recurring  513–514, 517  optional   523  

reminders  513, 516  removing 524  

resizing 507  required 523  

scheduling   504–508  tracking meeting responses  521  

time zones  512–513, 515  attributes  

arguments  files 53  

array 253  messages 482–486  

col_index_num 277    
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audio clips 

automatically starting  410 

bookmarking   402–403 

downloading     404 

fading into/out of 408 

inserting onto slides 406 

looping 409–410 

preventing from stopping 409 

restricting playback 407–408 

supported formats 404 

audio content 

adding narration   404 

customizing   406 

recording onto slides 406–407 

starting 405 

trimming   408 

audio icons 404–405, 408 

audio playback 

automatically starting   409 

controls 405 

manually starting   409 

restricting 407–408 

auditing formulas for errors 229 

AutoCalculate 

summarizing filtered data lists 247 

summarizing values 252 

Auto-Complete List   434–436 

AutoCorrect Options   92, 202 

AutoFormat As You Type  96, 202 

AutoFormatting options   96 

automatic calculations 226 

AVERAGE function 207, 247–248, 250 

AVERAGEIF function  220–221 

AVERAGEIFS function  220 

 

B 
Background Removal tool tab 360 

backgrounds (PowerPoint) 336–346 

Format Background pane  337, 340 

gradients  337–338, 342–343 

patterns  339–340, 346 

removing from pictures 359–360 

textures 338–339, 343 

Backstage view 6–7, 18 

app-specific options 22–23 

managing account information 18 

balloons 

comments 116 

displaying markup  125 

Bar Tab 81 

Bcc field 430, 432 

bitmap (BMP) file format 355 

bits per pixel (bpp) 355 

blind courtesy copies 430 

BMP (bitmap) file format 355 

bookmarks 402–403 

Border Lines 96 

borders (Word) 

adding lines   96 

paragraphs 79 

bpp (bits per pixel) 355 

branches, conversations 477 

build slides 392 

built-in styles, applying to text  97–103 

built-in themes, applying to documents 106 

bulleted lists 91 
See also lists 

animating on slides 390, 392 

converting from paragraphs 93 

formatting on the fly 92 

sorting into ascending/descending order 94 

starting new 92 

bullets   94 

 

C 
Cached Exchange Mode, enabling 463 

calculations 
See also formulas; iterative calculations 

automatic 226 

dependents 231 

error codes  230 

finding errors   229 

linear 299 

manual 226 

setting options  226–227 

stepping through   234–235 
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calendar items 

appointments 504, 506 

assiging importance  515 

configuring options  512–517 

converting 510–512 

events  505, 510 

indicating availability 513, 516 

modifying 516 

privacy 514 

recurring  513–514, 517 

reminders  513, 516 

time zones 512, 515 

Calendar view 505, 528 

calendars 

Active view 528 

adding holidays   508–509 

arrangements 529–531 

Calendar view   528 

changing displayed time period 531 

connecting to 503 

date areas 505 

Day arrangement   529 

displaying seven-day week 534 

displaying specific day 534 

displaying task lists 534 

displaying today’s schedule 534 

displaying week numbers 531 

displaying work week schedule 534 

List view 528 

Month arrangement 529 

navigating in Month view 531 

Preview view 528 

privacy indicator  514 

reminder icon 513 

removing holidays   509 

resetting views 530 

returning to default settings 535 

Schedule view arrangement 529 

ScreenTips 505 

time slots 505 

views 528–531, 534–535 

Week arrangement 529 

Work Week arrangement 529 

Call or Call All message responses 466 

capturing screen clippings 372–374 

categories 
See also messages 

appointments    515 

arranging messages by 483 

assigning 486, 492 

assigning colors 488 

assigning shortcut keys 488 

assigning to notes 490 

Categorize menu 489 

conversations 488 

creating 488, 493 

deleting   494 

elements 488 

events 515 

filtering by 489 

grouping items by 489 

holidays 509 

meetings 515 

naming   488 

Quick Click  488, 492, 494 

removing   493 

renaming  487, 493–494 

searching   486 

sorting by   489 

viewing in Reading Pane 488 

Categorize menu 489 

Cc field 430, 432 

cell colors, sorting data by 267 

cell formats and VLOOKUP 278 

cell ranges 

converting tables to 205 

creating tables from 202 

defining value sets 255–257 

named 198 

watching values in 234 

with numbers, counting 222 

cell references 

absolute 217 

circular 225 

in formulas  211–214 

relative 217 
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cells, in worksheets 

blank, counting 222–223 

dependents 231, 233 

error codes 230 

error indicators 233 

excluding from tables 202 

expanding selection 210 

meeting conditions   223 

named ranges 198 

precedents  230, 233 

references 211–214 

selecting in formulas 209 

setting watches 232 

validation rules  255–256 

Center Shadow Rectangle picture frame 

style 376 

Center Tab 81 

changes, tracking See tracked changes 

character formatting 84–90 

applying   85 

best practices 91 

definition   84 

removing   90 

types 84 

character spacing, changing  85, 90–91 

characters, subscript/superscript 88 

Check Spelling As You Type option 133 

chiclet 459 

circular references  225 

cleaning up conversations 480 

closing files 60 

cloud storage 20, 59 

coauthoring 115 

documents 149–153 

inserting comments into documents 116–118 

col_index_num argument 277 

collaborating 115–118 

Color Categories dialog box, opening 492 

color schemes, changing for all apps 20 

color sets in themes 104 

colors 

applying to presentations 334 

categories 486, 488 

comments 117–118 

fonts 88 

non-theme   344 

notes 490 

tracking changes using 119–120 

column input cell 294 

columns, in worksheets 

adding to Excel tables 202, 204 

as sort criteria 264–266 

combining documents 134–136 

commands 

adding to custom groups 33–34 

formatting 364 

Quick Access Toolbar 26–31 

repeating formatting 90 

comments 

adding to data set scenarios 287 

balloons 116 

colors 117–118 

deleting 130 

displaying 126 

editing 130 

hidden 116 

inserting into documents 116–118 

marking as done 130 

moving between  129 

responding to 128–130 

reviewing   128–130 

specifying user name 23–24 

viewing 123–124 

comparing documents 133–137 

Compatibility mode   55 

Compound Frame, Black picture frame 

style 376 

compressing media 415–417 

conditional formulas 

averages that meet conditions 224 

counting cells 222–224 

creating 219 

summarizing data   222 

sums that meet conditions 223 

conditional functions 220 

connecting shapes  371–372 
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connection points 
 

 

 

 

connection points 371–372 

contact cards 

displaying for message participants 

459–462 

initiating contact from 462–463 

pinning 460 

conversation bubble icons, hidden 

comments 116 

Conversation view  476–477 

conversations 476 

See also messages 

benefits of using 477 

branches 477 

cleaning up  478, 480–481 

deleting 478 

deleting messages from folders 478–481 

displaying all messages 476, 478 

displaying color category blocks 488 

displaying message lists 480 

displaying messages  480 

displaying messages in any folder 478 

displaying most recent messages 476 

expanding 476–478 

headers 476, 478 

history 462 

ignoring 478, 482 

indenting older messages 478 

moving from folders 497 

multiple responses 477 

participants 461 

selecting all messages 477, 480 

sent messages 477–478 

stop ignoring   482 

unique messages 476 

unread messages 477 

copying 

formatting from one shape to another 369 

formulas 211, 214, 217–218 

slide content 317–324 

slides 317–324 

values 270 

copyrighted pictures   352 

COUNT function  207, 220, 248, 250 

COUNTA function 220, 248, 250 

COUNTBLANK function   220 

COUNTIF function 220 

COUNTIFS function 220 

courtesy copies 430 

cropping pictures   357 

cursor movement and keyboard 45 

custom color model 345 

custom groups in subtotals 275 

custom lists, sorting data using  268–270 

 

D 
Daily Task List 534 

data 

analyzing using data tables 292–295 

analyzing using descriptive statistics 

303–304 

analyzing using Quick Analysis Lens 

284–286 

circling invalid data 257 

data tables 292–295 

filtering in worksheets 262–268 

organizing into levels 271–275 

sorting in worksheets 262–268 

sorting using custom lists 268–270 

summarizing   247–253 

summarizing in tables 202 

summarizing with AutoCalculate 252 

using tables 201–205 

validation rules 255 

Data Analysis add-ins, adding to ribbon 304 

data lists 

creating custom groups in 275 

hiding/showing details in 274 

removing custom groups 275 

removing subtotals from 275 

data, mail merge 

merging to new documents 182–183 

refreshing 178 

data ranges 

adding total columns/rows 285 

header cells in 240, 250 

data sets 

See also scenarios 

adding tables 286 



documents 

547 

 

 

 

 

adding totals   286 

analysis tools  303–304 

defining alternative values  287, 289 

defining multiple alternative values  290–291 

deleting   290 

displaying 289 

editing   289–290 

finding target values 296–297 

finding unique values 253–254 

formatting summaries  285 

Quick Analysis Lens 284–286 

scenarios 287–292 

Solver 297–303 

using descriptive statistics 304 

varying for specific results 295–297 

data sources, mail merge 

creating new 172–173 

filtering records 174–175 

linking to merge fields 178 

mail merge 160 

mail merge requirements 168–169 

refining records 173 

removing records 173–174 

selecting existing 169–172 

sorting records 177–178 

types 169–170 

data tables 

changing variables 293 

column input cell 294 

location in cell ranges 292 

one-variable    293–294 

row input cell 294 

two-variable 293–295 

date and time, displaying current 215 

date areas on calendars 505 

Day calendar arrangement 529 

decimal points, aligning 81 

Decimal Tab 81 

deleting 
See also removing 

comments 130 

slides 324–326 

dependents 231, 233 

descending order, sorting bulleted lists   94 

details, hiding/showing in subtotal summary 

lists 274 

digital signatures See signatures 

Display For Review options 122–123 

displaying 

author of tracked change 131 

coauthor changes 152 

comments 126 

document markup 122–128 

time of tracked change 131 

distribution lists 461 

docking panes   99 

Document Formatting gallery    98 

Document Themes folder location 106–107 

documents 

accessing restricted 144–149 

adding envelopes  186 

annotating   135–136 

applying built-in themes 106 

browsing objects 48 

changing theme elements 106 

closing 60 

coauthoring  115, 149–153 

collaborating 115 

combining 134–136 

comparing 133–137 

content restriction 137–149 

creating based on templates 42 

default theme 106 

editing 152 

expanding/collapsing sections  103 

formatting marks 52 

formatting restrictions  138–144 

hiding/unhiding gridlines   52 

hiding/unhiding guides   52 

hiding/unhiding rulers 52 

highlighting merge fields 180 

identifying locked areas 152 

merging 133–137 

nonprinting characters 52 

opening   46–47 

opening protected documents 146–147 

previewing merged 182 

restricting edits 138–144 
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dots (pixels) 
 

 

 

 

documents (continued) 

restricting styles 139–142 

saving 59 

spelling checks 133 

tracking changes 119–122 

versions 136–139 

dots (pixels) 355 

Draft view 49 

drafts 

automatic saving increments 441 

modifying messages 442–443 

saving messages as  438–439, 441–442 

drawing shapes 361–371 

 

E 
editing 

comments 130 

inviting others to edit 152 

photo album settings 380 

pictures 356–361 

removing restrictions  144 

restricting edits  138–144 

tracked changes  119–122 

Effect Options 399 

effect style, applying to presentations 335–336 

effects 

fonts 85 

WordArt   86 

electronic postage 186 

email addresses 

comma separators  437 

removing from Auto-Complete List 436 

email messages See messages 

embed code 410 

embedded videos, selecting 414 

Emphasis animation effects 388, 391 

Encrypted option 144 

Entrance animation effects 387, 391 

envelopes 

adding to documents 186 

creating individual 184 

editing addresses 184 

electronic postage  186 

manually entering addresses  186–187 

positioning addresses  185 

printing 187–188 

saving 188 

setting up from addresses 187 

storing return addresses 185–186 

Error Checking tool   232 

error codes in calculations 229, 230 

errors 

changing display options 234 

circular references 225 

Error Checking tool   232 

finding/fixing in calculations 229–232 

in formulas 231, 233 

tracing precedents  230 

events 504 

converting to appointments 512 

converting to invited events 512 

creating recurrences 517 

displaying on calendars 505 

holidays 508–509 

indicating availability  516 

invited 510 

modifying 516 

recurring 513–514 

reminders, changing default 516 

scheduling 505, 510 

time zones 512–513 

Evolutionary solver method 299 

Excel 2016 

file extensions  54 

file formats  54 

views 49 

Exit animation effects  389–391 

 

F 
Facebook accounts, connecting to 19 

faxing messages 448 

fields, mail merge 160 

files 

accessing from OneDrive 61 

attaching to messages 444–447 

attributes 53 

automatically saving 58 

creating   40–43 



formatting marks, displaying 
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creating based on installed templates 42 

creating based on online templates 42 

displaying different views 48–50 

displaying multiple 52 

displaying properties   56 

editing properties   56 

extensions 54 

formats 54–55 

magnifying   51–52 

moving around in 43–45 

Office version compatibility 54–55 

opening 40, 43–51 

opening in web browsers 47 

previewing design templates 41 

properties 53 

saving 56–57, 59 

saving copies   59 

saving in previous Office versions 55 

saving to OneDrive 57, 60 

saving to SharePoint  57 

sending from File Explorer   444, 449 

sending from Office apps   444, 447–448 

settings 53 

starting new 41 

switching among views 51 

switching between 50 

templates 40 

types 39, 54–55 

viewing in multiple windows 50 

filter arrows 240, 243–245 

filtered data lists, summarizing visible cells 247 

filtering 

All Items list 463 

by categories 489 

defining criteria 241 

summarizing worksheet data 247–253 

worksheet data 262–268 

filters 

clearing from worksheets 245 

creating rules 244 

search 242, 245 

selection   244 

Top 10 242, 244 

Final view (Word 2010) See No Markup view 

first line indent, creating 78 

First Line Indent marker 76–77 

flags, arranging messages by 483 

Flickr accounts, connecting to 19 

flipping shapes 366 

folders, messages 496–497 

Font dialog box 90 

font sets 

applying to presentations 334–335 

built-in 104 

fonts 

attributes 85–86 

changing colors   88 

changing for selected text 87 

changing sizes 87 

default   84 

effects   85 

size 84 

style 85 

Format Background pane  337, 340 

Format tool tab 353, 356 

formatting 

alignment 71 

AutoCorrect Options   92 

characters 84–90 

commands   364 

copying to other text 89 

graphics 355–356 

lists 92 

messages 428, 432–433 

paragraph borders   79 

paragraph shading   79 

pictures 356–361 

previewing   9 

removing   90 

removing restrictions  144 

repeating previous commands 90 

restricting edits 138–144 

shapes 367–370 

text 69, 87–88, 96 

text as you type 96 

text on a shape 369 

tracked changes 119 

formatting marks, displaying 52 
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Formula AutoComplete 208–210 

formulas 
See also calculations 

absolute references 214 

arrays 227–229 

averages that meet conditions 224 

calculating payments 215 

calculating values  206 

cell references  217–218 

conditional 219–224 

copying 211, 214, 217 

counting cells 222–224 

creating 215 

creating AGGREGATE  253 

creating subtotals 252 

displaying date and time 215 

displaying errors 224, 231, 233, 234 

duplicate results 228 

Error Checking tool 232 

error codes 229 

Formula AutoComplete 208–210 

generating specific results  295, 297 

identifying dependents   233 

identifying precedents   233 

incomplete results   228 

inserting functions  222 

interative calculations  225 

moving 217 

NOW(), updating 215 

operator precedence  218 

operators 218 

predefined   206 

recalculating workbooks 226 

referring to named ranges 216 

referring to table columns 216 

relative references 211–213 

selecting cells 209–210 

stepping through   232–234 

summarizing data 222 

sums that meet conditions 223 

tracer arrows 231 

values from named ranges 208 

VLOOKUP 278 

Forward As Attachment message 

responses 465 

Forward message responses 465 

forwarding messages 464–465, 470 

frame styles, pictures 376 

framing pictures  358–359 

function_num argument 248, 252–253 

functions 

AGGREGATE 245, 247, 250–252 

AVERAGE 207, 247–248, 250 

AVERAGEIF 220–221 

AVERAGEIFS 220 

COUNT 207, 220, 248, 250 

COUNTA 220, 248, 250 

COUNTBLANK   220 

COUNTIF 220 

COUNTIFS 220 

HLOOKUP   278 

IF 222 

IFERROR 220 

MAX 207, 248, 250 

MEDIAN 251 

MIN 207, 249–250 

MODE.SNGL 251 

NOW 207 

PERCENTILE.EXC 251 

PERCENTILE.INC 251 

PMT 207 

PRODUCT 249 

RAND   245–246 

RANDBETWEEN 245–246 

SMALL 251 

STDEV.P  249, 251 

STDEV.S 249, 251 

SUBTOTAL 245, 247–248, 250 

SUM 207, 247, 249, 251 

SUMIF 220 

SUMIFS 220 

VAR.P 249, 251 

VAR.S  249, 251 

VLOOKUP  220, 276–279 

fv argument 207 
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G 
GIF (Graphics Interchange Format) 355 

Goal Seek 295–297 

gradients, slide backgrounds 337–338, 

342–343 

grammar errors, hiding 23 

graphics 
See also pictures; shapes 

formats 355–356 

formatting commands   364 

screen clippings 372 –374 

types 351 

Graphics Interchange Format (GIF) 355 

Greeting Line merge field 179, 181 

GRG Nonlinear solver method 299 

gridlines, hiding 52 

grouping shapes 369 

guides, hiding 52 

 

H 
Hanging Indent marker 94 

hanging indents 

creating 77–78 

in lists 91 

hidden characters  80 

hidden comments 116 

hiding 

Animation Pane   395 

data list details 274–275 

document markup  126 

grammar errors  23 

gridlines 52 

guides 52 

paragraph marks  82 

ribbon 13–14 

rulers 52 

slides 324–326 

spelling errors  23 

tracked changes 120 

highlighting text in documents 89 

HLOOKUP function 278 

holidays 508–509 

hyperlinks 418–419 

I 
IF function 222 

IFERROR function 220 

ignoring conversations 478, 482 

importing 

custom data lists 269 

slide content 317–323 

slides 317–324 

indenting 

lists 93 

paragraphs 78 

indent markers 76–78, 94 

InfoBar 505 

information rights management (IRM) 149 

Insert New Pictures dialog box 377 

Insert Picture dialog box 353 

inserting 

comments into documents 116–118 

on-screen window images onto slides 

372–373 

pictures 352–355 

screen clippings  372–374 

simple graphics  351–382 

slides 316–317 

integer programming   299 

invited events 510, 512 

IR (information rights management) 149 

italic, applying to text 87 

iterative calculations  225–227 
See also calculations 

 

J 
jelly bean 459 

JPEG (Joint Photographic Experts Group)  355 

 

K 
k argument 253 

keyboard and cursor movement 45 

keyboard shortcuts 45 

creating tables  202 

expanding cell selections 210 
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L 
labels See mail merge labels; mailing labels 

LARGE function 251 

layouts, photo albums 375 

Left Indent marker 76–77 

Left Tab 81 

letters 

merge field placeholders 162 

merge fields 179 

starting mail merge 162–163 

templates 162 

level buttons in worksheet outlines 273 

line break characters 80 

line breaks, inserting 82 

linear calculations 299 

LinkedIn accounts, connecting to 19 

List view 528 

lists 
See also bulleted lists; numbered lists 

automatic formatting 92 

creating multiple levels 93 

customizing 92 

definition 91 

ending   92 

modifying indentation   93 

Live Preview 23–24 

locking documents 152 

lookup_value argument  277 

lowercase 91 

 

M 
magnifying screen display 13 

mail merge 

creating new data sources 172–173 

data source requirements 168–169 

data sources 159, 160, 162, 169–170 

definition 159 

displaying Mail Merge Recipients list 174 

editing custom greetings 167 

fields 160 

filtering recipients list 174–175 

filtering records 175–176 

importing contacts  170 

importing data from Exchange 170 

labels 163–166 

letters 162–163 

manually excluding records 177 

merge fields 161 

messages 166–168 

process overview  160–161 

records 160 

refining data source records 173–177 

refreshing data 178 

removing data source records 173–174 

removing duplicate records  176 

selecting existing data sources 169–172 

sorting records in data sources 177–178 

starting 166–168 

tools 160 

types of output 161 

using the Mail Merge wizard 161 

validating addresses 174 

mail merge labels 

manufacturers and products 164 

starting mail merge 163–166 

uses for 163 

Mail Merge wizard 160–161 

mailing addresses 

editing on envelopes 184 

validating 174 

mailing labels 188–190 

managing simple graphics 351–382 

manual calculations 226 

markup 116 

displaying 122–128 

hiding 126 

responding to comments 128–130 

reviewing comments 128–130 

tracking changes 119–122 

views 122–123 

mathematical operators 

controlling order of 218 

list of 218 

MAX function 207, 248, 250 

media, compressing/uncompressing  415–417 
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MEDIAN function 251 

meeting invitations, creating from 

messages 464 

meeting requests 466, 518 

accepting 526 

creating 522 

declining 526 

editing   524 

proposing new time 526–528 

responding to 526–527 

tenatively accepting 526 

meetings 

attendee availability  519–520, 523 

attendees  519, 521 

canceling   524–525 

changing times  521 

conference rooms  519 

creating recurrences 517 

default availability 513 

indicating availability  516 

inviting groups of people 519 

inviting managed resources 519 

meeting window 518–519 

modifying 516 

opening new meeting window 521 

optional attendees 523 

recurring 513–514 

reminders  513, 516 

removing attendees 524 

requirements 519 

Room Finder 519 

scheduling 518–525 

Scheduling Assistant 518, 520 

Skype for Business 504 

Suggested Times list 519, 521 

time zones  512–513, 515 

tracking attendee responses 521 

menus, resizing 393 

merge fields 161 

Address Block 179–181 

Greeting Line 179, 181 

highlighting in documents 180 

inserting 178–181 

linking to data sources 178 

placeholders 162 

previewing results 181–182 

merged documents, previewing 182 

merging 

data to new documents 182–183 

documents 133–137 

message folders, creating 496–497 

message headers 430, 452, 476 

conversations 476, 478 

drafts 439 

icons 452 

message lists 475 

changing default settings 480 

changing sort order 483–485 

default order 475 

message participants 

communication history 462 

contact cards  459–462 

online status 459 

resolving addresses 430, 434 

message responses 

address boxes  464 

etiquette   465 

forwarding   465 

meeting requests 466 

modifying recipients   465 

task assignments 466 

voting buttons 466 

messages 
See also categories; conversations 

address boxes  464 

address resolution 430–431 

arranging by account 482 

arranging by attachments 482 

arranging by attributes 482–486 

arranging by categories 483 

arranging by flags    483 

arranging by importance 483 

arranging by item type 483 

arranging by primary recipients 483 

arranging by senders 483 

arranging by size 483 
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MIN function 
 

 

 

 

messages (continued) 

arranging by subject 483 

assigning categories 492 

attaching files 444–450 

attaching online file copies 449 

attaching Outlook items   444–445, 450 

attributes 482–483 

Auto-Complete List   434–435 

body   429 

categorizing   486–489 

closing after responding  470–471 

collapsing groups   484, 486 

creating   429–434 

creating appointments from  510–511 

creating folders  496–497 

displaying as conversations 477 

displaying content 452–453 

downloading external content 453 

editing custom greetings 167 

entering content 432 

entering email addresses 432 

entering subjects 432 

expanding groups   486 

faxing   448 

fields   429–430 

formatting  428–429, 432–433 

forwarding  465, 470 

grouping/ungrouping   485 

headers 430, 439, 452 

HTML format 428 

icons in headers 452 

modifying drafts 442–443 

moving to folders 496–497 

multiple categories 487 

opening   452 

organizing in folders 494–497 

personalizing 428 

Plain Text format 428 

previewing 499 

printing   498–499 

Reading Pane   452 

recalling   468–469 

recipients 430 

removing attachments   449 

Reply 464 

Reply All   464 

Reply with Meeting 464 

resending 468–469 

resetting arrangements  486 

responding to 464–467 

Rich Text format 428 

saving as drafts 438–439, 441 

security settings  453 

selecting groups   485 

sending   443 

sending from specific accounts 440 

sending to aliases 430 

signatures 428 

sorting by column 485 

troubleshooting 434–435 

verifying sent items 444 

MIN function 207, 249–250 

Mini Toolbar 23–24, 85 

MODE.SNGL function  251 

Month calendar arrangement 529 

Motion Path animation effects 389 

moving 

between comments  129 

formulas 217 

groups of shapes 370 

pictures 352–355 

shapes 366 

between tracked changes 128 

multiple data set scenarios 290 

N 
named ranges 

creating 200 

creating from data with headings 200 

defining cells as 198 

deleting 201 

editing 200–201 

managing 199 

referring to in formulas 216 

supplying formula values 208 

names, removing from Auto-Complete List   436 
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naming Excel tables 203 

narration 402 

holidays 508–509 

Navigation pane 48, 103 

new mail notifications 451 

No Markup view 123 

nonprinting characters, displaying 52 

non-theme colors 344–345 

Normal template styles 97 

Normal view 49 

Notes Page view 49 

notes, storing information in  490–491 

notifications 451 

NOW() formulas, updating 215 

NOW function 207 

nper argument   207 

Number Filters   240 

numbered lists 91 
See also lists 

converting from paragraphs 93 

formatting on the fly 92 

predefined numbering 95 

restarting 95 

starting 95 

starting new 92 

numbers 

changing styles 94 

defining custom styles 95 

O 
objects 

animating on slides 386, 392–394 

applying multiple animation effects 391 

applying multiple effects 395 

attaching hyperlinks 418–419 

browsing in documents 48 

copying effects   395 

positioning on slides 391 

removing animations 396 

Office 365 subscriptions 18, 21 

Office 2016 3 

managing updates 21 

Quick Access Toolbar 6 

ribbon 6–9 

starting   4 

title bar 5–6 

window elements  4–8 

Office themes 19 

on click animations 398 

OneDrive 60 

accessing files 61 

connecting to   19 

saving files to 57, 60–61 

OneDrive for Business 61 

one-variable data tables 293–294 

opening protected documents 146–147 

options argument  251–253 

organization levels in worksheets 273 

organizing 

Inbox 494–497 

items in folders 495 

messages in folders 494–497 

Original view 123 

outdenting paragraphs 77–78 

outline area, worksheets 273 

Outline Level settings 102 

Outline view 49 

outlines 

displaying in Navigation pane 103 

expanding/collapsing 103 

levels 102 

managing with styles 101–103 

subheadings 103 

Outlook items, attaching to messages 444– 

445, 450 

Outlook Options dialog box, opening   436 

 

P 
Page Break Preview view 49 

paragraph indent 76 

paragraph marks, displaying/hiding 82 

Paragraph Spacing options 73 

paragraphs 

adjusting spacing between lines 75 

breaking lines 80 

configuring borders 79 

converting to lists 93 
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parentheses, controlling operator order 
 

 

 

 

first line indents 78 

formatting 70 

formatting as lists 92 

hanging indents 77–78 

hidden characters  80 

indenting 76–78 

indenting beyond margins 78 

indenting right edge 78 

inserting line breaks 82 

line break characters 80 

line spacing 72 

manually positioning text 79 

outdented    77–78 

outdenting right edge 78 

setting alignment 72 

shading 79 

soft returns 80 

spacing 72 

tab characters  80 

wrapping lines   80 

parentheses, controlling operator order 218 

passwords 144–149 

patterns, slide backgrounds  339–340, 346 

People Pane  461–463 

PERCENTILE.EXC function 251 

PERCENTILE.INC function 251 

personalizing messages  428 

Photo Album dialog box 375 

photo albums, creating 375–380 

Picture Tools tab group 353 

pictures 
See also graphics 

pictures animating  386–391 

artistic effects 361 

copyrights 352 

editing and formatting 356–361 

inserting, moving, and resizing 352–355 

pie charts, animating 392 

pinning contact cards 460 

pixels 355 

placeholders, merge fields 162 

Plain Text format 428 

PMT function   207 

PNG (Portable Network Graphic)   355 

Portable Network Graphic (PNG) 355 

PowerPoint 2016 

file extensions 55 

file formats 55 

views 49–50 

precedence of operators 218 

precedents 

identifying   233 

tracing 230 

presence information 459 

presentations 

adding slides 314–326 

applying themes  331–336 

closing 60 

color schemes 334 

copying slides  317–324 

creating based on templates 42 

deleting slides  324–326 

dividing into sections 326–328 

effect style 335–336 

font sets 334–335 

hiding slides 324–326 

hiding/unhiding gridlines   52 

hiding/unhiding guides   52 

hiding/unhiding rulers   52 

importing slides  317–324 

opening   46–47 

rearranging sections  329–331 

rearranging slides  329–331 

saving 59 

standard themes  333 

Preview view 528 

previewing 

animation effects 394 

animations 396 

attachments 456–457 

formatting   9 

merged documents  182 

messages 499 

primary key  276 

primary key column 276 

primary slide master, attaching hyperlinks 418 

Print Layout view 48 
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printing 

envelopes 188 

messages 498–499 

PRODUCT function 249–250 

properties 

displaying 53–54 

editing   56 

pv argument 207 

 

Q 
QUARTILE.EXC function 251 

QUARTILE.INC function 251 

Quick Access Toolbar 6 

adding commands  25, 26, 28 

customizing   26 

defining for specific files 28 

displaying separators 28–29 

moving   28 

moving buttons 29 

resetting to default 29 

Quick Analysis Lens 

adding tables   286 

adding totals   286 

formatting cells 285 

Quick Click category 488 

assigning  492 

changing   494 

removing   492 

setting 494 

 

R 
RAND function   245–246 

RANDBETWEEN function   245–246 

range_lookup argument 277 

ranges See named ranges 

rate argument 207 

Read Mode view 48 

Reading Pane 

displaying 452 

displaying attachments   454 

magnifying   453 

meeting requests  526 

scrolling messages  454 

viewing categories   488 

Reading view 50 

rearranging slides and sections 329–331 

records 

filtering recipients list 174–176 

mail merge 160 

manually excluding from recipients list 177 

removing duplicates 176 

sorting in data sources 177–178 

Rectangle picture frame style 376 

recurring appointments 513–514, 517 

ref argument 252, 253 

references 

absolute 217 

circular 225 

relative 217 

regrouping shapes 370 

relative references 

changing to absolute 214 

creating 217 

in formulas  211–213 

religious holidays   508–509 

reminders 513 

removing 
See also deleting 

backgrounds from pictures 359–360 

password protection 147 

restrictions 142–144 

slides 314–326 

tracked changes 132 

Reply All message response 464 

Reply message response 464 

Reply with IM or Reply All with IM message 

response 466 

Reply with Meeting message response 464 

resize handles 202 

resizing 

Excel tables 202 

pictures 352–355 

shapes 366 

resolving addresses 430–431 

responding to comments 128–130 

responding to messages 464–467 

Restrict Editing pane 139 
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restricting 
 

 

 
 

restricting 

document access 144–149 

document actions  138–144 

styles 139–142 

reviewing comments 128–130 

revising content See editing 

Revisions pane 124–128 

ribbon   6–9 

adding commands   33–34 

creating custom groups 30, 33 

creating custom tabs  30, 32 

displaying tabs 15 

hiding 13–14 

hiding/unhiding tabs  30–31 

moving commands  30–31 

removing commands 30–31 

renaming custom groups 32–33 

renaming custom tabs 32 

resetting to default 34 

ScreenTips 8 

scrolling 12 

unhiding 14–15 

Rich Text format 428 

Right Indent marker 76–77 

Right Tab 81 

Room Finder pane 519 

rotating shapes 366 

Rounded Rectangle picture frame style 376 

row input cell 294 

rows, worksheets 

adding to tables 202, 204 

grouping   275 

hiding/unhiding   273 

random, selecting from lists 246 

restoring 273 

sorting in worksheets 264 

rulers 

changing measurements  77 

displaying 77 

hiding   52 

indent markers 76 

tab stops 80 

S 
saving 

attachments to storage drives 457–458 

automatically 58 

documents 59 

files 56–57 

files in previous Office versions 55 

files to OneDrive 57, 60 

files to SharePoint 57 

message drafts 441 

presentations 59 

workbooks   59 

Scenario Manager 289–292 

scenarios 
See also data sets 

adding comments   287 

applying multiple  290–291 

creating 287, 289 

creating from Solver 299 

creating summary worksheets 292 

defining values 288 

displaying 289 

editing   289–290 

Normal 291 

removing   288 

size limitations 291 

summarizing 291 

Schedule view calendar arrangement 529 

scheduling 

appointments   504–507 

events  505, 510 

meetings 518–525 

Scheduling Assistant 518, 520 

screen clippings, capturing and inserting 

372–374 

screen resolution 13–14 

Screenshot menu 372 

ScreenTips 23–24 

ScreenTips, calendars 505 

scrolling files   44 

search filters 242–243, 245 
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searching 

address books  437–438 

address lists 438 

categories 486 

folders 494 

for holidays 509 

security 

restricting access using passwords 144–149 

scanning for viruses 456 

security settings, messages 453 

selecting 

multiple shapes 366 

pictures for editing 354 

shapes for editing 366 

selection filters  240, 244 

sending messages  443 

settings, files 53 

shading paragraphs 79 

shapes 
See also graphics 

connecting 371–372 

drawing and modifying 361–371 

formatting 367–370 

Text Box margins 364 

Share pane 150–151 

SharePoint 

saving files to 57 

slide libraries 322 

shortcut keys, categories 488 

signatures 428 

Simple Frame, Black picture frame style 376 

Simple Frame, White picture frame style 376 

simple graphics 351 

creating a photo album    375–380 

drawing and modifying shapes 361–371 

editing and formatting pictures 356–361 

inserting, moving, and resizing pictures 

352–355 

screen clippings  372–374 

Simple Markup view 122, 126 

Simplex LP solver method 299 

Skype for Business 504 

slide libraries 322 

Slide Show view 50 

slide shows  412 

Slide Sorter view 50 

slides 

adding 314–326 

adding audio content 404–410 

adding video content 410–415 

animating objects   392 

animation/transition indicator 394 

audio playback controls 405 

backgrounds 336–346 

building with animations 391–392 

copying 317–324 

deleting 324–326 

fitting to window 52 

hiding 324–326 

importing 317–324 

inserting 316–317 

inserting audio clips 406 

inserting video clips 413 

moving video images 414 

rearranging 329–331 

recording audio onto 406–407 

removing 314–326 

reordering animation effects 400 

SMALL function 251 

social media service, connecting to 20 

Soft Edge Rectangle picture frame style 376 

soft return 80 

Solver 

adding constraints 301–302 

adding to ribbon 300 

creating scenarios 299 

deleting constraints 303 

editing constraints  302–303 

Evolutionary method   299 

GRG Nonlinear method 299 

identifying objective cell 300 

identifying values to change 300 

installing 298 

integer programming   299 

limiting values 299 

opening   300 
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Solver (continued) 

requiring binary number values 302 

requiring integer values 302 

requiring non-negative values 303 

resetting model 303 

saving results 299 

selecting methods 303 

Simplex LP method 299 

solving methods 299 

specifying result types 300 

Sort & Filter 262–268 

sorting 

categories 489 

cell colors 264 

data set rules 264, 268 

data using custom lists 268–270 

default settings, Excel 268 

Sort & Filter 262–268 

worksheet columns 264–266 

worksheet rows  264 

spelling checks 133 

spelling errors, hiding 23 

splitting windows into panes 52 

standard colors 344 

standard themes, presentations 333 

Start screens, enabling/disabling 23 

status bar 10–11, 15 

STDEV.P function 249, 251 

STDEV.S function 249, 251 

sticky notes  490 

strikethrough   87 

style sets 98, 101 

styles 

adding to Styles gallery 101 

applying 97–98 

built-in, applying to text 97–103 

defining custom numbers 95 

fonts 85 

live preview 98 

modifying definitions   98 

numbers 94 

predefined   97 

removing from Styles gallery 101 

restricting 139–142 

Styles gallery 97 

adding styles 101 

removing styles 101 

Styles pane 

changing displayed styles 99–100 

displaying/hiding style previews 101 

opening 99 

options 100 

Subject field 429, 432 

subscript 88 

SUBTOTAL function 245, 247–248, 250 

subtotal summaries 275 

subtotals 

defining 271 

groups 272–273 

hiding/showing details 274 

removing 274 

removing from data lists 275 

Suggested Times list 521 

SUM function 207, 247, 249, 251 

SUMIF function 220 

SUMIFS function  220 

summary function, changing 203 

summary worksheets 291–292 

superscript 88 

 

T 
tab characters 80, 82 

tab leader 81 

tab stops 80–81, 83–84 

table_array argument 277 

tables (Excel) 

adding columns 202, 204 

adding rows  202, 204 

adding with Quick Analysis Lens 286 

converting to cell ranges    205 

creating using keyboard shortcut 202 

creating with default formatting 204 

defining 201–205 

entering values  202 

excluding cells 202 

expanding automatically   202 

naming 203 
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overwriting format   202 

renaming 205 

resizing manually  202, 204 

summarizing data   202 

summary function   203 

total row  203–205 

tabs 81, 83 

Tabs dialog box, opening 82 

task assignments 466 

task lists, displaying on calendars 534 

templates 

creating files from 41 

finding 43 

letters 162 

previewing design 41 

styles stored in 98 

testing passwords 146 

text 

adding to shapes 362–363 

animating 386–391 

applying artistic effects 88 

applying bold 87 

applying built-in styles 97–103 

changing case 88 

changing font color 88 

changing fonts    87 

changing font size 87 

character formatting 84–90 

copying formatting   89 

crossing out 87 

effects 86 

formatting   87 

formatting as you type 96 

highlighting 89 

strikethrough 87 

underlining   87 

WordArt   86 

Text Box margins, shapes 364 

textures, slide backgrounds  338–339, 343 

themes 104 

applying custom  107 

applying from non-standard locations 107 

applying to presentations 331–336 

built-in, applying to documents 106 

changing default 107 

changing in documents 104 

color schemes 334 

color sets 104 

custom  105–106, 108 

effect style  335–336 

font sets 104, 334–335 

Office 19 

saving 105 

saving custom 107 

standard 333 

Themes gallery 104 

thumbnails 9 

time slots on calendars 505, 507 

time zones on calendars 

appointments 515 

hiding controls 515 

meetings 515 

specifying 512 

title bar 5–6 

To field  429–430, 432 

toolbars, displaying  285 

totals, adding with Quick Analysis Lens 286 

tracer arrows 231, 233 

tracked changes 

accepting 131–132 

colors 119, 121 

default formatting 119 

displaying author of 131 

displaying revision types 127 

displaying time of 131 

hiding 120 

Microsoft accounts  126 

moving sequentially among 128 

preventing from turning off 121 

rejecting all 132 

removing selected changes 132 

reviewing 130–133 

turning on/off  120 

unlocking 122 

user identification   24 

trigger icons   404 
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triggering animations 
 

 

 

 

triggering animations 398, 401 

troubleshooting 

address lists 435 

Auto-Complete List   434–435 

message addressing  434 

multiple recipients   435 

Twitter accounts, connecting to 19 

two-variable data tables 293–295 

type argument 207 

U 
Unencrypted option   144 

ungrouping shapes 370 

unhiding 

Animation Pane   395 

data list details 274–275 

gridlines 52 

guides 52 

paragraph marks  82 

rulers 52 

unique messages 476 

unique values 276 

unlocking change tracking 122 

updates 21 

uppercase 91 

user interface 3 

user names 23–24 

 

V 
validation circles  255–257 

validation rules 255–256 

values 

defining for cell ranges 255–257 

finding in data sets 253–254 

watching in ranges 234 

variables, changing  293 

VAR.P function 249, 251 

VAR.S function 249, 251 

versions (documents) 

comparing 136–137 

control 137–149 

vertical spacing, paragraphs 72, 74 

video clips 

bookmarking   402–403 

embedded, full screen playback 414 

embedding 411 

formatting 411 

inserting 410 

inserting onto slides  413 

inserting trigger bookmarks 411 

linking to online video 410 

managing 412 

selecting embedded  414 

sources 410 

video images 414 

video playback 411 

video soundtracks, setting relative volume 415 

viruses, scanning attachments 456 

visual elements 351–382 

VLOOKUP formula   278 

VLOOKUP function  220, 276–279 

voting buttons   466 

 

W 
Watch Window 232–233 

watches 232, 234 

Web Layout view 48 

websites, linking to 418 

Week calendar arrangement 529 

what-if analysis  286, 289 

windows 

magnifying files 51–52 

splitting into two panes 52 

switching 52 

Word 2016 

file extensions  54 

file formats  54 

views 48 

WordArt   86 

Work Week calendar arrangement 529, 534 

workbooks 

closing 60 

creating based on templates 42 

opening 46–47 

recalculating 226 

saving 59 



zooming 

563 

 

 

 

 

worksheets 

adding validation rules 255 

auditing 229–231 

filtering data in   240–243 

finding information in 276–279 

organization levels 273–274 

recalculating 226 

selecting random rows 246 

setting calculation options 226 

sorting data 262–270 

summarizing data  247–253 

using VLOOKUP 279 
 

Y 
YouTube accounts, connecting to  19 

 

Z 
zooming  11, 51–52 
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